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Synchronous technology was born out of the idea that merging the best ideas of direct edit  
techniques with the best ideas of history-based modeling would deliver unprecedented 
power and control in editing CAD geometry.

For decades, history-based modeling has dominated the CAD world for reasons we will  
discuss more later. History-based methods have a lot of power, such as being dimension 
driven, highly automated, and feature-based, but come with a lot of less desirable baggage 
such as the need for pre-planning, inflexibility and the fact that it slows down as you add 
many features or many parts. Meanwhile, direct edit methods have also existed for a long 
time and have several advantages, but because of its associated weaknesses, it could never 
compete with history-based modeling. 

Enter synchronous technology, which marries the best of both worlds, and brings some new 
strengths to the table that make it all work together seamlessly. In the chapters that follow, 
we’ll guide you through a step-by-step approach to synchronous technology and share some 
compelling examples that will help to demystify what synchronous technology is, and how 
it can revolutionize the way you work.

Visit the companion resource file to obtain parts for the tutorials contained in the following 
chapters. 

Prologue

http://media.plm.automation.siemens.com/solidedge/solid-edge-st-ebook-download-folder-reference-files.zip
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Chapter 1

Introduction to synchronous 
technology 

 
 
Introduction
Welcome to synchronous technology for the history-based user. In these pages we hope to help 
history-based users of all stripes understand synchronous technology better. Whether you’re an 
experienced Solid Edge® software ordered user or are coming from SolidWorks® software or 
Inventor® software, we want to help you understand this revolution in CAD. This is not necessar-
ily a book for CAD beginners. We expect that you will already have an understanding of histo-
ry-based CAD programs such as SolidWorks, Autodesk, Inventor, PTC Creo® software, or even 
ordered (history-based) functionality in Solid Edge.

It doesn’t do synchronous technology justice to call it simply “direct edit”, and the popular notion 
that it is not parametric is altogether incorrect. Part of the goal of this book is to first properly 
define synchronous technology, and then to dispel misconceptions through demonstrations of 
its capabilities, and to help existing CAD users see how application of synchronous methods will 
help you save time and energy in your everyday CAD and engineering tasks. 

For decades, history-based modeling has dominated the CAD world for reasons we will discuss 
more later. History-based methods have a lot of power, such as being dimension driven, highly 
automated, and feature-based, but came with a lot of less desireable baggage such as the  
need for pre-planning, inflexibility and the fact that it slows down as you add many features or 
many parts. 
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Synchronous technology is the combination of the best functions of history-based CAD and the best functions of Direct 
Modeling, along with some special exclusive functionality.
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Meanwhile, direct edit methods have also existed for a long time and have several advantages, 
but because of its associated weaknesses, it could never compete with history-based modeling. 

Enter synchronous technology that borrows some of the best ideas from history-based and 
Direct-edit methods, while leaving behind the weaker areas. Plus, synchronous technology 
brings some new strengths to the table that make it all work together seamlessly. 

Why synchronous?
Let’s start by understanding the name, synchronous technology. 
What does it mean? “Synchronous” means that several things are 
happening together, at the same time, in a coordinated way. This 
is contrasted with the history-based concept of doing things 
sequentially. 

Synchronous technology adds several other technologies on top 
of the direct edit method such as feature recognition, intent  
recognition, driving dimensions (PMI), Face Relations, and proce-
dural features.

In synchronous technology, the entire model is solved at once. By 
contrast, in history-based CAD, the model is solved one feature at a 
time, and each successive feature is added to the body. So in a 
sense, solving the whole model at once rather than sequentially in 
parts can also be thought of as “synchronous”. 

Another level of synchronous behavior in synchronous technology is that Solid Edge enables you 
to combine both synchronous and history in parts and assemblies. So you don’t have to use only 
one method at a time, although you can if you want. Parts made in Solid Edge can use either 
synchronous, ordered or both. Likewise, assemblies can have parts in them that are either syn-
chronous, ordered or both. 

Let’s list the things are happening at the same time in 
synchronous technology:

• Synchronous solves the model geometry at the 
same time, instead of feature-by-feature

• Synchronous employs several technologies that 
work at the same time:
• Direct edit
• PMI dimensions (driving dimensions on the  

solid body)
• Face relations (work like sketch relations on  

the 3D model)
• Procedural features apply parameters to features 

like patterns, thin walls, ribs, holes, and others
• Feature recognition (can convert patterns, holes and other  

features from imported bodies into procedural features) 
• Synchronous and ordered methods can both be used on the same models,  

in the same assemblies

Synchronous technology is like…
History-based users sometimes have a hard time getting their heads around synchronous tech-
nology when they see it for the first time. When asked how to describe the software in words, 
we often resort to analogies. Synchronous technology is to 3D as 2D-only CAD is to 2D line draw-
ings. You may have worked with 2D-only CAD before. To move lines in 2D, you select a set of 
items and use the appropriate tool to move the selection set. You can move an approximate 

In synchronous modeling, we 
make use of PMI dimensions 
directly attached to the model.

Synchronous assemblies enable us to use 
both synchronous and ordered parts in the 
same assembly.
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amount by just dragging, or a specific amount by keying in a number or snapping to points. This 
analogy may over-simplify some aspects of the software, but it does help illustrate the select-
and-move aspect of editing with synchronous technology.

Editing with synchronous technology is a lot like editing in 2D-only 
CAD: select and move.

If you have preconceptions of what you 
think synchronous technology is, you’ll do 
best to put them aside until you’re done 
reading this book. We think that when 
you understand what synchronous tech-
nology is, what its strengths and weak-
nesses are, and how it stacks up against 
the strengths and weaknesses of  
history-based modeling, you’ll come to 
agree that there should be a place for it in 
your design process. 

You may have become numb to the pain of history
The shortcomings of history-based methods are often overlooked because history-based model-
ing has been considered the only seriously viable method for decades. But synchronous technol-
ogy has strengths where history-based modeling has weaknesses, so these methods can and 
should be used together to make the most robust models possible.

We are not proposing that you should entirely  
abandon history-based modeling and only model 
synchronously. We generally like the idea of using 
synchronous and history for their respective 
strengths, using them together as appropriate. This 
allows you to avoid the weaknesses of both history- 
based and synchronous. Combining modes greatly 
simplifies the parent/child tangle that can result from 
inter-associativity between straight history-based 
parts, especially when designing in-context parts in  
assemblies. Using these technologies together is  
really where the biggest value lies.

Anyone who has used 3D CAD in the last couple of decades has dealt with the workarounds and 
frustrations of history-based modeling. For example, editing features that you made early on in 
the process causes features that you made at the end to disappear as they are rolled back and 
then recompute when the edit is complete. This is made necessary by the linear nature of the 
history tree, but from a design point of view makes no sense, and simply wastes time. We have 
all used history-based CAD for so long we just accept its shortcomings without question. So in 
this book, we aim to show that synchronous has an alternate method that enables you to avoid 
those frustrations. We will then show you techniques where synchronous works best, and some 
clever ways of using it. Beyond that, we will demonstrate how and when to combine synchro-
nous and history-based methods.

Many of us have used history-based CAD for so 
long, we have forgotten how many areas of it are 
based on difficult concepts to learn.
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Not everyone starts  
a believer
In doing the research for this book, we have 
taken time to examine some of the fears and 
misconceptions that have prevented people 
from moving forward with synchronous tech-
nology. There are some limited specific situa-
tions where synchronous really doesn’t fit into 
certain design workflows, and in those situa-
tions we recommend ordered. 

Combining synchronous and ordered 
techniques within a single part is one of 
the strengths of Solid Edge with 
synchronous technology.

As a product of this research, we also have found that people tend to cling to what they know. 
You owe it to yourself and those working with you to be open to potential improvements to your 
process. Even if you start out reading this book as a skeptic, 
that’s ok. Just promise yourself that you will be open to new 
ideas, and that you will recognize the value in possible new 
ways of doing things. 

As another product of the research, we kept seeing examples 
where the history paradigm was illogical, or was susceptible 
to procedural problems that more closely resemble program-
ming bugs than mechanical design problems. The deeper 
you get into studying history-based modeling, the less you 
will be convinced that it is the best method for most model-
ing situations. 

Weaknesses of history-based modeling
History-based models rely on a recipe of features, executed in a specific order. Synchronous tech-
nology, in contrast, is only concerned with the present state of the geometry, without regard for 
how you might have arrived at that point. Through the evolution of CAD, history-based modeling 
has been the most prevalent for the last 30+ years. Pro\ENGINEER® software was the product to 
develop and popularize this method. Synchronous technology was introduced in Solid Edge in 
2008, and is gaining traction in the industry. 

Working with imported data in synchronous 
technology makes things possible that simply 
can’t be done with imported data in history-
based software.

The necessity for introducing the time/order metaphor for 
CAD models originally had to do with the computer hard-
ware that was available in the 1980s. It wasn’t very fast, so 
it couldn’t handle the typical complexity of a manufac-
tured part all at once, much less the complexity of multi-
ple parts going into an assembly. Thus, CAD developers 
needed to break up the geometrical information into 
smaller computable chunks.

This meant that not only did product data have to be bro-
ken down into assemblies and sub-assemblies, but the 
assembly data had to be broken into parts, and the parts 
into features, and the features into sketches and metadata 
parameters. Feeding the computer large amounts of infor-
mation in small chunks was already a familiar method to 
the people who were charged with solving this problem –  
programmers. Programmers write computer programs 
using essentially the same method – by creating a 

Synchronous technology enables the user to create design 
intent without very resource intensive techniques such as 
associative links between parts, but when it’s really 
necessary, we can still create those associative links.
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sequential set of instructions that can be strung together one by one to make a finished product 
of any size. So to employ yet another analogy, history-based CAD modeling developed into a 
method that requires the mechanical designer to work (and think) like a programmer. 

For decades this abstraction of thinking of our CAD models in a time-based metaphor has 
seemed acceptable to mechanical designers who work in 3D, even though the metaphor breaks 
down when we start working in assemblies, and doesn’t make much sense when we look at our 
models in terms of feature importance rather than order in time. To some users, approaching 
CAD modeling without this artificial metaphor now seems unnatural. 

Embracing a new way
It is common to hear history-based users who are contemplating the switch to synchronous tech-
nology complain that they feel they will lose some sort of control because of the perception that 
there is no way to fully constrain the model in synchronous technology. The fully constrained 
mindset is one that comes from the history-based way of 
thinking. In synchronous technology, the idea of fully con-
straining a model works backwards from the history-based 
method. The part geometry will not change unless one of the 
four tools tells it to:

1. PMI 3D Dimensions

2. Steering Wheel editing interface

3. Face Relations

4. Design Intent

In history-based modeling, the model – either in its entirety or a portion thereof – is recalculated 
with each change, so the entire model is constantly in danger of changing. With synchronous, 
there is no reason to assume the model will change, unless you actively change it with one of 
the tools above. 

The most difficult part of history-based users making the switch to synchronous technology is 
letting go of the programming metaphor, and learning to just be concerned with how the model 
looks right now. 

The zen of synchronous
I used to teach history-based CAD for many years. Every now and then I 
would come across someone who would completely ignore the feature 
tree, and just keep building, editing, and cutting away portions of the 
model. They would wind up with hundreds of features, many of which 
simply chopped away features created earlier in the tree. This was of 
course completely the wrong way to handle history-based models, but its 
how things work in synchronous. So many of us have been ingrained with 
the idea of “right” and “wrong” ways to model in history. It’s very hard to 
throw away that training, but that’s exactly what you have to do to under-
stand synchronous technology. I will wind up saying this many times 
before this book is over – the only thing that matters in synchronous technology is the state of 
the geometry right now. It doesn’t matter how you got there, all that matters is the current state. 

Point to the History 
on this part.
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History-based complaints
One step in confronting the fear of change is to outline the problems that we have grown to 
overlook with the existing history-based paradigm. This is my favorite part, because many people 
have completely forgotten that they go to great lengths to work around these problems to make 
history work. Let’s examine the difficulties associated with history-based modeling:

The ability to mix modes in parts and assemblies makes 
Solid Edge stand out as the most flexible CAD tool around.

1. Design is not linear. There is nothing 
about design that leads us to think of 
features in some sort of order, especially 
not as an executable list of features. 

2. Change is inevitable in CAD models. We 
want our design intent to handle the 
changes gracefully. But sometimes the 
design intent itself is what changes. In 
history-based CAD, changing the design 
intent itself is similar to rerouting a big 
expressway through a congested city. It’s 
a complex, frustrating, and ineffective 
undertaking.

Synchronous technology as 
implemented in Solid Edge works best 
with prismatic parts.

3. The concept of rolling back the tree to insert a feature is 
entirely artificial. You should be able to just add a feature 
without worrying about order. If a feature exists, you 
should be able to just edit it without affecting the other 
features in the model. Daisy-chained parent/child depen-
dencies lead to many unintended relationships in parts 
with long feature trees. These daisy-chained relationships 
often lead to daisy-chained failures. 

4. History-based modeling looks more like computer program-
ming than anything else. That’s because it’s a method  
created by programmers to overcome the limitations of 
hardware thirty years ago. The concept of history-based 
modeling does not come from design. It comes from the 
intersection of hardware computational limitations and 
programming paradigms.

5. Even in history-based software, sketches, assemblies, and drawings don’t use the concept of 
history. If you can work without it in those places, you can work without it in parts as well. In 
fact, some people compare the way synchronous technology handles 3D geometry to the 
way most CAD programs handle 2D geometry – select and move.

6. Failures in the feature tree have to be repaired before you can proceed. How much time do 
you waste on this? In my consulting business, I spent probably 60 percent of my time repair-
ing things after changes because the change I had to make was not foreseen at the time I 
created the model. Design intent in history-based software requires you to be able to see the 
future to build design intent into the model, and requires you to see into the past to recall 
how the design intent was meant to work.

7. The parent/child relationship becomes 
extremely convoluted on big complex parts, 
and is even more difficult to unravel when 
parts become inter-related in the context of 
the assembly. When you select a base fea-
ture to start your part, there are often multi-
ple ways of getting started. In many cases, 
the feature you pick is completely arbitrary, 
or doesn’t involve factors which become 
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important later on. A week later, however, when you’re making edits, you might wish you 
made a different choice. This kind of foresight/hindsight experience that you encounter 
almost inevitably in history-based models, does not exist in synchronous technology.

8. Rebuilding and possibly repairing all the features in the tree repeatedly is inefficient and slow. 
And every time the software does it, it’s another chance to do it incorrectly. The only thing 
that really should matter with your CAD model is the final state. History-based software, 
however, acts like your model is really itself software that has to be constantly recalculated, 
and so is constantly in danger of returning errors or unintended changes.

9. Best practice for history-based modelers is built around the limitations of history-based mod-
eling. In history-based modeling, you can have the correct geometry, but your CAD Admin 
might still declare your model a disaster. In synchronous technology, if the geometry is right, 
it’s right. So has all that effort that has gone into best practices really been necessary?

History-based modeling and the concept phase

Solid Edge captures much of 
the model data right in the 
PathFinder, which makes it 
easy to find, edit and control.

History-based modeling has particular weaknesses when it comes to 
modeling concepts rather than finished models. Many users resort to 
making what amounts to a practice model during the concept stage. 
Concept work where the direction of the design intent can and does 
change very rapidly is inherently incompatible with requirements of 
history-based modeling, where your idea needs to be fully formed 
before you start creating sketches. When the design is finalized, these 
users go back and re-create a more robust well-thought out model 
where the design intent actually works as intended, essentially dou-
bling their work.

Synchronous models, on the other hand, only care about the present 
state of the geometry. Design intent in synchronous is captured in the 
geometry, PM and applied relations. If faces in the model are parallel,  
the software recognizes that and maintains that relation until you tell  
it not to. So as long as the geometry is correct, your concept model is  
as good as a production model. No more practice models.

Synchronous is: PMI dimensions
Product Manufacturing Information or PMI refers to the dimensions that 
are placed directly on the 3D model to drive size, orientation, and posi-
tion. Applying dimensions directly to the 3D geometry rather than indi-
rectly through sketches and defining dialogs gives you a clear and 
unambiguous way to document and control parts.

Dimensions can be located and turned on/off easily through the 
PathFinder, or show only the PMI attached to a specific feature. PMI can 
also be grouped in user-specified groupings. 

To be most successful when starting to learn synchronous technology, 
PMI dimensions should be your first stop when making changes to engi-
neering models. The Steering Wheel (discussed later in this chapter) 
might seem more attractive and interactive at first, but for stability, clarity, and precision, begin-
ning synchronous users should start with PMI dimensions. They are simpler to control and more 
direct than other available methods.
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Dimensions connect to faces
Dimensions are created by selecting edges, but they drive faces. Dimensions do not drive edges. 
Edges always exist at the intersection of two faces. So even though you create dimensions by 
selecting edges, dimensions always specify a distance between faces. 

The dimensions in these examples have been created using the Smart Dimension tool. Smart 
Dimension can be used to create most but not all the dimensions you will need to place on mod-
els in Solid Edge. You need to pay attention to the available options in the Smart Dimension 
CommandBar, shown here, and the other dimension tools available from the Ribbon.

Here we have a simple block. The 2.432 dimension could have 
been created by selecting either just the edge highlighted in yel-
low, or both edges highlighted in red. In either case, what the 
dimension does is specify the distance between the two blue 
faces at the vertical gray face. 

If the dimension had been created between the left red edge and 
the black edge (or just the orange edge), the dimension would 
have been different, and the faces it controlled would have been 
different. The software is smart enough to know which faces you 
mean to control even though there is the possibility of two differ-
ent faces for each selected edge. 

When you edit the dimension, you can make the left side move, 
the right side move, or move both sides symmetrically based 
either on the dimension settings or where you select the dimen-
sion for editing. This is a really novel idea in driving design intent, 
and is not available with history-based models. Notice that the 
face highlighting in the previous image reflects the change direc-
tion setting (the face that will move is highlighted). This concept 
helps you determine the design intent on the fly and will be dis-
cussed in more depth in the next chapter.

Notice another thing that isn’t necessarily relevant to synchronous technology or 
the actual function of the dimension. The placement of the dimension changes 
from parallel to the ZX plane to parallel to the XY plane if you rotate the model 
while placing the dimension. Whichever plane normal is closest to parallel to your 
line of sight is the plane that the dimension will be placed on. Once the dimension 
is placed, it will remain in that orientation. 

If you dimension between two edges that are not co-planar, you can rotate the view and get a 
number of different results. For beginners especially, it’s recommended that you keep your 
dimensioning choices clearer, which will make it easier to control and understand the results the 
software gives you. Once you gain some solid experience with the system, some of these more 
complex options will give you additional control, but for now, keeping it simpler will be less 
confusing. 

Synchronous technology and curved faces
Synchronous technology deals with curved faces somewhat differently from planar faces. When 
you select a cylindrical face, the software displays a radial or diameter dimension that you can 
use to change the size. This happens whether you have created a dimension on the cylindrical 
face or not. You may also notice that the Steering Wheel is not displayed to change the size of a 
cylindrical face, although it can be used to change the position or orientation of a cylinder.

When you place a dimension on a non-planar edge, Solid Edge projects that edge onto the near-
est base plane. So if you have an edge that is the intersection of two curved surfaces, 
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dimensioning the edge will yield a read-only Length dimension (shown here as L 1.580in purple) 
because the software sees the edge as a complex spline. 

If you want to change the radius of a curved face, 
you need to select the curved face itself. The 
image to the right shows a part with two curved 
faces that intersect. The circles used to make the 
cuts are also shown. The circles have diameter 
dimensions, and the faces have radial dimensions. 
The dimensions for the curved faces are assigned 
by the software if the user doesn’t directly specify 
them. Selecting the curved face brings up the 
radial dimension. 

This just helps to demonstrate the relationship 
between dimensions, edges, and faces. It is rele-
vant to synchronous technology in that you have 
to understand how dimensions connect to the 3D 
geometry rather than just working with 2D 
sketches. The model used to create the previous graphic is provided with the reference materials 
for this chapter if you want to examine it more closely, called Curved  
Faces.par.

Live Sections are a little different
In some situations, it makes sense to attach dimensions to Live 
Sections rather than to faces. The Live Section is essentially a sketch 
created at the intersection of the model faces and a section plane. 
Solid Edge automatically creates live sections for revolved features, 
and the Live Section is placed in the PathFinder where you can turn it 
on or off. This Live Section can be used to drive the model, unlike 
other sketches. Live Sections can be used anywhere on any model, 
but are most effective on revolved features where controlling the 
profile just from model edges can be difficult. 

Synchronous is: Steering Wheel, Design Intent,  
Solution Manager
The Steering Wheel enables you to translate or rotate the selection set 
along axes or within a plane by using the tool plane. The blue dots help 
you locate and orient the Steering Wheel, and the arrows help you move 
along an axis. The tool plane enables you to move the selection within 
the indicated plane. The ring enables you to rotate the selection. Each of 

these controls enables you to key in 
a specific value for the translation or 
rotation after you have established a direction. 

Editing done with the Steering Wheel is applied to the selec-
tion set – the set of faces you have selected at the time 
when you invoke the Steering Wheel. In addition to the 
faces you have selected, synchronous technology uses your 
Design Intent settings to select additional faces. We will 
discuss selection sets and Design Intent later in this chapter.

Generally, if the model has faces that are parallel or perpen-
dicular, they aren’t that way by accident. You probably 
intend for them to stay that way. Thus, those relationships 
are part of the design intent. Synchronous technology can 

Dimensions are attached to faces, even though they may 
be created by selecting edges. Working with PMI 
dimensions attached to the 3D model is a very intuitive 
way to work, although it may take the history-based user 
some time to make the transition.

Live Sections help you apply 
simplified dimensions on 
revolved parts.

You need to become familiar with the parts 
of the Steering Wheel and how to use it, as  
it is one of the primary interface tools 
synchronous users use to edit parts and 
assemblies.
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identify relationships like this quickly and easily, and so it helps you main-
tain these relationships by adding any faces that meet the criteria of any 
active option in the Design Intent settings to the selection set. So if you 
have the Concentric option turned on, any faces that started out concentric 
will still be concentric at the end of the edit. This is a very different way of 
looking at design intent, but the big advantage is that you can assign or 
disable Design Intent at the time of edit. You no longer have to establish it 
before you know how you are going to edit the model. 

Note: because Solid Edge has a tool called Design Intent and a  
general concept called design intent, this book will refer to the tool 
with capitals and the concept with lower case. 

Also note that Design Intent was previously called Live Rules, so you may  
see that name used to describe this functionality in older references.

Manipulating the Steering Wheel
You can use this section as a tutorial, by following along and just getting the 
feel for how the Steering Wheel works, and how to control it. You can use the 
part called Practice With Steering Wheel.par to practice on shapes similar to 
those in the following figures.

The ability to manipulate the Steering Wheel is key to being able to make the 
edits you want to make. 

The first time you click on a planar face, a single arrow appears. This is the 
simplified Steering Wheel, and only allows movement in the direction of the 
arrow (normal to the selected face). 

To get the full Steering Wheel to appear, either click and release twice on the 
arrow, Ctrl-select multiple faces, or use the origin knob (blue dot) to move the 
Steering Wheel. This enables you to move the select set in the direction of any 
arrow, rotate about the axis of the torus, or along the plane of the tool plane.

If you click on a cylindrical face, the Steering Wheel appears with only 
two axes, (2D Steering Wheel) at the end of the cylinder to allow you to 
move the cylinder. To change the length of the cylinder, click the origin 
knob, or Ctrl-select the end face of the cylinder and use the normal 
arrow as for the planar face. 

There is not a way to use the Steering Wheel to change diameter or radius values, you must use 
the PMI dimensions that the software places on cylindrical faces automatically.

If you want to move a selection of faces along an orthogonal direction (parallel to one of the 
three main axes of the part), then it’s easy. You have three axes on the Steering Wheel, so you 
just move along one of those axes. But when you want to change the angle of a selection of 
faces, you have to use the torus, and the Steering Wheel origin has to be on the vertex or axis of 
the angle. The Steering Wheel only has one torus, so you’ve got a 1 out of 3 chance of the torus 
being in the right orientation by default. 

To reorient the Steering Wheel’s torus to be parallel to one of the XYZ 
directions, Shift-click on the tool plane on the Steering Wheel. There 
are only three options, so if clicking once doesn’t give you the 
result you need, just click once more. The Steering Wheel will 
toggle through the three possible orientations.

To orient the Steering Wheel along a direction other than the 
XYZ directions, drag the origin knob to an edge or face that is 
either parallel or perpendicular to the desired direction. 

The Design Intent panel 
enables you to control 
relationship assumptions 
made by the software.
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If there is no geometry in the current assembly or part that fits the purpose, Ctrl- click on an axis 
bearing knob and drag or key in an angle of rotation. If hovering the cursor over the axis knob 
highlights the wrong axis for rotation, then use Shift instead of Ctrl.

You can also use the surrounding geometry to pick up references to get exact distances or angles 
without round-off error involved in measuring or keying in values. For example, if you want to 
copy a set of faces by the length of an existing edge, you can select the faces you need to move/
copy, and offset the Steering Wheel by dragging the origin knob to a keypoint (say one end of an 
edge), then Ctrl-click on an axis and to place the faces, click on another keypoint (say, the other 
endpoint of the edge). 

When you are using the Steering Wheel to move items in a From-To sort of arrangement, you can 
think of the Origin Knob as being your From reference, and whatever keypoint you select will be 
the To reference.

Synchronous is: Face selections
Although there is a chapter in this book exclusively devoted to creating selections in synchronous 
technology, we will go over some of the highlights here.

One of the things that distinguishes synchro-
nous technology from history-based modeling is 
that changes occur to selection sets rather than 
to features. In synchronous, features in the 
PathFinder really are just selections of faces. So 
in order to make a change such as for example 
angling a set of faces, you first select the faces, 
then use the Steering Wheel to make the 
change.

Selections can be made using common tech-
niques such as:

• Ctrl-selection
• Window/box/fence selection
• Selecting features in the PathFinder
• Selecting a user-defined set of faces
• Using the Selection Manager for automated or intelligent selections
 

You can also manually create user defined sets if the features listed in the PathFinder don’t 
match up with the edits you want to make. 

Selections can also work with dimensional changes. If you have a set of faces selected, and then 
click on a dimension to make a dimensional change, the selected faces will also move with the 
faces that move with the dimension. 

Selections can be made by individually clicking on faces, using Ctrl-click to select multiple faces, 
or by fence/window selecting multiple faces at once. If you use Ctrl-click, the cursor changes 
between 3 states, –, + and +/– . You can toggle these states by pressing the Spacebar.

Design Intent is actually a method for automatically selecting faces. If you are using the Parallel 
design intent, the software automatically selects any faces that are parallel to your existing selec-
tion for use in the edit you are about to perform with the Steering Wheel. 

In any case, with this book, we hope to leave you with a correct idea of what synchronous tech-
nology is, what it does, and what it does not do. We hope to help you see that the best way to 
use it is to combine its strengths with the strengths of history-based modeling. Our goal is to 
help you spend less time wrestling with the artificial process of CAD, remove the frustration, and 
put time back in your day for things you value most.

Rather than selecting a “feature” to edit, in synchronous 
technology, you select a set of faces to edit. This gives you 
far more flexibility than being tied to what your CAD tool 
identifies as a feature.



Solid Edge with synchronous technology  |  Steering a new course in 3D design 

13 Chapter 1  |  Introduction to synchronous technology

Confronting the buzzwords
Converting to a new way of working with CAD data is difficult enough without all of these buzz-
words confusing things. Here we define some of the more common words and phrases that tend 
to confuse new users. 

History-based
History-based CAD software relies on the user to build an individual part with a series of fea-
tures. The software remembers the features in order, and the model must re-solve these features 
in order perfectly at every step to move forward. You can think of this method of model building 
like a computer program. You give the computer instructions for every step, and it executes 
those steps for every time the model must be rebuilt. 

Interestingly, only the part file follows this way of working. The sketch, assembly and drawing do 
not. Things begin to get complicated when you make references between parts in the assembly, 
because the references are still bound by history, while the top-level assembly document is not.

History-free
History-free CAD still uses the idea of features, but once the 
feature is part of the model, the order of the features is irrele-
vant. For example, in the PathFinder shown to the right, the 
features are shown in the order in which they were created, 
but can also be sorted alphabetically or by type. Features can 
be thought of as a collection of faces, but can also contain 
certain types of metadata, such as size for a round or cham-
fer, or diameter for a hole, or possibly number of features for a pattern. Synchronous technology 
uses both history-free and history-based methods. As an overgeneralization, history-free model-
ing is sometimes equated with direct edit.

Direct edit
There seems to be no end of experts arguing over finely nuanced definitions and variations of 
this term, but in general, direct edit is a CAD method where you directly manipulate faces of the 
model, rather than indirectly edit feature definitions or sketches. The reason edit is part of the 
name is because how the geometry is made really doesn’t matter, and frankly, isn’t as interesting 
as how the geometry is changed. All designers know that you draw something once, but edit it a 
dozen times or more. Synchronous technology augments the basic direct edit idea with several 
tools such as PMI, Design Intent, Face Relations, the Steering Wheel, Procedural Features, and 
others.

Feature-based
Both history-based CAD and synchronous technology are feature-based, although the features 
work differently for each. Each operation you perform is equivalent to one feature. During the 
creation of new geometry, features work roughly the same. From a sketch or sketches, you make 
an extruded feature, or a sweep, or add a round, or chamfer, or pattern. The difference comes 
when editing. In history-based software, you edit with the same interface that you used to cre-
ate, and the software remembers values. In synchronous technology, the features are generally 
selections of faces. Synchronous technology also has a type of feature called a Procedural 
Feature, where it will remember some values that go with the collection of faces. Examples of 
procedural features are rounds, chamfers, patterns, holes and thin wall. Editing these features 
does not take you back to the original interface or suppress other dependent features, it just 
selects the faces of the feature, and allows you to change a value such as wall thickness, or hole 
diameter. Deleting a synchronous feature will delete all the faces of the feature. To get a little 
ahead of ourselves, synchronous technology uses the set of currently selected faces to edit. This 
is why a feature remembers the faces used to create it. But this also allows you to change the 
selection set, and thereby change the design intent. It’s almost too easy. The hardest part is for-
getting the old history-based definition of a feature.
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Parametric
People frequently have the mistaken idea that only history-based software is parametric. 
Synchronous technology is also parametric. Parametric means that the model is driven by param-
eters, which can include dimensions, pattern instances, wall thicknesses, hole diameters and 
depths, and so on. You can drive synchronous parts with a table of values that in turn drive PMI 
dimensions on the part. 

Associative
Associativity in CAD means primarily links between documents. In some cases this is good, such 
as between a model and a drawing. But in other cases, it is considered onerous overhead, for 
example when you have links between parts in an assembly. Synchronous technology has tried 
to lighten the CAD compute and file management burden by limiting links between part files, 
while still allowing you to make in-context changes. 

In history-based CAD, it’s possibly too easy to create these links between parts. Synchronous can 
go either way, with explicit associativity, or with the less permanent associative intent by selec-
tion, which you might think of as manual associativity. Synchronous technology gives us func-
tions like Create Inter-part Relationships, Inter-part Copy, and the use of externally linked variable 
table to drive dimensions. This allows you to work freely, without creating the tangled associa-
tive spaghetti that you tend to get with history, but when you need an associative link, the tools 
are there.
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Summary
Synchronous technology is a combination of a lot of powerful tools. Some of these tools will be 
familiar such as dimensions and equations, and some will be new to history-based users, such as 
the Steering Wheel, and Design Intent on the fly. It is simultaneously an improvement on and a 
complement to history-based modeling. In many ways, synchronous technology is a completely 
new way of approaching 3D CAD modeling that can revolutionize the way you work. 
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In this chapter we build on the concepts from Chapter 1 and start looking at practical aspects of 
how the details of synchronous technology actually work.

What is design intent?

Design intent is the set of properties that allow a CAD model to react predictably 
to change.

This is the same definition for design intent used for history-based CAD software, but it also 
applies to synchronous technology. The design intent does not imply anything about feature 
order, or whether features are driven by sketches, because you don’t need those things to create 
design intent. Relationships and dimensions create design intent, and synchronous technology 
uses both of those control types.

In synchronous technology, the geometry itself captures the design intent. Synchronous technol-
ogy recognizes existing relationships in the model and maintains those, without requiring dupli-
cated instructions in sketch relations. For example, in a simple rectangular block, three pairs of 
model faces are parallel, and synchronous technology will recognize this situation without the 
user needing to specify that the faces are parallel. You can, however, tell the software to stop 
recognizing the parallel relation when you need to, or manually add a relation that doesn’t 
already exist. 

For example, concentric holes are probably not concentric by accident. The software recognizes 
the concentric condition, and maintains it. This is how synchronous technology is able to apply 
design intent to imported models with no sketches or “features”. The intelligence comes from 
the geometry and the software just has to read or recognize it. This is why data transfers involv-
ing history-based CAD generally lose all of their intelligence – because it is part of the propri-
etary file format rather than simply captured in the existing geometry, as in synchronous.

Driving geometry size and position synchronously
In synchronous technology, there are four tools that we identified in the previous chapter that 
you can use to drive geometry size or position: PMI (dimensions), Design Intent (assumed rela-
tions), Face Relations (manual relations), and the Steering Wheel. These methods work together 
with the selection set to make changes.

Solid Edge offers a complete 
set of tools for applying 
dimensions to models.

1.  PMI (product manufacturing information) refers to driving 
dimensions that are directly attached to the 3D model and drive 
the locations or sizes of faces. PMI dimensions are placed using 
the tools on the Dimension group on the Home tab. 

Chapter 2

Driving design intent  
without history
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Dimensions in Solid Edge® software have several colors indicating function or state:

a. Red = Locked. This means that you 
have to actively edit the dimension 
to change its value (the system  
cannot drive or change the value).

b. Blue = Unlocked. This means that 
you can change the dimension  
manually or the system can change 
it through other changes in the 
model. You can use the Lock toggle on the dimension box to  
toggle dimensions between locked and unlocked states.

c. Purple = Read Only or For Reference. Can be a number of 
things, including Not To Scale or driven by table.

d. Orange = Highlighted

e. Green = Selected

f. Brown = Dangling, or detached dimensions that have lost one of their references

Note that the following only applies to PMI dimensions on the model, not to 
dimensions within sketches. 

 Within the dimensions are directional arrows (red 3D cylindrical arrows) that indicate 
which side of the dimension will move when you make a change: left, right, or symmetric. 
For example, if you did not yet set the direction of the dimension, and you click on the left 
side of the dimension to edit it, the left side moves. In the previous figure, notice the posi-
tion of the cursor relative to the numerals and the resulting red arrows on the dimension. 

Changing the design intent on the fly with the 
dimension directional arrows is something you 
will not find in history-based software.

 This method of changing the direction of the 
dimension represents a major departure from how 
dimensions work in other CAD software. The 
dimension tools on their own add greatly to the 
design intent flexibility that synchronous technol-
ogy gives you over other methods. 

 You can permanently set the direction of the 
dimension in the dimension dialog box, shown 
above. Once you do this, the side of the numeral 
that you click on no longer controls the direction of change.

2.  Design Intent (formerly called Live Rules) refers to the interface 
Solid Edge uses to display and enable the user to control the 
relations captured from the model geometry.

Design Intent essentially adds to your selection set anything that 
satisfies the enabled options. So if you select a cylindrical face to 
modify, the default settings will add any faces that are concentric 
or tangent to the selected face.

Faces selected by Design Intent apply to Steering Wheel edits as 
well as PMI edits. So the Steering Wheel will move the entire 
selection set which includes whatever you select manually plus 



Solid Edge with synchronous technology  |  Steering a new course in 3D design 

18 Chapter 2  |  Driving design intent without history

whatever Design Intent selects for you based on the settings. PMI likewise will move the 
entire selection set plus Design Intent faces for any dimensional changes. 

The idea for the two different panels (the gray one above and the colored tiles below) is that 
for most of your edits, you will not make any changes to the Design Intent settings, or the 
changes that you make will be to the simple, commonly used settings shown in the gray 
Design Intent panel. However, there will be those times when you need more detailed con-
trol, and for those times, you can access the Advanced Design Intent panel, and get as 
detailed as you want, including the Solution Manager.

a. The Design Intent panel enables you to turn off the most basic assumed relations. To  
display more advanced relations, you can display the Advanced Design Intent panel, 
shown below.

Orange means the option is active, white means it is inactive. 

b. The Advanced Design Intent panel enables you to turn off assumed relations, such as 
keep orthogonal to base planes, coplanar axes and consider sketch planes.

The symbols in the Advanced Design Intent panel are identified using tool tips, but here is 
a detailed list with the keyboard shortcuts for each listed in parentheses.

Design Intent Restore (R) –  
Restore default settings

Consider Reference Planes

Design Intent Save Relations (F) –  
Creates persistent relations for 
Design Intent settings

Consider Sketch Planes

Concentric (C) Consider Coordinate Systems

Parallel (L) Lock To Base Reference

Tangent (T) Same Radius

Tangent Touching (G) Keep Orthogonal to Base

Coplanar (P)
Suspend Design Intent Settings

Perpendicular (J)

Symmetry About Base Planes (S) Relax Dimensions (D)

Symmetry about YZ (Y) Relax Persistent Relations (N)

Symmetry about ZX (Z) Solution Manager (V)

Local Symmetry (Ctrl-Y) Auto Solution Manager

Aligned Holes (A) – Coplanar axes of 
holes, Cylinders, revolved features

Design Intent Options

Aligned/Coplanar in XY (Q)

Aligned/Coplanar in YZ (W)

Aligned/Coplanar in ZX (E)

Aligned/Coplanar in canted planes 
(Ctrl-A)
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c. Solution Manager

The Solution Manager is a way to manage failure. When an edit will not work, you would 
typically adjust the Design Intent settings. If it continues to not work the way you want it 
to, you would resort to the Advanced Design Intent panel to control the Intent in a more 
detailed way.

If you still cannot get the edit to work, or if you just want to investigate the reasons why 
the model is behaving the way it does, the Solution Manager is the way to go. This can be 
used for either Steering Wheel or PMI edits.

We will do a quick overview of Solution Manager at the end of this chapter to show you 
that there is always a way to get the solution, and that there are reasons for your model 
acting the way it does. Below is the classic simplified model often used to demonstrate 
the functions.

3.  Face Relations. Manually applied relations that work like sketch  
relations, but are applied directly to faces in the model.

a. Face Relations are listed in PathFinder.

b. Faces are tracked in PathFinder

c. You can repair/replace by right-clicking a listed face.

4.  Steering Wheel. You can use the Steering Wheel to 
move (translate or rotate) faces that are not explicitly 
defined by any of the previously mentioned tools. 

a. The combination of the current selection set and faces selected automatically by Design 
Intent determines which faces will be edited in a given operation. The selection set in 
essence replaces the history-based feature, but it is more flexible.

b. The Steering Wheel element that you choose to use (arrow or torus) 
determines whether the change will be a translation or rotation, 
respectively.

c. You can move the blue handles to determine the direction of  
translation or center of rotation.

d. Select the translucent disk to make a planar move.

e. You can move the starting point of the edit (blue dot), and drag to a keypoint to get a 
From/To type edit, or type in a value, or just drag to make the move.

Not changing

Selection set

Error path

Solved correctly

Isolated faces

Rigid set

Grounded

Relaxed
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From this information, we can summarize that  
with synchronous technology:

1. Design intent comes from the geometry.

2. Design intent can be changed on the fly.

3. Since design is not a linear task, the  
 order of features is irrelevant. 

Tutorials
In this chapter we talked a lot about concepts and thrown around a number of ideas. But in this 
tutorial, you will see for yourself some of the power of design intent in synchronous technology. 

For this, and subsequent tutorials, you can get a 45-day trial of the current version of Solid Edge. 
This is available through downloading a local installation or streaming the full version over  
the internet.

Tutorial 1: Using PMI dimensions to change model
This tutorial was created using Solid Edge ST8.

1. Start Solid Edge from your Windows Start Menu or from the icon on your desktop. 

2.  Click the Application button, in the upper 
left, click New and then select a part tem-
plate with your choice of units. 

Use a default template for now. We will set  
up custom templates for you in a later 
tutorial.

3.  Choose Home tab –> Solids group –> Box . 

The Box command creates a box primitive without requir-
ing a sketch. For other shapes, you can sketch the shape 
and use the Extrude command.

4.  Move the mouse over the base planes in the center of the 
display, and when the Top plane is highlighted, press F3 
to lock your initial rectangle to that plane.

5.  In the CommandBar, set Selection Type to by Center. 

Note: Your CommandBar may not look like the one 
shown here. I am using the Maximum Assistance 
theme, which includes more 
text in the interface. The default CommandBar is docked horizontally at the  
top of the graphics window, and uses icons rather than text.

6.  Click and release the left mouse button on the origin (Base), then 
move the cursor away from the origin.

Synchronous technology 
brings together the most 

powerful tools in 
history-based 

techniques with the 
most powerful tools in 

Direct Modeling 
techniques to give you a 
full range of capabilities 

to create whatever you 
need to create.

http://www.plm.automation.siemens.com/plmapp/se/en_gb/online/Shop?ACTION=trial&drmarketingforce=true#ACTION=trial
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7.  Create the box, assigning actual dimensions, in a 
series of short steps:

a. Type 5. 

b. Press Tab.

c. Type 4.

d. Press Tab.

e. Press Enter.  

f. Move the cursor so the light blue solid appears in 
the positive Z direction. 

g. Type 3.

h. Press Enter. 

You could also simply drag with the cursor and click to accept dimensions visually.

The dimensions placed on the resulting solid are blue dimensions, which means that they 
are unlocked. You can change these dimensions manually by entering values or using the 
Steering Wheel. The system can automatically change the dimensions if another dimen-
sion changes and requires values to change in order to solve properly.

8.  In the images that follow, note that the red arrows on the 5.000 dimension value are point-
ing in different directions, depending onthe cursor position on the dimension value. When 
the cursor is over the left or right side of the dimension value, the dimension changes on the 
left or right side of the block, respectively. When the cursor is in the middle of the number, 
the dimension changes symmetrically.

It may be easier to understand the correlation between the red arrows and the cursor posi-
tion by trying it: move the cursor from the left of the dimension value to the right. Watch 
how the red arrows change. 

9.  When both red arrows are displayed, click the 5.000 value, in the middle.

The display of the red arrows on 
the screen is reflected by the 
selected option at the bottom of 
the value box (double-ended 
green arrow highlighted in 
orange).

If you use your mouse scroll 
wheel, the gray solid changes 
symmetrically. 
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10. Change the dimension value and lock the dimension by doing the following:

a. Type 7.5.

b. Click the lock icon to the right of the dimension value.

c. Press Enter.

The solid changes size 
symmetrically and the 
dimension turns red. Red 
dimensions are locked, 
meaning they can only be 
changed when you manu-
ally type in a value.

11.  Click the vertical 3.000 
dimension. 

12.  To change the dimension so it will change on the  
positive Z side, click the green arrow that points to the left.

Do not lock the dimension.

13. Type 3.25 and then press Enter.

14. Click the top face of the box. 

 
 
 
A white arrow is displayed on the top 
face. This is the Steering Wheel in a 
simplified form. The software 
assumes that if you just click a single 
flat face, you want to move that face.

15. Click the Steering Wheel arrow.

A value box is displayed on the 
model. You can just click to get 
a visual dimensional change or 
type in a value to get an exact 
differential value. The value 
that you type in here will add or subtract from the 3.250 dimension. 

You changed this value in two ways: directly typing in a new value for the dimension and 
directly typing in a differential change amount for the dimension. 

This was a blue (unlocked) dimension, which is what allowed the Steering Wheel to change 
it. The red 7.500 dimension cannot be changed by the Steering Wheel because it is locked.
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Tutorial 2: Design intent and solution manager overview
Now you’ve used simple dimensional changes and been introduced to a simple Steering Wheel 
change coupled to an unlocked dimension.

You can follow this tutorial either in print or the 
linked video.

1.  Open the file from the folder for this chapter 
called “tutorial2 start.par”. 

2.  Click on the face highlighted green in the image 
to the right.

3.  Click on the Steering Wheel arrow and drag it 
back and forth.

Notice the lower ear also moves. To prevent this from happening (or to cause it to happen if 
it’s not happening) remove the check from in front of the Coplanar option in the Design 
Intent panel.

4.  Remove about a half inch of material, using the 
number in the white box as a guide, then click 
the left mouse button to accept the change.

5.  Next let’s make a change that you might have  
to think hard how to do it in ordered, but in 
Synchronous it becomes easy. 

Let’s take the hole on the top ear and angle it in 
the YZ plane. Another way to think about it is to 
rotate the hole about a line parallel to the X axis.

To get started, select the inside face of the top hole, as shown. You 
may notice that you are getting the simplified Steering Wheel instead 
of the full wheel shown to the right. To get the full Steering Wheel, 
click on the big blue ball at the center and just drag it away, then  
drag it back to the edge of the hole, and it will snap to the center, 
 and display the third axis as well as the torus and the tool plane.

Also notice that as shown, you cannot get the rotation you want. We 
want to rotate about X, and the Steering Wheel is currently oriented to 
rotate about Y. To rotate the Steering Wheel, Shift-click on the tool 
plane (blue translucent disk coplanar with the torus).

Note that when you select a hole or cylindrical cut, the Steering Wheel allows you 
to move or rotate the hole, but you cannot use the Steering Wheel to resize the 
hole. Selecting a hole brings up a diameter dimension which can be used to resize.

6.  Now you can click on the torus and angle the hole as well as the  
cylindrical outer face together. Play around with this to get the feel  
for what you can do with the torus. This is a type of edit that you may  
not even consider doing in ordered modeling. Also remember that it is 
completely valid to use normal methods to create something and then 
edit it to achieve an orientation in which it may have been more difficult 
to create.

7.  When you are done, use Ctrl-Z (undo) to return the model to its  
previous state.

Ctrl-Z in Solid Edge works to undo until you save the model.  
You cannot undo functions previous to a save.
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8.  If you use the Steering Wheel to move in the X direction, you will find that the entire model 
moves. This is because no faces have been grounded, and the “Lock to Base Reference” 
Design Intent option is turned off.

Let’s first turn on that option, test it, and then ground some faces.

9.  With the hole face selected, click 
on the Advanced… option on the 
Design Intent panel.

10. Click on the Lock to Base 
Reference  option so that it 
turns orange. Now try to move 
the hole in the X direction again. 
Notice the end radius on the ear 
gets bigger as you move the hole 
in the X direction because the 
face is tied to the end of the part 
that was just locked down with 
the Lock to Base Reference Design Intent option.

Next select the tool plane and move the hole in the XZ plane. This is just to get used to edit-
ing with the Steering Wheel, and the Design Intent options.

Finally, return the model to its original state with Ctrl-Z, and turn off the Lock to base option 
in the Design Intent panel. If you have deselected all model faces, you may have to reselect a 
face to gain access to the Design Intent panel again, as it only appears when geometry is 
selected and ready to edit.

11.  Next let’s lock down some faces, but first we have to 
reposition the model with respect to the origin. 

Rotate the model so you can see the back face, then 
drag a box around the entire part, and move the 
Steering Wheel to the bottom hole, as shown to  
the right.

We are going to reposition the part so that the Origin 
in on the back face, and then lock down all faces that 
are on the base planes.

12.  Click on the Steering Wheel arrow that is parallel to 
the hole axis. This enables us to move the entire 
model along the Y axis.

Move the cursor to the Origin and click the 
Origin keypoint, as indicated in the screen 
shot below. This moves the entire part 
body along the Y axis so that the back face 
is on the XZ plane. 

This technique for moving items will be 
very handy as you use the software.

13.  Press ESC to clear the selection. 

14. On the Ribbon,  
Home tab,  
Face Relate group,  
click on the Ground tool.
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15.  Next, select the three faces 
shown in the image to the right, 
and click Accept on the 
Command Bar.

You will not have to hold down 
the Ctrl key to select multiple 
faces while the Ground function 
is active.

Note that for these screen 
captures, I am using the 
Maximum Assistance theme, 
which adds more text to the 
Command Bar and orients it 
vertically instead of the default 
horizontal Command Bar. This 
setting can also be accessed 
independently from the themes 
using the Application Menu, 
Solid Edge Options, Helpers, 
Command User Interface, Use 
vertical docking window form.

Note also that the face relationships are stored in the PathFinder, as shown to the 
right. Very easy to remember what you’ve applied to the model. Faces highlight 
when you mouse over the relation.

16. Now we will move on to using the Solution Manager, which was mentioned earlier in this 
chapter. The Solution Manager helps you sort out which relationships are causing a particular 

edit to not work as expected. It also helps you visualize differ-
ent solutions to the problem by analyzing the error path, and 
relaxing one of the overconstrained links connected to the 
face you tried to edit.

Select the end face of the model, 
as shown, and drag the Steering 
Wheel arrow out from the model. 
This edit is failing for reasons we 
are about to research.

Finding out why things happen is an important way to understanding how things 
work and what you should reasonably be able to expect your tools to do. A few 
extra minutes spent researching problems from time to time will build your skills 
and knowledge of the software significantly.
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17. Click to place the face about an inch from 
the original. Notice how the model again 
turns colors. 

The colors, from top to bottom, are:

Transparent = irrelevant 
Green = selected 
Orange = error path 
Blue = solves correctly 
Red = isolated (rules off) 
Purple = rigid set 
Black = grounded 
Slate = rules relaxed

The colors that you are concerned about here are 
the orange faces. As a history-based user, you can 
think of all the orange faces being overconstrained. 
Orange is the “error path” color. Think of the path 
as a chain where each dimension, face relation, or 
Design Intent assumption is a link, and you have to 
decide which link to relax, or break in order to allow 
your edit to work.

The way to examine the links in the chain is with right mouse button clicks and hovering with 
your mouse. For example, I can see that the fillet face is part of the error chain because it is 
orange. Notice that the 2.577 dimension is orange, because it is also part of the problem.

When you right click on the fillet face, the Solution Manager shows the set of relation icons 
to the right. The yellow triangle means that relation is part of the error chain, so the tangent 
between the fillet and the top flat face is not part of the problem. 

This tells you that the fillet face has three Design Intent assumptions, and hovering your 
mouse over the icons will highlight the two faces involved in each relation. So hovering over 
the Concentric icon highlights the fillet face and the hole.  

If you click on one of the icons, it will go gray and break that relation temporarily, and show 
what the model would look like with that relation broken. Clicking on the Concentric relation 
breaks the error chain, and fixes the edit error. 

To put the model back the way it was, click on the gray icon again to reactivate it and show 
the model in its error state again.

18. Click the right mouse button again to hide the icons, and then right click on the face of the 
hole. This brings up the concentric icon as well as a dimension icon. If you click the dimen-
sion icon, it goes gray, and the Solution Manager turns the 2.577 dimension to an unlocked 
(blue) dimension, meaning that the edit would drive the dimension. This also solves the 
problem , but in such a way that the hole moves to match the fillet.
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19. Accept this result by clicking on the green checkmark in the Advanced Design Intent.

You may also want to watch the video associated with this tutorial. It does not follow the steps 
exactly, but shows some additional techniques.

There are a few things here to remember, but with all of the symbols decoded and the ways to 
access the information spelled out, the Solution Manager is accessible. With the Solution 
Manager as a safety net, you can feel more secure in exploring more synchronous edits, and 
feeling better about the idea that synchronous really works backwards from the “fully con-
strained” concept. Nothing is going to move unless you allow it, which is the reverse of the basic 
history-based concept which is everything can move unless you constrain it.

http://media.plm.automation.siemens.com/solidedge/solid-edge-st-ebook-ch2tutorial.mp4
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Summary
In this chapter you learned some of the practical details of how synchronous technology edits 
parts. From PMI to Face Relations to the Steering Wheel and Design Intent with the Solution 
Manager, you are in control of how your model reacts to change. And changing how it reacts to 
change is far easier than with history-based modeling. Even troubleshooting overdefined rela-
tionships has a clear and understandable pathway to success.

© 2016 Siemens Product Lifecycle Management Software Inc. Siemens and the Siemens logo are registered trademarks of 
Siemens AG. Solid Edge is a registered trademark of Siemens Product Lifecycle Management Software Inc. or its subsidiaries 
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The Solid Edge® software interface follows Microsoft’s standards. Most functions and interface 
elements will be familiar to most Windows users. You can customize the interface manually or 
use one of the pre-established Themes that use commonly used groups of settings that different 
types of users look for. 

The Solid Edge workflow, or order of operations is often unique to Solid Edge and doesn’t follow 
conventions from other CAD packages. When learning Solid Edge, it is best not to expect it to 
work exactly like some other system. The general concepts are usually familiar to users of other 
software packages, but the details of how you accomplish specific tasks are often different. 
Terminology is often unique to each system as well. 

Solid Edge interface
Let’s continue by identifying the major parts of the Solid Edge interface.

Additional panes can be turned on or off using the View >Show > Panes dropdown list. All of 
these panes can be docked, or moved around the screen, and even outside of the Solid Edge 
application window to put them on a separate monitor. Initially, when learning Solid Edge, you 
will use the Learn Solid Edge pane frequently. The Prompt Bar is important for new and learning 
users. You will use the Select pane frequently to create and modify features. The rest of the 
panes come up on an as-needed basis, however I would recommend the YouTube pane for new 
users who might want to ask questions using video.

Chapter 3

Introduction to Solid Edge 
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Note: The Solid Edge User Community is a great place to ask questions and get 
answers about the software. You need a login to ask questions, but you can read 
what other people have written without a login. Give it a try: https://community.
plm.automation.siemens.com/t5/Solid-Edge-User-Community/ct-p/solid-edge

Customization
Everyone has a different way  
of working, and everyone has 
different desires when it comes 
to how they use the software  
interface. Because of these  
differences, every user has  
different needs from customiza-
tion. If you’re using Solid Edge  
eight hours a day, getting things 
set up properly can save you a lot 
of time. Some users just want the 
interface organized in a certain 
way. Some experts are looking 
for speed, some who are still 
learning the software may need 
to make things easy to find.  

 
Still other goals for customization might be efficient use of space, total number of clicks to 
accomplish a task, total amount of mouse travel, or having all the tools you might use available 
when you need them. Some companies even require that all users use the same interface setup. 
Whatever your goals, realize that there are probably conflicting ideas that you have to balance 
out. For example, the default Solid Edge interface settings are very space efficient, but you have 
to be well acquainted with the interface in order to use it that way. On the other hand, if you  
use the Command Bar with all of the text labels on it, that makes it easy to find things when 
you’re not sure what you’re looking for, but it also takes up a lot of space. Keyboard shortcuts  
can be accessed with no visual interface, but require keystrokes and memorization. Radial menu 
requires two keystrokes for every command, and is limited in the number of commands it  
can contain.

Themes
Just be aware that there are always trade-offs, and each decision requires a balance of poten-
tially conflicting factors. This is part of the idea behind the Solid Edge Themes. Solid Edge 
Themes are out-of-the-box customizations aimed at the needs of different kinds of users. 
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Examples of the Themes are:

• Some Assistance – For users who are partially familiar with the interface and workflow, but 
still need a hint from time to time.

• Maximum Assistance – This is for beginners who are working through tutorials or attending 
classes, and aren’t yet familiar with the Solid Edge workflow and tool icons. (This is the 
theme used for most of the screenshots in this book).

• Maximum Workspace – This option is primarily for expert users who can identify each icon 
by sight, and don’t need tool tips.

• Balanced – This is the default Solid Edge settings which are most useful for users with more 
than a year using Solid Edge.

You can set a theme, customize it, and then save the customized theme to a different name. You 
can even move the theme to other computers or other installations of Solid Edge on the same 
computer.

Customization is available from the drop down on the Quick Access toolbar at the top left of the 
screen. The various toolbar areas are listed as tabs in the Customize dialog, and the entire list of 
commands is available in the window on the left. You can use the Add and Remove buttons 
between the left and right windows to customize each interface element. Use separators, spac-
ers and the Move Up and Move Down buttons to organize your buttons in a way that fits your 
workflow or tool search style.

Customizing for speed  
and efficiency
The Keyboard tab can be 
used to create keyboard 
shortcuts (hotkeys). Hotkeys 
are fastest way to use the 
Solid Edge interface, with 
the downside being the 
need to memorize them. 

If you’re looking for speed 
and efficiency, the radial 
menu, shown to the left, is 
another great option. The 
radial menu can be accessed 
by holding down the RMB for 
a second. 

The Ribbon
The Microsoft Ribbon interface has generated a lot of mixed feelings. However, some people 
believe that the Solid Edge implementation of the Ribbon works better and makes more sense 
than the original Microsoft Office® software implementation. The Solid Edge ribbon expands and 
contracts to fit the available space. As it contracts, most of the space is saved by removing the 
text labels and collapsing grids of icons into dropdown lists. 

Ribbon for 1920 pixel display.

Ribbon for 1024 pixel display. 

The Radial Menu is sometimes called 
the Marking Menu. It appears when you 
hold down RMB. This can be customized 
for each environment: Sketch, Part, 
Assembly and Drawing.

Panes can be docked to the sides or 
floated inside or outside the Solid Edge 
application window.
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You can switch between the tabs by clicking on them or by pressing Alt and then pressing one of 
the keyboard shortcut keys that appear. Notice that the shortcuts are on the Quick Access bar 
and Application menu as well as the Ribbon tabs. 

Pressing the Alt key causes shortcuts to the tabs to appear.

ToolTips
One easy way to get help about the interface quickly is to use ToolTips. You can access ToolTips 
by hovering the mouse over buttons in the interface. Solid Edge has three types of ToolTips, 
which you can control in Solid Edge Options (Application menu > Solid Edge Options > Helpers> 
Command Buttons):

1. Basic 

Basic ToolTips 
show the tool’s 
icon, its name, 
and a brief 
description of 
what it does.

2. Enhanced 

Enhanced 
ToolTips include 
the basic ToolTips 
plus some general tips on usage and  
an image that acts as a visual aid.

3. Video clips

The Video clips ToolTips looks like the Enhanced, but in 
place of the static image, there is a brief animated 
image showing the tool in use. 

For beginning users, the Video clips ToolTips are really 
a great idea. Very often all you need is that brief 
description of how the tool works in words, and then a 
video to show it in action to get you moving. General help often lacks important details like 
where to find something or if there are any prerequisites for a particular function, and some-
times you can find this sort of thing in the ToolTips.

Command Finder
Another type of help that you can make use of for help with the interface is the Command Finder 
at the bottom of the screen. Just type in the name of the command that you are looking for in 
the box, and Command Finder pops open a window with a list of related commands. 

You can also tell it to look for commands that are outside of the current environment. For exam-
ple, if you search for center mark, and are in the Part environment, Command Finder might 
return a list of tools that contain the word “center” or “mark” in their names or descriptions, but 
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the actual “center mark” tool is found in the Draft envi-
ronment. If you look at the bottom of the Command 
Finder window, you will see an option to click for “Show 
matches outside of Environment”, and these matches will 
be shown in a lighter gray font. If there are not matches 
outside of the environment or you have already clicked 
that option, the option will not appear. Choices that are 
grayed out will not flash to show you where they are, 
because they cannot be accessed in the current 
environment.

In the returned list, mouse over your choice of com-
mands, and the Ribbon changes to show you where the 
command is and the button flashes. When you are done 
with Command Finder, the Ribbon stays in the configura-
tion where you can find the command you were 
searching for.

Workflow
Workflow, in this context, means order of operations. 
Most of the Solid Edge interface works with the “Action 
=> Object” workflow paradigm, where you select the tool 
you want to use, and then select what you want to use 
the tool on. An example of this is the workflow to create 
a sketched extruded feature. The workflow is shown 
here for both Synchronous and Ordered:

1. Synchronous

a. Click sketch tool

b. Select plane or planar face

c. Create sketch (click-click method, not click-drag)

d. Click on the Extrude tool button 

e. Select closed region/chain

f. Right click to accept extrude region

g. Set to add or remove material/other options

h. Drag a distance or key in a value

2. Ordered

a. Click Extrude (or Cut)

b. Select existing sketch or a plane to make a new sketch on

c. Draw sketch (click-click)

d. Close sketch

e. Drag or key in distance/set options

f. Right click to Finish

g. Click Cancel to avoid making another extrude

You can also use variations of some of these steps, but these are the commonly used workflows 
for these features. 

Other popular CAD packages enable you to select the plane, the sketch or the feature button in 
different orders, but Solid Edge wants you to follow the process.

The Command Finder can help you find tools 
in the interface, but also can help you find 
equivalent terms from other CAD systems
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I mentioned that the preferred workflow is Action => Object, but there are times when the 
requirements are the opposite. For example, when you make a mirror or pattern in Synchronous 
mode, you must have geometry selected before the Mirror or Pattern tools become available. 
When creating mates, you select the mate tool first, then the geometry. 

In general, although there may be a couple of exceptions, Solid Edge requires that you proceed 
one way or the other, but does not allow you to select tools or items in random order. This aspect 
of the workflow in Solid Edge can be difficult for SolidWorks® software users to accommodate.

The most important thing to keep in mind when learning a new CAD system is that you will be 
most successful if you learn the new system in the way it is meant to be used. Trying to force the 
new system to work like another system generally leads to frustration and failure. Solid Edge has 
a full complement of tools, but it does not work exactly like SolidWorks. Take this bit of advice 
from someone with 17 years of SolidWorks experience who changed to Solid Edge: Learn Solid 
Edge on its own terms. You will not always find a direct comparison between functions in the 
two systems. 

Settings
Most of Solid Edge settings are located in the Solid Edge Options dialog found at the bottom of 
the Application Menu. Most of the settings in this box are global, meaning they apply to any 
document opened on the current computer. There are some settings in here that are document 
specific, however. These settings will travel with the file (or template) with which they are saved.  

 
It may be a good idea for new users to browse through the Solid Edge Options dialog to become familiar with some  
of the settings you can control easily. 
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This section does not explain every option, but picks out the more used or potentially useful 
options for more complete explanation. 

General
• Show units in value fields. Units in value fields can be helpful when you are working with 

mixed units, but can also get in the way when you don’t need to be reminded.

• Store geometry in Part file for fast open. The trade-off here is that file size increases. 

• Enable Dynamic Edit of profiles/sketches. Dynamic Edit in Ordered operations enables 
you to see the finished feature while you are editing the sketch, and the 3D geometry 
updates as the sketch changes. 

The Recompute options should be set to “after edit” if you have a slow or old computer or 
are marginal on some of the system specs such as RAM or video requirements.

• Profile undo steps. The level of undo buffer can affect RAM usage, but can be a great  
convenience. The idea of balance and conflicting desires should be applied here.

• Intellisketch Options. Intellisketch is the set of automatic sketch relationships or selection 
aids attached to the cursor while sketching. These options can also be set in the main  
interface on the Home tab.

• When Creating New Synchronous Sketches. These options should be left at default, 
which is On. Regions are very convenient, especially in Synchronous mode, and if you took 
the time to put a dimension on a sketch, it should probably move to the feature when  
it is created.

• Indicate under-constrained profiles in PathFinder. Users of history-based CAD systems 
tend to be very concerned about under-constrained profiles. With Synchronous, these  
worries should disappear, but some habits are hard to break. 

• Enable “Undo All”. This is the equivalent of exiting a sketch without saving.

• When entering Profile/Sketch. The “Orient the window to the selected plane” option 
applies to Ordered. The view will automatically reorient normal to the sketch plane.

View
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• Quick View Cube, Steering Wheel and OrientXpress. The size settings for these visual 
aids control how visible and selectable the on-screen elements are. Also controls how much 
space they take up on the screen.

• Auto-sharpen. This controls how closely Solid Edge approximates curves. When the arc 
smoothness is low, circles can look like hexagons. The better the curves look, the harder 
your video card will have to work to keep up.

• Use shading on selection. If this is off, a selected face will only show the edges high-
lighted. With it on, the entire face will highlight orange when you mouse over it and  
green when you select it. The same settings apply to reference planes and constructions 
(surface bodies).

Colors

 
I would recommend that you leave the default colors alone. But notice that you can access the 
Background/View Overrides from this page. These are document specific settings which you can 
save with your templates. You can also access those settings by right clicking in blank space 
inside a part or assembly document. 

Save

These settings are for automatic save and backup.
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File Locations

 
To change one of the file locations, double click on the path and then browse to the new  
location. Locations that might be important to control shared documents or documents used 
between versions of Solid Edge are:

• Solid Edge admin options
• Custom settings file
• Macros
• Property seed file
• User templates
• Tolerance tables
• Sheet metal gage file
• Holes database

Inter-Part

 
In Solid Edge, you can specify which types of Inter-Part (in-context) relations users can create. 
These are the relations that create associative links between parts in an assembly. 
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Units

 
Units are probably better set up as template-driven settings. You also need to be aware of the 
role Dimension Styles play in controlling units, standards, and dimensioning before deviating too 
far from the default settings.

Dimension Style

Helpers

 
The Helpers page is where you will find many useful interface settings.

• Start using this template/Start with my last saved document. When this is set, a new 
session of Solid Edge will automatically start with a new document using the specified tem-
plate. This is very useful if you start your day making parts, or if you work on one part for a 
number of days in a row. Set to None to disable.

• Start Part and Sheet Metal documents using this environment. Are you a fan of 
Synchronous? A hold-out for Ordered? You can always start your parts in the same mode 
with this setting.
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• Edit Creation Options. You can remove extraneous templates from the Startup list to 
increase your efficiency.

• Set Default Templates. Most Solid Edge users have specific templates that they prefer 
for each type of document. This setting allows you to select which templates are used as 
defaults for each type of document.

• Show PathFinder in the document view. When this setting is ON, the PathFinder appears 
as an overlay in the graphics window. With the setting OFF, the PathFinder is put into a 
separate dockable pane. In the image on the left below, the setting is OFF, the image on 
the right has the setting turned ON.

• Show command tips. Command tips are similar 
to ToolTips, but show up right in the graphics 
window while you are working. They show up 
as dismissable text bubbles from which you can 
access additional help. For brand new users 
these can be helpful. Resetting them and revis-
iting them may also be helpful to get a refresher 
on some of the workflow and terminology.

• Show basic tooltips/enhanced tooltips/video 
clips. The display and types of tooltips are dis-
cussed earlier in this chapter. 

• Increase buttons on Command Ribbon by 2x. 
This shows the relative size difference when 
using the Increase 2X setting. Notice other text  
in the interface is also increased, including the  
PathFinder text.
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• Use horizontal toolbar form/vertical docking window form.  
This setting refers to the Command Bar, and is one of the items 
controlled by Themes. The horizontal setup is very compact, but 
primarily for experienced users. Because you’ll have to use ToolTips 
to know what the various buttons are for. The vertical setup takes 
up a lot of space, but it contains text so you know what most of the 
buttons are for. Plus, the vertical setup is going to look more famil-
iar to SolidWorks PropertyManager users. Below are both interfaces 
for the same Extrude function.

Again we see the tradeoff between usable graphics space and con-
venience of knowing what the buttons do.

• Radial Menus. The radial menu can be accessed by holding the RMB down for longer than 
the designated period in milliseconds or by dragging the RMB in the direction of one of the 
commands on the radial menu disk (gesture). With touch interfaces, the gestures are use-
ful. In more desktop oriented setups with mouse and keyboard, the RMB delay may be the 
preferred method.

• Advanced Design Intent Panel. Design Intent Panel was formerly called 
Live Rules. The basic Design Intent panel is shown here to the right. This 
is new with ST8, for those of you familiar with previous versions. 

The advanced Design Intent Panel is shown below, and can be rotated 
vertically. Using this Solid Edge Option. 

This is another example of the choices Solid Edge gives users for a sleeker, icon-driven 
interface, or a more explanatory icon-and-text-driven interface.

• Document Name Formula. You can use available document properties to automatically 
build a filename for your new documents.

A video demonstration exists that goes along with the material in the chapter. Click on this link 
to view it. 

http://media.plm.automation.siemens.com/solidedge/solid-edge-st-ebook-ch3tutorial.mp4


Solid Edge with synchronous technology  |  Steering a new course in 3D design 

41 Chapter 3  |  Introduction to Solid Edge 

Summary
The Solid Edge interface follows Microsoft standards and is highly customizable. You can apply 
themes to it to make it appropriate for various levels of user. The interface is also flexible enough 
to be useful on a variety of devices, although you will probably find that as a professional CAD 
product, it is best used on large monitors.
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If you are familiar with creating geometry in a history-based CAD program, you won’t have any 
trouble creating geometry using synchronous technology. Creating geometry in the two environ-
ments is very similar. It’s the editing that holds the biggest differences. The one big difference 
with synchronous technology is that you will need to leave some history-based ideas behind. 
Sketches in synchronous are not associative to the features they create. Said another way, once 
you use a sketch to create a feature, the sketch can be used as reference, but it is no longer tied 
to the part geometry. This is an idea that a lot of history-based users have a hard time accepting. 
Just remember this – when it comes time to edit the part, you can edit the part directly, without 
worrying about steps, or order, or dependency. That is the trade-off.

In this chapter, you will learn about the features, tools and concepts that you can use while  
creating new geometry with synchronous technology. This chapter also includes a tutorial that 
steps you through creating a part from scratch.

Two video demonstrations are available for the material in this chapter. Click on the links for the 
Part 1 video and the Part 2 video.

Primitives
When you are no longer restricted by the constraints of associative sketches, you realize that for 
the most common shapes – boxes, cylinders and spheres – sketches really don’t need to play any 
role at all. In fact, Solid Edge® software realizes this and provides you with the ability to create 
primitive geometry entirely without sketches. The three types of primitives you can create in 
synchronous technology are boxes, cylinders and spheres.

Box 
The Box command is located on the Home tab, in the Solids group. The Box dropdown list 
also contains the Cylinder and the Sphere commands.

You can create a basic box with three clicks. As soon as you select the Box 
command, the software (or Solid Edge) displays crosshairs on the screen,  
as if you were sketching. To change the orientation of the crosshairs, roll the 
mouse over a reference plane or planar model face. To lock the crosshairs  
to a particular orientation, press F3 when the lock symbol appears next to 
the cursor.

To use the Box command:

1. From the Home tab -> Solids group, click the Box command.

2. (Optional) Change settings.

3. To create the first corner, click once.

4. To create the diagonal corner of the first face, click again or type 
values for length and width.

5. To define the length of the box, drag and click or type a value.

Chapter 4

Creating geometry

http://media.plm.automation.siemens.com/solidedge/solid-edge-st-ebook-ch4-part1-tutorial.mp4
http://media.plm.automation.siemens.com/solidedge/solid-edge-st-ebook-ch4-part2-tutorial.mp4


Solid Edge with synchronous technology  |  Steering a new course in 3D design 

43 Chapter 4  |  Creating geometry 

The Box command offers several options:

• Holding down the Shift key between the first and second click creates a box with two equal 
sides. The sides remain equal through changes.

• The initial rectangle can be created in three ways:

• By center – Click center of rectangle, drag half diagonal.

• 2 points (default) – Click one corner, click diagonal corner.

• 3 points – Click first corner, click adjacent corner to establish direction of sides, 
click third corner.

• Symmetric – When dragging the depth of the box, the Symmetric option adds (or removes) 
material equally on both sides of the original plane. When this option is OFF, material is 
only added or removed on one side of the original rectangle.

• Add/Cut – Solid Edge will generally figure out what you are trying to do, but sometimes 
you need to specify your intent. The options are: Automatic (default), Add and Cut. You can 
toggle this setting using the Spacebar.

• Keypoints – Keypoints are very important in Solid Edge, and especially on the synchronous 
technology side. Keypoints enable you to establish direction, distance, or location by 
selecting an existing entity that might be the end of a sketch line, the center of a hole, the 
midpoint of a line, or others. 

Solid Edge has four shortcuts for invoking keypoints, which can be easily remembered using the 
acronym MICE:

M = Midpoint

I = Intersection

C = Center

E = Endpoint

 
When the sketch cursor is over an entity such as an edge, press M, and then click the mouse to 
start or end the sketch entity at the midpoint.

Cylinder
The Cylinder command is located on the Box dropdown list. The Cylinder command works 
just like the Box command, except that the only way to draw the original circle is to click 
the center, then click the radius.

Sphere
The Sphere command is similar to the Box and Cylinder commands. To create a sphere, 
you simply click the center point, and a point to indicate the radius, or type a value.

If you don’t like the placement or orientation of any of these primitives, you can use  
the Steering Wheel to move, resize or rotate them. The Steering Wheel is discussed in 
Chapter 1.
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Sketching and sketches
Although the actual act of drawing sketches in Solid Edge is probably going to be very familiar to 
you, sketches fit into the Solid Edge process differently than in other history-based programs you 
may have used. We have already seen that sketches are treated differently in synchronous than 
they are in ordered workflows.

Besides sketching, in this section we will discuss how you can use sketches differently in synchro-
nous and ordered. Since synchronous has no history, a collection of sketches in synchronous 
behave differently than a collection of ordered sketches. With ordered sketches, you can only 
make references to earlier sketches from later sketches, but in synchronous, every sketch can 
reference all the other sketches. Synchronous sketches are like keeping all your sketch informa-
tion in one big 3D sketch, where there is no concept of order. You can even use synchronous 
sketches to drive ordered features. This can be very beneficial when you need to have several 
features referencing one another.

Sketch Organization in Synchronous
Solid Edge synchronous technology sketches are handled somewhat differently from SolidWorks 
sketches. In SolidWorks, you open a new sketch, and stay in that sketch until you close it. Then 
you open a new sketch, and stay in it until you close it. You may go back to edit the first sketch. 
These sketches can be on the same plane, and they have a history-based relation to one another.

In synchronous technology, any sketch entities that are on the same plane are automatically put 
into the same sketch feature or collector (entry in PathFinder that acts as a folder for items). If 
you start sketching on a different plane, Solid Edge creates a new sketch for that plane. If you go 
back and start adding items on the first sketch plane, Solid Edge adds those new items to the 
original sketch. Synchronous doesn’t use the concept of closing a sketch. You simply turn off the 
sketch tool.

It’s as if all sketch entities are in one big 3D sketch, organized by sketch plane. To create features, 
you can select any available sketch entities from any plane or any sketch. This analogy will help 
the SolidWorks user make sense of the synchronous sketching scheme.

When editing sketches in Synchronous, you can move from editing items in one sketch to editing 
items in a different sketch without closing or exiting a sketch. These concepts don’t exist in syn-
chronous. Synchronous sketches won’t cause a feature to fail because it has too many or not 
enough or the wrong kind of entities in it. These are limitations or frustrations that SolidWorks 
users encounter on a daily basis.

Here is the workflow for synchronous sketching:

1. Select a sketch command (such as Line, Rectangle, or Circle).

2. Move the cursor over a plane or planar face.

3. Watch the orientation of the crosshairs – the sketch plane can shift dynamically  
if you are not actually sketching.

4. To lock the sketch plane, press F3 (or right-click the lock). 

5. To start the sketch entity, for example a line, click and release.

6. To end the line and continue sketching, click and release.

7. To quit sketching the line, right-click or press Esc.
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To switch sketch planes:

1. To make sure you’re not actively sketching, right-click or press Esc.

2. To unlock the sketch plane, press F3.

3. Reorient the cursor over a different plane and watch the crosshairs change direction.

4. To re-lock the sketch plane, Press F3 (or right-click the lock).

The sketches are collected in an area of PathFinder, and can be reordered manually or sorted by 
name. Items you sketched at different times on the same sketch plane are stored in the same 
sketch in PathFinder.

IntelliSketch
IntelliSketch is the set of automatic relations assigned to 
sketch entities as you sketch in Solid Edge. The IntelliSketch 
options are located on the Sketching tab, in the IntelliSketch 
group. You can turn the options on or off as you sketch, to 
help you add relations to your sketches automatically.

IntelliSketch icons attach to your cursor as 
you move it around the screen. In the image, the symbol on the lower right 
shows that the cursor is picking up an endpoint, and the tooltip text  
confirms this.  

Sketch tools
Relate – IntelliSketch automatically applies sketch relations as you sketch, but 
sometimes you need to apply relations manually, and that’s when you use the 
Relate tools. The Relate tools require a special workflow:

• Select the Relate tool you want to use to create a sketch relation.

• Select the sketch entity that you want to move first.

• Select the sketch entity that you want to remain stationary second.

• You can continue to assign relations until you press another tool button or Esc.

Some tools only require selection of one entity, such as the Horizontal/Vertical tool –  
just select a line, and it will snap to whichever state is closest – horizontal or vertical.

You can also select two endpoints, which will become horizontal or vertical from one 
another, such that the one you selected first will move while the second endpoint will 
remain stationary.

Maintain Relationships – Turning this setting off turns off the automatic applica-
tion of sketch relationships. Existing relationships are still valid, but new automatic 
relationships are not created.  

Relationship Handles – This option turns on or off the display of relationship sym-
bols on the sketch entities.  
 

Relationship Assistant – This is only available when the sketch plane is locked. 
Use it on a selection of underdefined sketch elements. The Relationship Assistant 
applies IntelliSketch relations and dimensions. When working with this tool, be 
sure to monitor the Prompt Bar so that you are aware of what Solid Edge is expect-
ing you to select next. 
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Lock – The Lock tool enables you to lock a keypoint or an entire sketch element in 
place. If you lock:

The entire element, none of the keypoints on that element can move.<bullet>A key-
point, other keypoints may move. So a line with one end locked may rotate or 
lengthen.

Rigid Set – A rigid set acts as a single block.

 
IntelliSketch Options – In the IntelliSketch 
dialog box you can define which 
IntelliSketch relations the software adds 
automatically. 

The IntelliSketch Auto-Dimension function gives you 
a high degree of automation for adding dimensions 
to sketches. You can use this together with typed-in 
values to help define new sketches quickly and 
accurately.

Relationship Colors – Many users making 
the change from SolidWorks to Solid Edge 

are very concerned about sketch colors reflecting the fully defined state of the sketch. 
The Relationship Colors tool does this, and is available in ordered mode sketches. 

Note: What constitutes “fully defined” is not the same in Solid Edge and  
SolidWorks. In SolidWorks, for example, if a line is parallel to the X-axis and  
dimensioned at a distance from it, the line is displayed as fully defined (black). In 
Solid Edge, the line must also have one endpoint located along the X-axis and 
have a designated length to be considered as fully defined. Also, the dimensions 
in Solid Edge must be locked (red). SolidWorks does not have an equivalent for 
unlocked (blue) dimensions. SolidWorks allows lines that it determines to be fully 
defined to have open degrees of freedom and move around. Solid Edge does not. 
In other words, SolidWorks allows the state of the endpoints to be different from 
that of the rest of the line, such that the endpoints can be underdefined while the 
rest of the line is fully defined. In Solid Edge, the entire line, including the end-
points, is either fully defined or not.

Features
Solid Edge has two types of synchronous features: synchro-
nous and procedural. The synchronous feature in PathFinder 
acts as a collector for the faces associated with that feature. 
Any dimensions associated with the feature will be PMI, 
attached to the 3D model.

The synchronous features you find in Solid Edge will be of no 
surprise to history-based users coming from other CAD pack-
ages. Both synchronous and ordered modes have extrude, 
revolve, sweep, loft, and so on.

There are some differences, however, in the synchronous way 
of doing things. Obviously, editing features are different, but 
in this section, we are only addressing creation of new 
features.
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The biggest difference to which history-based users will have to adjust is that the sketches are 
not used to drive the features. Once the feature is made, the sketch is really just for reference, 
and gets stored in a collector folder called Used Sketches. To use the sketch again, right-click it 
and select Restore.

Note: The workflow for synchronous extrude and revolve features is generally:

1. Create a sketch with a closed loop.

2. From the ribbon, select an operation.

3. Set options and distance/angle.

 
You could also do this:

1. Create a sketch.

2. Press Esc.

3. Select the region (inside closed-loop sketch).

4. From the CommandBar, select an operation.

5. Set options and distance/angle.

 
Synchronous features are listed in PathFinder, and for simple feature types, such as extrude and 
revolve, the listed feature is a collector for all the faces associated with that feature.

Although features are listed in PathFinder in order of creation, you can reorder them however 
you want without affecting the geometry in any way. You can sort features alphabetically or by 
type. If you click on the name of a feature, the faces associated with that feature will highlight in 
the graphics area. If you delete a feature in PathFinder, Solid Edge deletes from the model all the 
faces associated with that feature.

Procedural Features
Procedural features work more like history-based features in that they have certain non-geomet-
rical parameters associated with them, such as the number of instances in a pattern.

The types of procedural features in Solid Edge are:

• Patterns
• Rounds
• Chamfers
• Holes
• Thin wall (shell)
• Rib
• Vent
• Lip
• Sheet metal features

Double-clicking a procedural feature displays parameters that drive that feature. But this has to 
do with editing, which we will discuss in Chapter 7.
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Tutorial – Creating features
In this tutorial, we’ll walk you through the creation of the part shown on the right. We’ll talk 
about the process and some related facts. In addition, we’ll discuss the decision making process, 
so you learn why we made certain decisions when creating the part.

Base feature
In synchronous, the base feature, or the first feature you 
create, doesn’t matter as much as it does in histo-
ry-based modeling. In fact, it doesn’t really matter at all 
to the rest of the model. The determining factor here is 
simply convenience. You could make this part in a 
number of ways. I’m going to choose a combina-

tion of revolved and extruded features. In the case where 
you have shape on the front and back, revolved features are 
easier because you don’t have to do protrusions and cuts. Plus, you 
just sketch it once, revolve the whole thing, and you’re done.

Create the sketch
1. Open a new part using a template with ANSI mm units.

2. Choose Home tab -> Draw group -> Line command.

3. Place the cursor over the edge of the displayed Front (xz) plane, and press F3. 

 Pressing F3 (or clicking the lock icon) locks the current sketch to the Front plane. 

 Depending on your settings, your display may swivel around, indicating that the view is nor-
mal to the sketch plane. The setting that controls this behavior is in the Application menu -> 
Solid Edge Options -> General -> When entering Profile/Sketch -> Orient the window to 
the selected plane.

4. Starting from the origin, create a sketch 
similar to the one shown at the right. 

 The sketch does not have to be exact. 
Only a few dimensions are placed on it 
so that you just get some practice with 
sketching without getting caught up in 
dimensioning.

 Tips: 
a. You can type in values as you sketch.

b. Sketching is click (release), click 
(release).

c. To end sketching, do any one of the following:
 i. Complete a loop.
 ii. Press Esc.
 iii. Right-click.
 iv. Choose the Sketch command again.

d. If relationship handles (small red symbols) are not displayed, you can turn them 
on from the Sketching tab -> Relate group -> Relationship Handles.

e. To get the tangent arc, once you have finished a line on one side, press A, and 
Solid Edge will transition to the Tangent Arc command. 
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f. Changing the sketch will not change the solid.

g. The solid can be edited by changing dimension 
values.

h. Red dimensions are locked, and you can change 
them. Blue dimensions are unlocked, and you, or 
the system, can change them. Purple dimensions 
are for reference, driven by various sources. 

i. The cursor gives you IntelliSketch feedback, to 
indicate when you can pick up a relationship to the 
end of another line, vertical, or tangent from 
another entity.

Create a revolved extrusion
1. When the sketch is complete to your satisfaction 

and shades an internal area as shown above, 
click the Revolve command.

2. Place the cursor over the shaded area that 
you want to revolve into solid geometry.  
The shaded area turns orange, as shown.

3. Click inside the shaded area. The shaded 
area turns green.

4. Right-click to accept this selection. 

Note: Monitor the PromptBar window 
for messages telling you what the 
software is expecting you to do next. 
PromptBar may be in different loca-
tions around your graphics window, 
depending on the theme you selected 
or your interface settings. 

5. Click the 112.76 mm dimension, as indicated in the PromptBar window.

6. Type in 360 to make the revolution go all the way around. Or you can use the Extent Type 
option in the CommandBar to specify 360 degrees.

7. To complete the revolve feature, press Enter.

 Note: Observe what happened in PathFinder:

a. Solid Edge created new collector folders:

 Features – Contains the new Protrusion revolved feature. In 
Solid Edge, a Protrusion adds material and a Cut removes it. The 
features listed in this folder can be sorted alphabetically or by 
type. The order does not matter. In Solid Edge, there are two 
types of features: synchronous and procedural. A revolve is a 
synchronous feature.

 Used Sketches – Contains sketches that were used to create features. These no longer 
drive the feature and are just used for reference. You can keep them or delete them.

 Sketches – Contains sketches that were not used to create any geometry. Solid Edge 
accounts synchronous sketches differently than SolidWorks. The rules for the sketch are 
less rigid in Solid Edge.
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 Live Sections – Contains sketches that take 
a cross-section of new revolved features 
through the plane of the revolved sketch. 
You can use such a sketch to drive the 3D  
geometry. You can put dimensions on this 
sketch and change the solid. 

 You can turn off the display of Live Sections 
and Sketches by clearing the check box to 
the left of each folder.

b. The sketch dimensions are no longer  
displayed. The sketch dimensions were red, 
but the remaining dimensions are blue and 
purple. You cannot change the purple 6.35 dimension, but you can change the blue 76.2 
dimension by dragging the Live Section. The system can also change the blue dimension. 

Simplify the view
1. Turn off PMI, Live Sections and Sketches folders by clearing the check boxes located to the 

left of each folder.

2. If the planes and dimensions are in your way, clear the check boxes for the associated folders: 
Base Reference Planes and PMI, respectively.

Create a rectangle
1. Choose the Rectangle By Center command, move the cursor 

over the plane lock, as shown, and press F3.

2. If the sketch plane does not reorient 
automatically, click the Front face of 
the Quick View Cube. 

3. Position the cursor over the disc 
aligned vertically from the center, as shown.  
A dotted line shows that the cursor is lined  
up with the origin. 

4. Click the center of the  
rectangle, and then click 
a corner point to create a rectangle approximately as 
shown below. The rectangle is centered across the  
reference plane.

Remember, sketching in Solid Edge is click (release), 
click (release). If you drag the cursor (holding the  
left mouse button down), you will create a different 
type of rectangle that won’t be centered on the  
reference plane.
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5. Add a Vertical relation  between the midpoint of the line and the part origin.

Note: This step isn’t really necessary, because if you created the 
rectangle such that it is symmetrical about the vertical axis, and the 
solid is created from that, then the Design Intent of synchronous 
technology will understand this symmetry and maintain it. Design 
Intent, however, doesn’t work with sketches, only with solids. Also I 
want to show some manual application of sketch relations.

So to add the sketch relation, remember Action -> Object. Click the 
Horizontal/Vertical command (Home -> Relate -> Horizontal/Vertical), then click 
the midpoint of the lower horizontal line of the rectangle, and finally, click the 
part origin. Remember that IntelliSketch adds visual feedback to the cursor to help 
identify what is being selected.

6. To quit the Horizontal/Vertical command, press Esc.

7. It’s best to be in a view other than looking square onto the sketch plane. To rotate the view, 
you can drag the middle mouse button or click one of the corners of the Quick View Cube.

Extrude the rectangle
1. Click inside the rectangle you just sketched. 

The rectangle area turns green and the basic Steering Wheel 
appears.

2. Position the cursor over the extrude handle (the arrow that comes 
out of the solid) and move the cursor from side to side. 

The feature draws dynamically as you move the cursor.

3. To create the feature, either click a second time at your intended 
length, or type in a value.

You created an Extrude feature without invoking the Extrude command.

Round the rectangle edges
1. Choose Home tab -> Solids group -> Round  

(and then select the two edges as shown).

2. Type in 5 and then press Enter.

3. Use the scroll wheel on the mouse to gradually 
increase or decrease the radius of the fillet.

This mouse wheel setting is available in Solid Edge 
Options -> General, above IntelliSketch options, and is 
named Enable value changes using the mouse wheel.

Note: Solid Edge displays the dimension units in the value fields because  
the option, Show units in value fields, is set on the Solid Edge Options ->  
General page.
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Create a circle
1. Choose Home tab -> Draw group -> Circle by Center Point.

2. Hover over the orange face, as shown, and lock the sketch plane by pressing F3.

Optionally, you can click on the appropriate face of the Quick View Cube to rotate the view 
normal to the selected face. The setting for making this rotation automatically was discussed 
earlier, and is found at Solid Edge Options -> General -> When entering Profile/Sketch -> 
Orient the window to the selected plane.

Create a hole
In this procedure, you align the hole on the midplane of the feature. You can align the hole in 
the same way you centered the sketch for the rectangle.

1. Move the cursor over the origin, and then move to approximately  
the location shown.

2. Sketch the circle by clicking the center and clicking a point on  
the radius. 

You should have a dashed line from the center of the circle to  
the origin.

Don’t worry about dimensions just yet – you can be more precise later.  
In this chapter we focus on creating geometry.

3. Set the view to a 3D orientation, select inside the circle, and 
drag the arrow that goes into the material. 

Solid Edge guesses if you want to add or remove material, and 
you can correct the software using the Add/Cut  
button                            on the command bar. 

4. Make sure the hole goes all the way through the solid.

Mirror elements
In this procedure, you mirror the boss, round, and cut you made.

1. Reorient the view so you can see the whole feature, 
and without any tools selected, drag a selection box 
around the feature. 

 The result should look as shown. 

2. Choose Home tab -> Pattern group ->  
Mirror                      .

 If you’re not sure what to do next, read the prompt in 
the PromptBar.

3. Move the cursor over the origin. 

 The three base planes are highlighted, even if they are not shown.
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4. Select the appropriate plane to mirror the selected feature,  
as shown.

 Solid Edge displays the new feature in blue, while the selected 
feature remains green. If you move the cursor over other 
planes or flat faces, the blue mirrored feature may jump 
around.

5. Once it is displayed where you want it, click the plane that 
gives you the correct result.

6. To clear the display, press Esc. 

You mirrored a bunch of geometry that you just selected from 
the screen, without worrying about what feature listed in the 
tree made that geometry. It just happens that our selection of 
faces lined up with three features that we created, but it didn’t 
have to work that way.

Add a hexagonal section
Before you can add a hexagonal section, you must extend 
a circular area and eliminate a round.

1. Drag a box to select just the two green faces, as 
shown.

2. Select the arrow pointing along the axis of the cone, 
and move your cursor toward the small end of the 
cone.

3. Type in 15 mm to extend the feature 15 mm from its 
original location.

4. Press Enter, then Esc.

5. Click the dropdown arrow next to the Rectangle by Center command and select the Polygon 
by Center command                                            . 

6. Lock the sketch plane as shown.

7. Move the cursor to the center of the circular edges, 
click at the +, and look on the CommandBar to make 
sure the number of sides is set to 6.

8. Type in 19 for the included radius, and 0 for the angle.

9. Press Enter and Esc. 

10. Click inside the hexagon and then drag the arrow up.

11. Type in 15 and press Enter. 

A construction circle with a Ø38 dimension is left over. 
You can either delete or turn off the sketch with the check mark in PathFinder, in the Sketches 
folder. The brown/orange color of the dimension means that is has lost its reference.

Making geometry is making geometry, and aside from a couple of small differences, everything 
looks fairly familiar to history-based users, right? 
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Create dimensions
Well, now the fun begins!

1. Choose Home tab -> Dimension group -> 
Smart Dimension.

2. Place the dimension on the edge of the newly created  
mirrored feature, as shown. Use the middle arrow setting, 
and change the value to 40 mm.

3. Click the lock symbol. 

 Locking the dimension changes the dimension to red and 
ensures that the only way that value can change is if you 
change it.

Note the following:

1. We applied a dimension to what history-based users would 
call a child feature, but when we changed it, the parent 
feature changed in size. Lesson learned? Parent/child 
dependencies don’t matter in synchronous.

2. The arrows at the bottom of the dimension value box determine where the dimensional 
change will apply: to the left, to the right, or symmetrically. Lesson learned? Synchronous 
does design intent on the fly. These arrows reflect the red 3D arrows on the dimension.

4. If you forgot to use the center arrow setting, Solid Edge still 
applied the dimension symmetrically, using the symmetry 
design intent. Using the Smart Dimension command, make 
the block stand up off the disk by 45 mm.

5. Click the change arrow away from the main disk and then 
lock the dimension.

Note some additional functionality:

• This time the arrows mean something. The correct arrow 
to have selected is the one toward the free end of the 
block. Changing the dimension on the disk side of the 
block causes the disk to get thicker.

• The dimension automatically accounts for the round, 
and goes to the virtual sharp.

• The base plane closest to the current display determines the plane on which the 
dimension is displayed. If you delete the dimension, rotate the screen and recre-
ate it, the dimension may appear on a different plane.
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6. Change the thickness of the block to 15 mm.

7. Dimension the hole diameter and the  
distance of the hole from the end of the 
block, as shown. Be sure to:

a. Lock each dimension.

b. Make the change arrows go the right way. 

8. Dimension the block from the center of the 
part to be 45 mm, as shown. 

You can also dimension between the inside 
edges of the blocks.
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Create live sections
Using Live Sections, you can dimension the sketch just like you would any sketch, and it will drive 
the model. In synchronous models, live sections are of great help when working with revolved 
features.

1. In PathFinder, click the check box to the left of Live Sections.

2. Place a 150 mm diameter dimension on the disk edge, not on the Live Section.

3. Place a 5 mm dimension on the edge thickness of 
the disk using the short line of the Live Section. 

4. Make sure that both dimensions are locked, and the 
5 mm dimension arrow is pointed toward the back 
of the part.

 Note:

• To move a dimension, drag the dimension line.

• To move the Ø150 dimension, drag the leader.

• To select a dimension to delete it, select the 
leader or right-click the dimension and select 
Delete. Only select the dimension value to  
change it.

5. Place a dimension on the large end of the conical face and assign it to be 21 mm.

6.  Choose Home tab -> Dimension group -> Angle Between                                     . 

7. Place a 92 degree dimension, as shown. Make sure the change arrow is correct, so that the 
side that is already angled will be the one that moves.
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8. In PathFinder, navigate to PMI -> Dimensions, where are all of the dimensions used  
in this part. 

9. At the bottom of the list, turn on all the dimensions you just created on the Live Section:

a. Select the first dimension you created in Step 3.

b. Shift-select the last dimension in the list.

c. Right-click and select Group.

10. With the group collector selected, press F2 and rename it Live Section Dimensions. 

Now you can quickly turn this set of dimensions on or off as a group.

11. Save the file, sit back, and enjoy your handiwork. Try to change a few dimensions, and see 
how simple it is to drive a model through PMI dimensions directly attached to the solid 
geometry.

 
Two video demonstrations are available for the material in this chapter. Click on the links for the 
Part 1 video and the Part 2 video.

http://media.plm.automation.siemens.com/solidedge/solid-edge-st-ebook-ch4-part1-tutorial.mp4
http://media.plm.automation.siemens.com/solidedge/solid-edge-st-ebook-ch4-part2-tutorial.mp4
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Summary
Synchronous technology offers tools for geometry creation that are familiar to history-based 
users, while giving more editing flexibility. Where most synchronous features simply contain 
geometry, procedural features also remember some metadata such as number of instances in a 
pattern, or type of hole. There is no better way to learn than by doing, so this chapter is dominat-
ed by a tutorial with various creation and editing steps.
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In synchronous technology, you can change the size, position, or orientation of whatever you 
have selected. If you want to make a change, it doesn’t matter how the geometry was created, or 
how or if it is grouped into features, it just matters which faces are selected. You could have 
faces created as portions of various features, different types of features, imported, native, faces 
inserted from a different model, and so on. 

You can also save selections 
as part of a group, or user 
defined set, and each time 
you create new geometry, 
Solid Edge® software remem-
bers the faces associated with 
that particular set. There is 
also a feature type called 
Procedural Feature, which 
works in some ways like history-based features, with metadata associated with the feature, but 
still without any associated order, sketch or dependencies.

All of this talk of saved sets of faces can make one think of re-using, or copying sets of faces to 
be used in other places. 

So for these reasons, this chapter lumps together the topics of selection, selection methods, 
saved and re-used selections. 

Selection methods
Since the selection of faces is so integral to how synchronous technology works, we’re going to 
spend some time talking about how to select what you want to change. 

There are multiple methods for selecting faces:

1. Selecting individual faces

2. Using Ctrl-Select

3. Using Selection Manager

4. Fence/Window/Box selection

a. Using the Overlapping setting

b. Using the Selection Filter

5. Automatic addition to manual selection through Design Intent settings

Chapter 5
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Note: Sometimes, users who are new to synchronous want to be able to make 
changes using edges or vertices, since these are also recognized entities that can 
be selected. An edge is just the intersection of two faces, and a vertex is the  
intersection of three or more edges. So the common denominator in all of these  
is the face. 

You cannot make changes in synchronous technology by using edges. Remember 
that even when you select edges to create dimensions, the dimensions are 
assigned to faces. Edges are commonly removed by rounds, chamfers, or other 
features, and lost reference entities tend to cause a lot of downstream problems 
when making edits to the geometry. Faces are more stable references.

Selecting individual faces 
Selecting individual faces is easy enough. Just point and click. 
Right? Well, most of the time. But what if you have already 
selected something, and you want to deselect it or select 
something else? 

Deselecting is also fairly simple, although it may not work the 
way you might anticipate. To deselect a face, you can press 
Esc, Ctrl-Select, or just select another face. 

If a command is already active, and you are selecting at the 
prompting of the Command Bar, you may have to use the 
Deselect button in the Command Bar. This works mainly for 
selections such as edges or sketch entities in a command like 
the Sweep where multiple selections are often necessary. In 
general, however, if nothing else is active, Esc or selecting 
something else will deselect the current selection. There is also a Clear Selection option in the 
Select dropdown menu located at Home -> Select. Clicking on an already selected face will not 
deselect it unless you have the Selection Manager active, which we will discuss shortly. 

Recognize also that there is a difference between a face 
being highlighted and a face being selected. Orange is the 
default color for highlighted, meaning your cursor is over 
it, and if you click right there, that is the face that will be 
selected. Green is the selection color.

Note: It is generally considered best practice  
to avoid standard interface colors when  
assigning part colors. Standard interface colors  
in Solid Edge include orange, green, light blue,  
and secondarily, any of the colors from the  
Design Intent interface. 
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QuickPick
The QuickPick tool enables you to select hidden or overlapping faces, or other 
entities that may be more difficult to select directly. When you hover your 
mouse over a surface and delay for more than a second or two, the mouse 
icon with three dots will be added to the cursor. This is prompting you to right 
click for the QuickPick selection. 

The QuickPick list box names each entity that is directly under 
your cursor at the time. This can include hidden faces (on the 
far side of the part), faces of internal holes, or other types of 
entities, such as features or bodies that a simple click might be 
too ambiguous to identify. As you move your cursor over each 
item in the list, it will highlight in the graphics window, and 
clicking the item in the QuickPick list will select the actual item.

It should also be mentioned here that tool tips appear on the 
cursor and in the QuickPick list identifying the type of face that 
is about to be selected. You see that the Cylinder tool tip is displayed on the cursor in a previous 
image, and in the QuickPick it identifies that cylinder and a torus. The symbols used for QuickPick 
help you identify the type of entity listed.

QuickPick can help you select faces, edges, curves, planes, features, bodies, sketches, sketch 
entities, coordinate systems, parts in assemblies, and more.

Using Ctrl-Select
Ctrl-Select is another Windows standard method that you should be familiar with. 
However, Solid Edge has its own take on making multiple selections easier to use. 
After you use Ctrl-Select to pick the second face, you don’t need to hold down the Ctrl 
key for subsequent selections. Solid Edge adds the plus and minus symbols to the cur-
sor, clicking on unselected items adds them to the selection set, and clicking on 
selected items removes them from the selection set. 

Using the Fence/Window/Box selection method
Many older CAD systems, particularly the 2D systems, work on a similar “select and edit” princi-
ple used in synchronous technology. Selecting multiple items is generally handled by a method 
alternately called “fence”, “window”, or “box” select. In Solid Edge, “box” select refers to a 3D  
volume, and “fence” select refers to a 2D rectangular area.

Fence selecting all faces within a rectangular area will select all faces within the selection fence 
regardless of depth into/out of the screen. So faces obscured by other faces, as long as they are 
completely within the rectangular selection fence will be selected. So the orange selection fence 
in the image below left results in the selection of hidden faces shown below right.
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This concept and the application of it should be pretty straight forward, since all computer users 
make use of fence selections in applications outside of the CAD realm on a daily basis. 

Techniques that you can use along with the 
fence select method involve pre-orienting 
the screen to help you get the desired selec-
tion set more easily. For example, the view  
orientation and selection fence shown to  
the right might make it easier to get the 
selection from the images above.

In any case, this is one of those things that will improve with 
practice. And remember that you don’t have to select everything 
all at once. You can use Ctrl-selection as well as multiple fence 
selections to get the final selection set that you need for a particular edit. You may also find it 
easier to perform multiple edits from single selections. In the end, it’s up to what you find easier 
in a given situation.

Using the Overlapping setting
The Overlapping setting can be found on the Select group on the Home tab. Using 
this setting will select any face that is completely or partially within the selection 
fence. So the selection depicted in the screen shots below would result from using 
the Overlapping setting.

The Overlapping setting is turned off by default, and is not commonly used. Still, it’s something 
that’s available, and you should be aware of its existence in case it might come in handy.

Polygon Fence
In draft mode, you can use a polygon fence for 
more intricate selections, but this option is not 
available in part or  
assembly mode. A poly-
gon fence is an irregularly 
shaped polygon that you 
would use to select the 
items inside or intersecting 
the polygon. To create one,  
I show the example of a sketch  
on a draft document. In the Select 
Command Bar, activate the Polygon Fence 
tool, then click near what you want to select. 
Each click creates a new corner of the polygon. Keep clicking to  
create corners until you have the items inside the polygon that you 
want to select, and everything else outside the polygon.
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Using the Selection Manager

The Selection Manager 
dialog.

The workflow for using the Selection Manager has changed 
slightly within the last few years, so if you go searching for 
YouTube videos on the topic, you may find obsolete methods. 
You can access the Selection Manager from the Home tab, 
Select group, on the Select drop down list. Or if you prefer keyboard 
shortcuts, Shift+Spacebar will also get you there.

The Selection Manager enables you to make selections based on geomet-
rical criteria, such as all concentric faces within a box, or all connected 
faces. It sounds very similar to the way Design Intent works, but Selection 
Manager requires more interaction from the user. Design Intent starts 
with a lot of automated rules turned on by default, where Selection 
Manager requires the user to actively select the rules.

During the development of synchronous technology and  
its related tools, two of the product managers half-jokingly  
referred to the Selection Manager and Design Intent as  
Finders and Keepers respectively. 

“If for example you want to select all coplanar faces prior  
to an action, you would use the Selection Manager – a  
“finder” operation. If you had already started an operation  
and wanted to exclude coplanar, you use Design Intent as  
a “keeper” operation.” – Chris Dayton, Product Planner for  
synchronous technology

After you have activated the Selection Manager and selected a face to start from, the Selection 
Manager dialog appears to help you use some automated decision making rules to select groups 
of faces. 

One of the very attractive aspects of the 
Selection Manager is that you can limit 
the selection to faces that match the 
criteria and are within a 3D volume 
that you specify.

One way in which you might use 
the Selection Manager would be 
to turn off the Design Intent 
options, and simply pre-select all 
the faces you want to change 
using the criteria and tools in 
the Selection Manager. You 
can also use the Selection 
Manager to deselect faces, 
which might be important in 
more complex operations.

Overall, the Selection Manager is a tool 
you don’t see demonstrated as much as 
Design Intent, but for some people, it might 
offer more security in that it enables you to 
pre-select the faces that the Design Intent/Live Rules 
would otherwise select for you automatically. 

 
Selection Manager 
mode enables  
you to find faces 
that fulfill certain 
geometrical 
conditions.
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In the image shown above, Selection Manager was invoked using Shift + Spacebar, and the 
green cylindrical surface was selected. This brought up the Selection Manager dialog, and the 
mouse hovered over Concentric, which highlighted the other concentric cylindrical faces in 
orange. To exit the Selection Manager and proceed with the operation, such as move or copy, 
press the Spacebar.

Re-using geometry in synchronous technology
When you are not limited by the way features are defined, you have much more flexibility to 
re-use existing geometry where the same geometry exists again. This is one of the key, underly-
ing tenets of synchronous technology, so you may want to read that first sentence again. In stan-
dard history-based CAD, you have to worry about two things when re-using geometry: First, is all 
of the geometry you need part of a single feature, or would you need partial features? And sec-
ond, is the geometry you want to re-use dependent upon something else?

When you are not limited by the way features are defined, you have much more 
flexibility to re-use existing geometry where the same geometry exists again.

You really shouldn’t have to worry about things like relationships in re-used geometry. You 
should just be able to see some geometry you want to copy, and copy it. Whether it goes in the 
same part, or in a different part, copy the faces from here to there, position them, and incorpo-
rate them into the model. Done.

Sometimes you may need to create a pattern that doesn’t fit available tools nicely. You don’t 
have regular recurring groups, or the pattern goes between parts. Or maybe you have a particu-
lar shape that you make frequently, like a port cavity that you might need to add to any sort of 
part at a particular time. You should be able to pull a cutout from a library without having to 
create some sort of dummy material for it to be cut from. 

Let’s show some examples of copying geometry, and also saving geometry into a library for  
later re-use.

Selections in assemblies
Selections in assemblies follow the main concepts outlined here, but also have more types of 
data to deal with. For that reason, selections in assemblies are handled in the Assemblies chapter 
rather than here.

Tutorial – Copying geometry
1. Open the Spindle.par part from the 

folder for this chapter. This part was 
built natively in Solid Edge ST8. 

2. Box select the lug and the hole at the 
top, and then Ctrl-Select the hole to 
the right. You could probably get all 
of this in a single box select, but 
practicing different methods is a 
good thing. At the bottom of the 
screen, you should get a prompt that 
says “7 items are selected”. The lug 
itself has 4 faces, the hole on the lug 
has 2, and the separate hole has 1,  
for a total of 7. 
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 Make sure that you don’t accidentally get any of the faces from the 
back side of the model.

3. Now drag the big blue ball (origin) of the Steering Wheel, and drop 
it on any of the circular edges that is concentric with the main axis 
of the part, so that the Steering Wheel torus goes around the axis. 
The part should now look like the image on the right.

Notice we have selected what could be a portion of a fea- 
ture. That hole to the right could be the “child” of a mirror  
or of a pattern, or part of some other situation. But we  
can make a copy of it without worrying about any of that.

4. Holding down the Ctrl key, click and drag clockwise on the Steering 
Wheel torus. Drop the left mouse button, release the Ctrl key, key in 
45 to the value box, and press Enter, then Esc to deselect the newly 
copied faces.

If Solid Edge opens up the Solution Manager at this point, just turn 
off the Design Intent options, and things should land in place. Don’t 
forget to reinstate the Design Intent settings when you are done.

If the resulting geometry shows up as blue rather than gray, it cop-
ied the faces as surfaces because you got an extra face, or landed 
the faces in a place where they could not reattach to the model, 
Press Ctrl-Z (undo) and try it again. 

5. Next let’s try something a little different. Click on the Selection 
Manager Mode tool, located on the Select drop-down list. Your cursor 
will get a green circle with a white plus sign on it.  Next, click on 
the cylindrical face highlighted as shown in the image to the right.

6. From there, the Selection Manager appears. Select Recognize -> 
Feature, and the spindle will highlight green. Press the Spacebar to 
get out of Selection Manager mode, but still retain the selection. 

7. Use the Quick View Cube to go to the Back view K (or use Ctrl-K). Use Shift-Left Arrow or the 
curved arrow on the Quick View Cube to rotate the view so that the spindle is point straight up.

If necessary, move the Steering Wheel such that one arrow is pointing in the Z direction. Hold 
down the Ctrl key and tug the Steering Wheel arrow in the positive Z direction. 

Note: If you make a mistake and forget to push the Ctrl key before clicking on the 
Steering Wheel arrow, Solid Edge will think you are trying to move the spindle 
rather than copy it. You can just press Esc, and it will retain the selection for you  
to try again.
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8. Drop the mouse buttons and keyboard keys, and key in 1.3 and then Enter, and Esc.

Note: If the copied spindle does not turn gray and 
merge with the rest of the part, and instead turns 
blue, that means it has been copied as a surface 
body. You can find the new body in the PathFinder, 
probably identified as “Face Set X”, right click  
on it, and select Attach. This does a number  
of things automatically, including extending  
and trimming the surface body, and then merging 
it with the existing solid body. You could do all  
of this manually in Solid Edge, but it would be a 
tedious process.

This type of edit produces a result that doesn’t make much sense from a mechanical design point 
of view, but it does demonstrate a technique that you will need frequently.

Copying geometry from one part to another
9. One last demonstration. Drag a selection box around the 

spindle as shown. You should have 6 items selected. 

10. With the selection still active, move the Steering Wheel to 
the bottom of the spindle selection such that the torus is 
around the axis of the spindle, and press Ctrl-C (copy) on 
the keyboard.

11. Now open the Piston target.par part from the folder of 
files for this chapter, and press Ctrl-V (paste). Use the 
Steering Wheel arrows to position the spindle so that it is 
fully contained on the rod, as shown. Click to finish the 
positioning.

12. Now find the Face Set in the PathFinder, right click on it, and select Attach. This will merge 
the spindle onto the piston rod. 

 
A brief video accompanies this chapter. 

http://media.plm.automation.siemens.com/solidedge/solid-edge-st-ebook-ch5-tutorial.mp4
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Summary
Synchronous technology changes are driven by face selections. In synchronous, the selection is 
the feature. The software supplies several ways to select what you need to get, including the 
automated methods of Selection Manager and Design Intent.

Because there are no restrictions on “parent/child” dependencies, or feature order in the tree, you 
can re-use any geometry you can select. 
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In the history-based CAD world, it is common to refer to imported data as dumb because the 
metadata necessary to drive history-based features is never transmitted along with the geome-
try. This is true whether the transfer is between two entirely different CAD programs or between 
different versions of the same program. You lose all of the intelligence, or design intent in a  
data import.

Some history-based CAD programs have features that are meant to look like direct-edit function-
ality, but they in fact create additional history-based features. This is not direct edit, and just 
compounds the problems associated with sequentially rebuilt history-based features, namely a 
big time lag associated with simulating direct edit functionality. Don’t be fooled by this, you are 
still paying the history-based rebuild tax unnecessarily.

However, in synchronous technology, the design intent comes from the geometry itself, not 
from metadata stored with the geometry. If there are parallel faces, the chances that they are 
parallel by accident are very, very low. The software assumes this is intentional, and retains that 
relationship as design intent.

Synchronous technology can even recognize things like patterns, and holes in imported parts, 
and can create editable synchronous features. This is not some program that rebuilds the exist-
ing geometry with history-based features: it just assigns properties to the existing imported 
geometry. So if you created mates to holes in a pattern, and then run feature recognition to 
assign properties to those holes, the mates will continue to reference the original holes.

Reading native data
Solid Edge also has tools for import, such as direct import from SolidWorks, Inventor, and PTC 
Creo. To read these files directly, you must have Solid Edge installed locally, and the other pro-
gram installed in a place where it is accessible on the network. Later in this chapter, we show the 
steps for migrating a SolidWorks assembly into Solid Edge.

The advantage of using the migration tools as opposed to simply importing data is that with the 
migration tools you get some assembly mates and some procedural features that come across 
into synchronous, and all native features translate as face sets (synchronous features).

Translation data types
One of the first things to address is the 
type of data being translated. The best 
type of data to send or receive for Solid 
Edge users is Parasolid. Parasolid files can 
come with a couple of different file exten-
sions, but the most popular are “*.x_t” 
(text-based transmit file) and “*.x_b” 
(binary transmit file). Parasolid also has 
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various versions, so if you are sending data to an older CAD program, make sure that it can 
accept the data that you write out.

Other common translation formats, in decreasing order of desirability are:

• STEP
• VDAFS
• ACIS
• IGES

Future version
Another big problem with history-based systems is the future version problem. This is the situa-
tion where you get native data from someone else, but you have an older version of the software 
than the sending system, so you can’t read the data. You’re likely to encounter this problem with 
most, if not all CAD packages. The solution, generally, is to get a Parasolid file instead, but as 
mentioned before, all of the intelligence is lost.

You can also run into the future version problem with Solid Edge, and the solution is the same, 
but the results are different. As you know, when this happens with history-based systems, you 
lose assembly mates and the ability to edit parts (all you can do is add features). It’s as if the 
import came from some completely different CAD system.

Solid Edge with synchronous technology, however, can immediately edit all prismatic parts as if 
they were native. In addition, if the imports have patterns or holes, you can run recognition rou-
tines and actually make it native data. So with Solid Edge, Future version problems become an 
inconvenience instead of a complete change of direction.

Data migration
Solid Edge has three data migration tools. These tools pull 
native data from Inventor, Pro/E, or SolidWorks and create 
Solid Edge files. For this to work, you have to have Solid Edge 
installed on a local machine, and the other program installed 
on a computer that is accessible through the network.

The input for this process is a folder full of native parts and 
assemblies. The output is a set of Solid Edge parts and assem-
blies. Assemblies will bring across mates that use planes or 
axes. Parts will be synchronous, with the faces divided into 
user-defined sets of faces that correspond to the original 
SolidWorks features. This enables you to delete or move faces 
by feature.

You can find the Solid Edge migration 
tools in the Windows Start menu, under 
the Solid Edge entry. You must set up the 
paths for the various requirements, such 
as where the templates come from and 
where the finished Solid Edge files go.

Data Migration tools work better than 
using Parasolid, because you get synchro-
nous features and assembly mates. In 
addition, it’s automated, so if you have a 
large number of assemblies to convert, 
you can set it to unattended.

Migration tools translate parts and assemblies, and allow you to set 
up various folders for the use of the tool.
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These images show, clockwise from the upper left, 
the original assembly in SolidWorks, the migrated 
assembly in Solid Edge with several of the mates 
that came over connected to the block casting 
part, and to the right, the synchronous features 
that came over to Solid Edge on the block casting 
part.

When you import an assembly through Parasolid 
or other formats, each part is grounded in place. 
But when you use the migration tools, many of the 
parts will get enough mates to allow for motion 
without further intervention. The quality of the 
end result depends in part on the quality of the 
data you start with, and also on the fact that only 
mates that apply to planes or axes can be recre-
ated in Solid Edge.

Getting this sort of information with a CAD trans-
lation is something that history-based users have 
given up on long ago.

SolidWorks Associative  
Drawing Migration
At this writing, this tool is heading into Beta test-
ing, but by the time this eBook is published, the 
tool should be available to the general public. It 
should be available as a part of ST8.

Prior to the introduction of the SolidWorks 
Associative Drawing Migration tool, we relied on 
DXF translations for drawings. These were not 
associative, so that changes to the parts were not 
reflected in the drawings. With the drawing migra-
tion tool, the drawings migrated to Solid Edge 
from SolidWorks will be associative to the 
migrated 3D models. This of course will make 
switching to Solid Edge to take advantage of syn-
chronous technology that much easier.

The SolidWorks Associative Drawing Migration tool 
will work with principal, section, auxiliary, and 
detail views. You will be able to use shaded, partial 
sections, cropped and broken views. Dimensions 
and annotations recreated in Solid Edge will be 
connected to the drawing geometry. Tables and 
additional geometry will also be available for 
reference.

Similar to the migration tools for parts and assem-
blies, you need a version of SolidWorks 2012 or 
later as well as your Solid Edge license to make  
this work.
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Import/export options
When you import or export files to/from 
Solid Edge, a button labeled Options 
becomes active in the dialog box. The 
Import options, shown below, enable you 
to handle some of the typical issues with 
transferring bodies and surfaces, as well 
as individual parts within an assembly.

Export options that enable you to set 
parameters are also available. The export 
options are different for each type of 
export format. If you are having difficulty 
getting a good transfer of geometry 
between two packages, these options are 
one place you should look.

In the end, successful knitting of all sur-
faces into clean, healthy solids is impera-
tive for edits in synchronous technology to 
work. The small entities mentioned in the 
Geometry Inspector section can also derail 
certain synchronous edits, so merging 
smaller slivers into larger faces of the 
same type is crucial to getting successful 
synchronous edits. Remember from the 
more conceptual chapters that consuming 
topology is easy, but recreating it is not.

Feature recognition tools
The recognition tools in Solid Edge can be found on the Home tab, Solids group and Pattern 
dropdown list, under their respective feature names for Holes, Rounds/Chamfers, and Patterns.

Solid Edge has three recognition tools that will be valuable if you receive a lot of translated parts:

1. Hole Recognition – Recognized hole 
features allow you to change the 
diameter, move, or delete multiple 
holes that were recognized as the 
same diameter all at once. This enters 
into PathFinder a collector for the 
general hole type and individual fea-
tures for individual holes.

2. Chamfer Recognition – Chamfers can 
be recognized, edited, identified, and 
deleted in the same way that holes 
can. 
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3. Pattern Recognition – Before running pattern recognition, it’s a 
good idea to first run one of the other recognition tools. There is a 
separate tool for recognizing hole patterns vs. patterns of general 
features. Hole patterns also have the ability to recognize patterns of 
patterns. The advantage of recognizing patterns is the ability to 
change the number of features in a pattern. Holes can generally be 
moved or deleted in groups, even if they are not part of a pattern, 
just by selecting the collector in PathFinder for that type of hole. 
Alternately, you can Ctrl-select, or fence select, features that are not 
grouped into a single collector.

Geometry Inspector
When geometrical data is imported, sometimes errors occur. Errors will be more common if you 
use IGES or ACIS translation formats. Parasolid is the most reliable format to and from Solid Edge.

Note: When doing translations of parts or 
assemblies, best practice recommends that you 
round trip any file you save out. This just 
means that any file you write, you should also 
try to read back in. You should also recom-
mend this to anyone sending you data. This 
guarantees that at least the package that 
wrote the data can also read it, which will help 
eliminate translation errors. Units are a com-
mon source of problems, as are multi-body 
parts and surface bodies.

When you receive translated data, you should start 
out by running some diagnostics on the imported file. Diagnostics are especially important if you 
find the model behaving strangely, such as not allowing you to select certain faces, faces won’t 
accept mates, unexpected parts of the model appear black or transparent, or you see spikes or 
other anomalies.

The Geometry Inspector command is 
located on the Inspect tab, in the 
Evaluate group.

Geometry Inspector is looking primarily 
for faults in the geometrical data, and 
optionally for small entities. Small enti-
ties are frequently where you find a lot 
of geometrical errors on imported data, 
and can make some functions such as 
creating Thin Wall features, offsets, or 
rounds difficult to create. You can spec-
ify how the Geometry Inspector should 
define small within the interface.

To use the Geometry Inspector, open 
the part you want to check and then 
click the Geometry Inspector button. 
Set the options to look for either Faults 
or Small entities, and then click Go.
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If there are no faults, the Result description box will state that. Also, faults or small entities will 
be highlighted on the model in the graphics area. If you find faults, you should first click the Heal 
Body Faults button. This automatically tries to fix the faults. If you use this a couple of times, and 
the Geometry Inspector still reports faults, you may need to manually repair the fault. There are 
many ways in which you might go about this, including using surface modeling to dissect and 
reassemble the faces around the fault or simply cutting out a solid chunk and remodeling over it. 
Rounds are often the source of errors, and deleting a few faces around a fault may be all it takes. 
This is an area that requires advanced experience, and is really beyond the scope of this book. 
Besides, the tools needed are not that different from the tools you would need in history-based 
software.

Editing imported parts
Editing imported parts is only different from editing native synchronous parts in one respect: 
There are no procedural features in PathFinder. For that reason, there will be no editing  
section in this chapter. Everything that would be said will also be said in Chapter 7: Editing with 
synchronous technology. Many of the parts we use in that chapter will be imported, just to make 
things simple.

 
This chapter has a brief video to accompany the text.

http://media.plm.automation.siemens.com/solidedge/solid-edge-st-ebook-ch6-tutorial.mp4
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Summary
Working with imported data is one of the strengths of synchronous technology because the data 
can be edited immediately after import, or it can be massaged with recognition routines for addi-
tional usability. In addition, the migration tools take parts and assemblies to another level by 
adding synchronous features and mates. With synchronous technology, there is no such thing as 
dumb geometry.
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We have already talked about the biggest differences between history-based modelers and syn-
chronous technology being that the method of editing has nothing to do with how you originally 
model the geometry. When you switch from history-based modeling to using synchronous tech-
nology, many of the habits you learned in history-based methods become not only obsolete, but 
also counterproductive in many cases. For these reasons and more, as you learn how to make 
edits with synchronous technology, you should approach it as something completely new. Don’t 
expect it to work like history-based CAD software, with all of the best practice rules that you 
have become used to, because it is different. Expecting synchronous to work like history will lead 
to frustration. It’s different; it works differently; it has different strengths and weaknesses. 

Note: A brief video goes along with the content of this chapter. 

Assume everything is possible
You should start with the assumption that everything is 
possible in synchronous technology. Synchronous, of 
course has limitations, but there are things that are  
possible in synchronous that will surprise you. Things 
that you would not even imagine doing in history-based 
software, such as controlling a “parent” from a “child” 
feature, editing only part of a “feature”, rotating an 
entire feature out of the plane in which it was created, 
and so on. If you give up the idea of the limitations of 
history-based CAD that you have learned to live with, 
the realm of what is possible with synchronous 
will open up for you, and you will be much more 
successful with the switch.

Learning the capabilities of a system is one thing, 
but in order to maximize your effectiveness, you also need to 
understand what you can and cannot do with it. This might sound like a contradiction of the 
previous paragraph, but we are preparing you for a big shift in how you approach editing 
geometry. 

Limitations of editing with synchronous technology
Once you understand the boundaries of a system, it’s easier to learn what it can do. Synchronous 
technology has two main limitations that you need to know about before you start modeling:

1. Synchronous technology as implemented in Solid Edge® software can only edit prismatic 
geometry. Spline-based general NURBS surfaces can be created and can exist in synchronous 
technology, but they can only be edited through history-based techniques.

2. Synchronous technology can consume topology while editing, but cannot re-create it (during 
the edit process) once it has been consumed. 

Chapter 7

Editing with synchronous 
technology

http://media.plm.automation.siemens.com/solidedge/solid-edge-st-ebook-ch7-tutorial.mp4
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Both of these statements deserve further comment, and the next section is devoted to a more 
complete explanation. The statement about “topology” will also be demonstrated in a later  
section of this chapter. 

Prismatic versus spline-based general NURBS
For the previous statements to make much sense, we have to define some of the terms.

The word “prismatic” denotes combinations of the following types of geometry:

• Planar 
• Cylindrical 
• Conical 
• Spherical
• Toroidal (doughnut shaped, with double curvature)

This means any shape you can create by extruding or revolving any combination of straight lines 
and arcs is considered “prismatic” (sometimes also referred to as “analytic”). These are all readily 
editable by synchronous technology.

Splines are general curves with continuously changing curvature, with the exception of ellipse, 
hyperbola or parabola. We don’t need to get too deep into the technical definitions here. In Solid 
Edge, splines are called “curves” in the sketch tools. You can create geometry from splines/curves 
in synchronous, but you cannot edit those faces directly. You can, however, make synchronous 
sketches that drive history-based features. There is an example of this later in this chapter. It 
sounds mind-blowing, but it is not only possible, but highly useful at times.

The only methods available for editing spline-based complex geometry are moving/revolving, 
replacing or deleting the face, or of course cutting it off of the model or consuming it in other 
geometry.

For this reason, when you run into complex or spline-based geometry, we recommend that you 
use an ordered feature for that type of work.

Creating topology
For our purposes in this book, we will take “topology” to mean “the number, type and connectiv-
ity of faces”. The types we refer to are simply the prismatic types mentioned above. So a box has 
topology consisting of six planar faces, where each rectangular face is connected to four other 
rectangular faces at the edges. A cylinder’s topology consists of a single cylindrical face with two 
planar faces normal to the axis. 

Spline-based faces are also topology that you may see in Solid Edge, but this discussion is about 
topology that can be edited directly using synchronous methods, so the spline surfaces are not 
discussed here.

In synchronous, you can eliminate the top flat 
face by applying the rounds on the top corners, 
but you cannot go backwards through the 
process to get the flat face back. This works 
much like 2D editing of the same type of shape.
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Deleting topology happens frequently enough. One example would be when you put a full 
radius on the end of a part that encompasses two edges. For example, the image on the previous 
page, on the right, shows a block, and then rounds applied that eliminated the flat face on the 
top to make a tombstone shape. In this situation we say that “topology (the flat face on top) has 
been eliminated by the round”. Synchronous can create this situation, but it can’t go through this 
process in reverse: that is, starting with the tombstone shape, and recreating the deleted topol-
ogy by simply changing the radius dimension. Going through the process in reverse will fail in 
synchronous. If you can still use Undo, you could get the flat back, or you could simply cut 
another flat, reassign the tangents and correct the length. (The preferred method here would be 
to apply the rounds in Ordered mode to the rest of the part which is in synchronous mode.)

Synchronous technology is analogous in many ways to 2D sketching. If you were to make this 
same change in a 2D sketcher, the flat would be eliminated when the radius becomes half of the 
width, but again, you cannot go backwards through the process. In 2D, you cannot automatically 
recreate a flat by simply making the full radius smaller. It’s the same idea in 3D. Since we are 
already familiar with this problem and its workarounds in 2D sketching, dealing with it in 3D 
should not be a problem.

To get the flat on top back, you could: 

• Use Undo if still available
• Re-extrude the original rectangle 
• Cut off the round on the top and resize the block to full size
• Cut off a portion of the round leaving a flat face on top, and use Delete Face to remove the 

rest of the round
• The real solution to this issue in synchronous is to make the box in synchronous, but make the 

rounds in ordered. This way if the rounds consume a face, you can get the face back. Use the 
strength of synchronous when editing the box (synchronous strength) and use the concept of 
ordered features for the rounds (which play to ordered strengths).

Using the Steering Wheel
The Steering Wheel gets a lot of demo time, but you need to know that the 
Steering Wheel isn’t the primary tool for editing in synchronous technol-
ogy. In fact, for people just learning it, the Steering Wheel isn’t even the 
first option we like to turn to. 

The Steering Wheel is used for three things: 

1. Directional control – The Steering Wheel is easy for changes along or about the three main 
axes, but you can also use it to precisely angle faces, or move components in an assembly at 
an angle. Once you invoke the change by pulling the arrow or torus in a specific direction, a 
value field appears which you can use to make your motion very precise.

2. Differential control – Sometimes you only know that you want to move a face by a certain 
distance. The Steering Wheel is good for this kind of edit, because the value field that appears 
only represents the change in size, position or angle.

3. Approximate visual edits – This is the part that many people get hung up on. People tend to 
complain about synchronous technology not being good at “precision”. This perception 
seems to come when CAD users are getting their first look at the Steering Wheel, and only 
see the tug-and-pull operations changing parts. If tug-and-pull were the only way synchro-
nous made edits to parts, then I would agree – it would need more precision. But combined 
with the driving PMI and differential control operation, synchronous technology has as much 
precision dimensional control as any other CAD modeler.

The main message here is that the Steering Wheel is a visual interface device that is capable of 
precise dimensional control as well as approximate visual editing. 
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Tutorial: Imported air filter housing
Let’s consider this part, shown below. This is called “air filter.par”, and can be found in the mate-
rials for this chapter. It is an imported part, created in SolidWorks, brought to Solid Edge using 
the Migration Tools. It is what most history-based users would call a “dumb” part. The previous 
chapter dealt with imported parts specifically, but we will continue some of that work here 
because imported and native parts are not that different when it comes down to it. 

Apply dimensions
Let’s start with some dimensions. You’ll notice that all of the edges you would want to dimension 
have been removed by rounds. Most history-based CAD administrators who make best practice 
rules for their users will make a rule that says something like “don’t apply dimensions to edges 
created by fillets”. The reason for this rule is that dimensioning to an edge created by a fillet 
makes the fillet the driving feature, and we all know how often fillets just disappear. 

Note: Synchronous technology PMI dimensions drive faces even though you select 
edges to create them.

This rule is a good practice if you use software that can’t automatically compensate. Solid Edge, 
however, understands what you are looking for when you dimension to a round, and handles it 
correctly automatically. When you place the dimensions you’ll see it highlight missing edges or 
vertices. Plus, remember that although you select edges when placing dimensions, Solid Edge is 
really using the edges to identify faces, and is actually dimensioning faces.
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Changing units
This part has been imported to a template that uses inch units. If you prefer another unit system, 
it is best to change it before you start applying dimensions. To change to millimeter dimensions, 
go to the Application menu -> Solid Edge Options -> Units -> Unit System and select MMKS or 
your preferred unit system. 

This will set the units for any new dimensions that you place, 
but will not change any existing dimensions. To change exist-
ing dimensions, select the dimensions from the PathFinder PMI 
collector (via Ctrl- or Shift-select), right click on the selection 
and pick Properties from the RMB menu. Then select the units 
from the options for Linear and Angular dimensions. 

Note: The Units page of the Solid Edge Options controls the active dimension style, 
which can be set separately on the Dimension Style page of Solid Edge Options. 

Dimensions to rounded edges
1. Go to the Home tab, and select the Smart 

Dimension tool. Create the dimensions 
shown on this part. 

Note: If you are getting results from 
your dimensions that you don’t expect, 
try to spin the part to look orthogonal to 
the view in which you want the dimen-

sion to lie. You can 
use a 3D controller, 
your middle mouse 
button or the Quick 
View Cube in the 
lower right corner. 



Solid Edge with synchronous technology  |  Steering a new course in 3D design 

80 Chapter 7  |  Editing with synchronous technology

Change dimensions
2. Click on the value (number) of the 2.755 dimension. This brings up an editing box, and you 

can use your scroll wheel to change values or key in numbers. When you use the scroll wheel, 
the geometry updates automatically. When you key in numbers, you have to press TAB to get 
it to update while still keeping the value box open. If you press Enter, the part will update, 
and the box will close. Remember the trick with the TAB key, as this workflow will come in 
handy when testing various values.

 Notice that this dimension works for values 
between about 1” and 4.75”. Outside of that 
range, the dimension will fail due to the 
rounds colliding with one another. Notice 
what happens when the dimension fails.  
An orange dimension icon shows up in the 
graphics area, and other attaching dimension 
may turn a brown color, which means  
that the dimension has lost one or both  
references (this condition is called “dangling”). 

 You need to recognize and know how to react to failures in synchronous technology, just as 
in history-based software. In this case, you can press ESC to go back to the pre-edit value, key 
in another value or scroll until you hit a value that works.

Note: This is one of the places where you need to be careful. If you are changing 
dimensions, and a face in the model is consumed, and then you use Enter exit  
the Modify function, you will not be able to get that face back by changing  
dimensions. You will have to use Undo or one of the more advanced methods  
discussed later.

Change fillet radii
3. Click on some of the round 

faces on the model. Notice 
that for every fillet/round 
face you select, Solid Edge 
gives you a radius value. 
Notice also that in the 
PathFinder, the User-
Defined Sets contain four 
fillet features. If you click 
on one of those, the faces 
associated with that feature 
are highlighted. 

 Click on one of the light blue highlighted faces shown in the image above, and then click on 
the radius value that appears. 

 What’s happening here is that changing the radius for any of the 0.500” rounds will change 
the radius for all of the rounds with the same radius, not just the rounds created in the same 
feature. The icons to the right of the value in the modify box enable you to change just the 
selected radius, or all the faces with the same radius. Change the value up and down, and 
see what the limits are, and what it looks like when you push it to failure.

Consumed topology will return within an edit, 
but not after you have pressed Enter.



Solid Edge with synchronous technology  |  Steering a new course in 3D design 

81 Chapter 7  |  Editing with synchronous technology

Reattach dimensions
4. You might notice that the dimensions are connected to 

the main body of the filter, not the offset edge that goes 
around it. To reconnect the dimension, click on some part 
of the dimension other than the value (so, the dimension 
or witness lines), and notice that you get light blue and 
red handles. The light blue handle is to control the offset 
of the witness line from the part, and the red handle con-
trols the connection point. To reconnect the connection 
point, move the cursor over the red handle until it 
changes to a “+”, hold down the Alt key, and drag the 
handle to a new entity. 

 The dimension should increase by 0.050” when attached to the outer side of the lip. Since 
this needs to be done twice, it will increase to 4.100”.

Move origin to helpful location
5. You might notice that the origin is not 

in a helpful location. It should be 
located in one of the corners or maybe 
the center of the screw location. In his-
tory-based software, the sketches deter-
mine the location of the part, so if you 
wanted to move the entire part with 
respect to the origin, you would have to 
move several sketches. In 2D, you just 
move the drawing, view, sketch or 
whatever you are working on. Synchronous again in this situation works more like 2D than 
like history-based CAD. 

 To move the origin to a helpful location, we simply move the entire part. Here’s how to  
do this:

6. Make sure all tools are clear (you’re in select mode), and drag a selection window around  
the entire part. 

As a warning, it is important to keep the entire part active as the selection for  
this entire process. Extraneous clicks may clear the selection, and you will need to 
start again. 

7. All of the geometry should turn green, and the Steering Wheel 
appears. You will also get a little gray window called Design 
Intent. Since we aren’t changing the shape or size of the part, 
we can turn this off. So remove the check next to Design Intent. 
Using the Move Origin of the Steering Wheel (big blue dot), drag 
the Steering Wheel to the vertex shown. The view orientation is 
the same as the previous image, it is just zoomed in.

 Next, Shift-select the arrow parallel to the 4.000 dimension  
(X axis) and move it to the left, then key in .3, and press Enter. 
This moves the entire Steering Wheel to the combined distance 
of the radius and the lip, so it is at the furthest extent in the X 
direction of the model.

 Single click in white space to bring back the entire Steering Wheel. The selection will  
remain active.
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8. Now, Shift-select the arrow parallel to the 
2.755 dimension (Z direction), move the  
cursor away from the center of the model, 
key in .55, press Enter, and click in white 
space again, and you should have something 
that looks like the image to the right. The 
Steering Wheel is now positioned where you 
want the part origin to be.

 To move the part such that the part origin is 
in that location, we can do it in two steps. 
 

9. First, click on the tool plane 
of the Steering Wheel. This 
moves the part in plane, 
even if you select some-
thing out of plane. So your 
second click should be on 
the part origin, which is 
ghosted but still visible 
against the part. When you 
start the move, the part 
origin will be colored nor-
mally again, and be easier 
to see.

10. Finally, click the arrow parallel to the Z axis, 
and then click on the part origin again. This 
should put the part origin at the corner of the 
virtual bounding box of the part. You can now 
press ESC to clear the selection. 

Remove radii
By now, you have read several times in this book 
that fillets and rounds should be treated differently 
while modeling using synchronous technology 
because they can consume faces, and cause errors.

In most cases, you will be creating your own rounds, so you can create them in ordered mode, to 
follow best practice, and get the most editable models possible.

But in the current situation, we have an imported part, and we didn’t have a choice about the 
rounds. Still, this situation can be handled by the tools in synchronous technology. We just need 
to first remove, and then reapply the rounds. 

Note: You don’t have to work this way with all imported models. You can leave 
imported rounds on the part and continue to work that way. Sometimes, however, 
you may want to have more control over the round features, and this part of the 
demonstration shows that even though this is an imported part, you still have 
complete control.

Some rounds are easy to remove, and others will require more effort. Let’s start with the .25 R 
rounds on the top and the bottom. These are very easy. 
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1. Just click on the 
Fillet3 feature in the 
Pathfinder, and 
press Delete on the 
keyboard.   
 
 
 
 
 
 
 
 

2. Now select Fillet4 and press Delete. Notice first 
that Fillet4 was not a complete round, and that 
there are no faces to extend to take its place. This 
is part of the “consumed topology” problem. 
Deleting the feature has done something that was 
unexpected: it cut the model in half. 

There are two ways to deal with this:

3. First, we could simply extend the cut face of the 
lower half of the model up to the upper half. To do 
this, select the cut face, click the arrow in the direc-
tion you want to move the face, and then click an 
endpoint on the upper half of the part. That’s easy.

4. The second method is less easy, but because we 
didn’t expect this to happen in the first place, it is the 
method you should learn, because there won’t always 
be an easy way out of an unexpected situation.

5. Press Ctrl-Z (undo) until you get the Fillet4 feature back.

6. Now rotate the model so you can see the flat 
underside of the lip around the midsection of the 
part, and select that flat face. 

7. This shows the simple Steering Wheel. Hold down 
the Ctrl key, and click on the arrow, and then move 
the cursor to the top edge of the Fillet4 feature 
that we want to remove, and click a Keypoint, as 
shown in the image.

8. This has essentially copied the flat face (as a sur-
face body) to the location where we want to recre-
ate a flat face that was there before the partial 
round Fillet4 consumed it.

9. Next, click in white space to clear the selection. 

10. To incorporate the flat surface in the solid 
model and remove the round faces, we 
are going to use the Replace Face func-
tion. Find Replace Face on the Surfacing 
tab, Modify Surfaces group.
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11. The Replace Face workflow goes like this. Invoke the command, 
select faces that you want to get rid of. Then select the face that 
you want to use instead. The CommandBar helps you step 
through the workflow. Remember that the screenshots in the 
book are taken using the Most Assistance theme, which makes 
the CommandBar look different (more words). 

12. So select all the faces of the partial round. You can press Ctrl for 
the second face, but you’ll see a special cursor, and don’t need to 
hold down Ctrl for the third or subsequent face selections.

13. When all the faces of the round are selected, click on the Accept button in the CommandBar.

14. Next you will need to zoom in to select the offset surface we copied.

15. The result is a lip that goes around the part with flat faces on top and bottom. Press ESC to 
finish the command.

16. The remaining fillets could be deleted by just selecting the Fillet1 and Fillet2 features in the 
Pathfinder, but in the line of demonstrating techniques, select the 5 round faces with the  
.55 radius around the lip, and press Delete on the keyboard.

17. Notice that when you delete all 5 faces together, the Fillet2 feature in the Pathfinder is  
also removed.

18. Now click and delete Fillet1 in the Pathfinder.

19. Next, delete the green face from the screw hole, and 
finally, the yellow face from the screw hole.

Note: The result of leaving a chamfered face  
around the hole is somewhat unexpected, since  
all the faces that could be extended to patch  
the deleted faces have been consumed by the  
rounds. This function should have failed, but  
obviously Solid Edge has added some magic  
behind the scenes.

20. The result is a conical face. When you click on a synchro-
nous conical face, an angle dimension is displayed, but you 
can’t use the angle to make either 0 or 90 degrees, it has to 
be something in between. This is because the surface 
would change type from a cone to either a cylinder or a 
planar surface.
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21. If the goal is to make this a counterbored type 
hole, the way to handle it is with a Draft fea-
ture, applying a draft of 0 degrees. 

 The Draft tool is found on the Home 
tab, Solids group. The first face (Draft 
Plane) to select is the main planar face 
of the part. The “Draft Faces” in this 

case is just the conical face created by deleting 
the rounds. Enter 0 to the value box. 

22. The rest of the rounds can be removed by selecting the features in the PathFinder,  
and deleting them.

Note: It would have been much easier to move the origin after the rounds had 
been removed, but the difficult method was demonstrated to make sure your skill 
set was more complete. Also, you could have placed a reference coordinate sys-
tem, and used the Steering Wheel to locate it.

Remove screw head
1. There are several ways to remove the screw head. You could fence select all the faces on the 

screw head and press Delete on the keyboard. Or, you could use the Detach command, which 
will enable you to reattach it later on, if you want to. You could also cut away the screw head 
at the same time you cut a hole for the screw to go into. Since we also need a screw hole, 
let’s use this last technique. 

2. On the Home tab, in the Draw group, click on Project to Sketch. Then bring 
your cursor over the big flat face opposite the screw head, and press F3 on the 
keyboard. Finally, click on the outer edge of the screw head, and Solid Edge 
will place a sketch circle on that sketch plane. 

 Press ESC to cancel the Project to Sketch command, 
and click inside the projected circle, which will give you 
a green highlighted region. 

3. The goal here is to create a hole that is offset from the 
bottom (where the projected circle is) and go through 
the top (where the screw head is), and remove the 
screw head in the process. We will then make the hole 
smaller so the screw head doesn’t go down inside the 
hole. 

4. The process that we will go through could be done 
more simply, but these are techniques you should know  
how to use, so they will be demonstrated here.

5. To start cutting from an 
offset of the projected 
circle, we have to move 
the projected circle. In 
the PathFinder, expand 
the Sketches collector, 
and select the sketch with 
the circle in it. When you 
do this, the circle high-
lights, and the Steering 
Wheel appears. This 
enables you to move the 
sketch with the Steering Wheel. 
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Note: You could also select the sketch by using  
the RMB QuickPick method, which has not been 
covered to this point. QuickPick appears as a 
mouse icon after you hover over an entity for a second or  
more. When you click the right mouse button with the 
QuickPick icon showing, it activates a small list of items  
that are under the cursor in its current position. 

6. Click the arrow pointing vertically in the image above, and drag it 
down into the part. Key in .375.

7. Notice that this moves the sketch without moving any faces or 
planes. If there were other sketch items on that plane, they would also move.

8. From here, the sketch is buried in the block, so you can’t just select the region inside the  
circle as easily as you could when the sketch was on the flat face. So we have to use 
QuickPick again to select the region.

9. Hover the cursor over the interior of the circle until you get the QuickPick icon, then click the 
right mouse button. Bring the cursor down the QuickPick list until it highlights the correct 
region inside the circle, and select that item. The Steering Wheel appears.

10. Now drag the Steering Wheel arrow through the rest of 
the part until it comes out the other side. 

11. When you flip it over to look at it, the hole should have 
removed the screw head, but you will also see that the 
hole does not go all the way through the part. 

12. Next we need to make the hole smaller. The radius of 
cylindrical faces of all types are only controlled by 
dimensions. There is no visual dragging like you find for 
flat faces. So when you click on the cylindrical face of 
the hole, a diameter value appears, in addition to the 
depth dimension which is already there.

13. Click on the dimension, and change the value to .375. 

Shifting into ordered mode
1. Now we need to put the rounds back on the model,  

but these rounds need to be applied as ordered  
features, so let’s shift into ordered mode.

2. Right click on the synchronous header in the 
Pathfinder, and select Transition to Ordered.

Note: When you combine synchronous and 
ordered modes in the same part, the synchro-
nous body always comes first, and then the 
ordered features are applied on top of that. 
You can make synchronous edits to the syn-
chronous body while in ordered mode. To add 
more synchronous features, you have to go 
back to synchronous mode. You can also push 
ordered features to synchronous, but this is a 
one way trip. Synchronous features cannot be 
promoted to ordered features.
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3. The ordered features will show up under the ordered header after all the synchronous items. 
New features will be listed in the ordered area. 

Replacing the rounds
1. Usually, the recommendation would be 

to apply the rounds in order from biggest 
to smallest. In reality, it’s more difficult 
than that to write best practice type rules 
that work 100% of the time. Best practice must always 
be accompanied by common sense. In this case, we 
need to deviate from the best practice order slightly. 

2. Create a Round feature using a radius of 0.500” for the 
edges shown to the right in orange. 

3. Create a second Round feature using radius of 0.550” 
on the edges shown to the right in blue. 

4. Create a third Round feature using radius of 0.250” on 
the edges shown below in green. 
 
 
 
 
 
 

 
 
 
 
 
 

Making synchronous changes in ordered mode
The Solid Edge PathFinder helps you keep your model information 
accessible and organized. One of the items you can find quickly is 
the PMI collector. You can turn all or some of the dimensions on or 
off at will. You can group dimensions together so they can be tog-
gled always at the same time. You can even select, delete, control 
properties, and do many other things to your PMI dimensions from 
the PathFinder.

The dimensions Linear 5-9 are locked dimensions that maintain the 
width of the lip around the part. The 4.100 dimension drives the 
outside of the lip while the 2.755 dimension drives the inside. This 
is not necessarily the way you should do it, but it demonstrates 
that you can drive either side, and there is no such limitation as 
the “parent/child” difficulties you run into when figuring out how 
to drive a history-based model. (The model has been saved at this 
point for your convenience with the name Air Filter Intermediate 
4.par in the data for this chapter.)
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5. Turn on/off dimensions until you just have 
these three dimensions showing on the 
screen, for the overall part dimensions. 

6. In previous instructions, you learned how 
to reattach dimensions to new geometry 
(by selecting the dimension first, then 
Alt-dragging the red handles). This time 
we just want to change values. 

7. Click on the 2.755 value, and the modify 
dialog appears. Use the scroll wheel on 
your mouse to change the value, or key in 
a new value. 

8. Since these dimensions are blue, it means that  
you can change them via the modify box or by using  
the Steering Wheel. So click on a flat face, 
and give it a tug. 

9. Notice that if you click on a face belonging 
to a round feature, the toolbar for making 
changes to ordered features appears.
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Summary
The main idea that you need to take from this chapter is that although the methods may also be 
used independently, synchronous and ordered methods work together very well. The synchro-
nous method relieves you from the pain of parent/child history-based entanglements. The 
ordered method is used primarily where there may be danger of features consuming faces which 
might need to be replaced later on such as rounds, or detail features that require sketch editing 
such as extruded text.

You will find that there is very often more than one way to do things, and you always need to be 
familiar with multiple methods, because one method is not going to work for everything. 

Practicing using the Steering Wheel can be important for being able to make different kinds of 
edits. Also, multiple methods for selections, whether from the PathFinder features, fence select, 
Ctrl-select or QuickPick, you will need each of these in various situations as you continue to learn 
and use Solid Edge.

Making yourself familiar with the idea of driving the 3D model directly using locked and 
unlocked PMI dimensions opens an entirely new world for CAD users ingrained with the history- 
based mindset. Making the conceptual leap to synchronous technology enables you to regain 
control over your design intent.

There is much more to synchronous technology, but the simple concepts demonstrated in this 
chapter paint a picture of compelling functionality to add to your current toolbox. The beautiful 
thing here is that synchronous technology does not require you to give up your current expertise 
in history-based modeling, synchronous will rather enhance that, building on the areas where 
history-based modeling is weakest, to give you a broad, full-function set of tools for every 
situation.
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Sheet metal parts in Solid Edge are a different file type than general Solid Edge parts. Sheet 
metal parts have the extension *.PSM.  This chapter assumes that you are familiar with the sheet 
metal manufacturing process and you have some previous experience with designing sheet 
metal in CAD.

Note: A brief video goes along with the content of this chapter. 

Solid Edge, like most 3D sheet metal modelers, expects you to build sheet metal parts flange by 
flange and add features as you go. An alternative workflow is also available where you start with 
a flat sheet and add bends. The design process for sheet metal does not resemble the manufac-
turing process – that is, you do not start from a sheet, make cuts to it, and then add bends. 
Instead, you create the final shape, and then from the finished shape the software calculates the 
flat pattern and bend lines.

You will be more successful and happier with the software if what you expect it to do is in line 
with what the software actually does. In general, Solid Edge sheet metal is intended for straight 
brake press type operations, but can also perform some stamping, lancing, and basic forming. 
The material will remain a constant thickness with constant radius bends, and all sheared faces 
are perpendicular to the face of the sheet material. Solid Edge can provide a flat pattern for sheet 
metal parts and can calculate bend allowances accurately using multiple methods.

Some situations in real-world sheet metal work are not allowed for in CAD sheet metal, such as 
corners where bends overlap, or overlapping flat patterns. Deep draw, progressive die opera-
tions, and heavy forming can be modeled geometrically, but Solid Edge is designed to deal with 
the special considerations required by these processes.

Solid Edge sheet metal and templates
Solid Edge sheet metal templates are usually created from a dedicated sheet metal part, saved 
with the same extension. Solid Edge sheet metal parts can in turn be created from templates 
saved in either synchronous or ordered mode. General Solid Edge parts and imported parts can 
also be converted to sheet metal under some conditions which we will explore later in the 
chapter. 

All of the sheet metal parts I have made in this chapter were created from synchronous sheet 
metal ANSI inch template. You should have sheet metal templates in all of the drafting standards 
you will use, as well as in synchronous and ordered. 

Synchronous sheet metal can be created from closed-loop sketches (Tab) or open sketches 
(Contour Flange). As with parts in the rest of synchronous, the initial sketches are used only to 
create the first feature, and are not linked to the solid geometry after that.

Chapter 8

Synchronous sheet metal

http://media.plm.automation.siemens.com/solidedge/solid-edge-st-ebook-ch8-tutorial.mp4
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Base features in sheet metal
The Tab is most commonly used as the first, or base feature. With this method, you have to draw 
the profile of a panel and extrude it to the thickness of the sheet metal part. The Tab tool is on 
the Home tab, Sheet Metal group. You can enter the material thickness when extruding the fea-
ture, or later, in the Material Table. 

Solid Edge Material Table
You can use the Material Table command to assign the 
material, thickness, default bend radius, method for calcu-
lating bends (gage table, neutral factor (K value), or a  
custom formula. This is the same Material Table command 
that you use to assign materials in non-sheet metal parts 
also. The Material Table is available from the sheet metal 
CommandBar and from the Application Menu -> 
Properties -> Material Table.

Solid Edge installs several materials. If your installation doesn’t include materials, in the panel  
on the left of the table, right-click the top-level materials, and then select Import. Solid Edge 
searches for a *.mtl file or an Excel worksheet. In the folder with material for this chapter, there 
is a sample Excel worksheet, called Material.xlsx, that shows how Solid Edge expects the material 
information to be formatted.

To start with a Tab, sketch the outline of one of the 
panels. Solid Edge automatically extrudes it to the 
material thickness set in the Material Table.

The Solid Edge Material  
Table can be saved out and 
imported as an Excel file 
format. This contains all the 
properties for materials from 
sheet metal to simulation.

The Solid Edge Material Table can be saved out and imported as an Excel file format.  
This contains all the properties for materials from sheet metal to simulation.
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Getting started with a contour flange
The second method of creating the initial feature in a synchronous Sheet Metal part is the 
Contour Flange, using an open sketch, highlighted in orange in the image.

Adding flanges
To add a flange onto an existing panel or flange, simply 
select the thickness face and pull the short arrow of the 
Steering Wheel. There is no toolbar button for a simple 
flange.

You don’t have to initiate a 
command or press a tool-
bar button to get this to 
happen, just click on the 
face, and pull the arrow. 
The result, and the accom-
panying Command Bar are 
shown below.

Setting the length of the 
flange can be done in one 
of three ways:

1. Position the cursor on one side of the original edge 
so the new flange is displayed on the side you want 
it on, and then click (visual placement).

2. Instead of clicking in the previous step, key in a 
number for the length and press Enter to accept it.

3. Instead of clicking in empty white space in the first 
step, click on a keypoint, such as the end or mid-
point of an existing flange.

To place the flange at some angle other than the 
default 90 degrees, press the Tab key, which will high-
light the box that displays the angle measurement 
(90.00). With your cursor on the correct side to denote 
direction, enter the correct value and press the Tab key again to keep the value, and go back to 
editing the length of the flange. 

You can select multiple edges to create multiple flanges in a single operation. 

To start with a Contour Flange, you need an open sketch 
profile. Leave the bend corners sharp in your sketch because 
the software will add the bends for you based on the 
Material Table properties for your selected material.

The Contour Flange Command Bar.

The Flange Command Bar.
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Contour Flange
A contour flange is a flange that can be sketched to include multiple flanges with bends and can 
also go around multiple thickness faces of another flange. To start a contour flange, you must 
have a sketch with some geometry in it. If you don’t 
have any sketches available, the Contour Flange 
command will be grayed out. To activate the button, 
the sketch doesn’t need to be appropriate for the 
contour flange, it must simply exist and not be 
empty.

For example, the sketch on the right could be used 
to start a contour flange, and the resulting flange 
might look as shown next. 

To create a contour flange:

1. Create the sketch on a plane perpen-
dicular to the thickness face you 
want the contour flange to run 
along. Make sure the sketch is con-
nected to either the top or bottom 
edge, as shown in the previous 
example. 

2. Click the Contour Flange command. 
(Follow the Prompt Bar prompts).

3. Select your sketch as a chain of 
sketch entities.

4. Pull the Steering Wheel 
arrow in the direction 
along the face where 
you want to place the 
contour flange.

5. Select additional adja-
cent thickness faces to 
run the contour flange 
around corners. Solid 
Edge will automatically 
miter corners and add 
bends according to your 
sheet metal defaults for 
this part.

The Contour Flange command automatically makes a set of regular flange features to match 
your sketch and selected thickness faces. Editing must be done through the normal flange  
editing process, with the steering wheel and PMI. 

For example, the contour flange created above turns into Flanges 30-38 in the section of the 
PathFinder shown to the left. For complex edits to complex contour flanges, we recommend that 
you simply delete the existing flanges and create a new feature.
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Hem
A hem feature folds the sheet metal part back on 
itself according to the selected settings. 

The hem type can be changed from the Hem 
Options, on the command bar. Hems can be taken 
around adjacent edges and mitered, if necessary.

To edit a hem, select the hem from the PathFinder, or select 
a face of the feature in the graphics window, then click on 
the hem’s name displayed as an annotation. This makes the 
command bar available.

To delete a hem feature, you can follow the same procedure: 
select the hem in the PathFinder or the graphics window and 
press the Delete key.

Note: You can use regular flanges to go around the 
three outer sides of a U shape with a flat bottom, but 
to get those three flanges around the inside, the 
flanges must automatically miter the corners to pre-
vent overlapping. As a workaround, you can use the 
contour flange with a single line drawn to the inside, 
and this will create three flanges to the inside, and 
automatically miter them correctly. This example is 
saved in the folder of materials for Chapter 8, called 
CH8 3 mitered flanges.psm.

Closed Hem.

S Bend.

Curled Hem.
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Bend
A bend feature can be 
added to a Solid Edge 
sheet metal part simply 
by drawing a line across 
a flat face. The line must be 
drawn before you can activate 
the feature.

You would use a bend, rather 
than a flange, if you wanted to 
make use of existing material 
rather than creating more com-
plexity for the flat pattern. 

 
 
 

Bends are not listed in the PathFinder, but the flanges created by bend are listed. All bends are 
edited using the same techniques, not just sketched bends created with the Bend command. To 
edit a bend, select one of the cylindrical faces of the bend, and the software will display the 
annotation, Bend Radius = X. You can click on this annotation to edit the bend radius. To edit the 
bend angle, click on the flange affected by the bend, and move the Steering Wheel to the axis of 
the bend. This enables you to use the torus to change the bend angle (angle the flange).
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Jog
A jog is a series of two bends in 
opposite directions that create a 
step in the sheet metal part. You 
could create a jog by simply making two 
simple flanges that bend in opposite direc-
tions, and in fact, that is the end result. 
When you look at the PathFinder, you will 
not see a jog feature, but rather two  
new flanges. 

The Jog feature works much like the bend, 
requiring a line in a sketch. In fact, the 
Bend Options available from the Jog  
command bar are the same as the Bend 
Options available on the Bend command 
bar (shown above). 

To create a jog:

1. Draw a line where you want the jog to start. The Material Side setting on the command bar 
lets you control the relationship of your sketch line to the bend. 

2. A simplified Steering Wheel displays on the drawn line. The side of the arrow you click on will 
move up or down.

3. Specify the height of the jog step.

This operation adds material to the flat pattern. If you wanted to create a jog from the existing 
material of this flange without lengthening it at all, you would have to create two bend features.
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Bend reliefs and corner reliefs
A bend relief is necessary when a bend ends in the  
middle of a flange. For example, the orange faces in  
the image to the right are bend relief faces. 

The default values for all the reliefs in a part are found 
in the Material Table, on the Gage Properties page 
(Application Menu -> Properties -> Material Table).

You can also access settings for individual bends by clicking the bend 
 in the graphics window, then clicking on the bend radius, and the  
Bend Options, shown next, available on the command bar.

Solid Edge cannot accept a relief 
width of 0, but you can enter 
very small numbers, such as 
0.0001”. CAD programs that 
allow a relief type of tear are 
simply doing this behind the 
scenes with a very small non-
zero number. Solid Edge actually 
does this with the Corner Relief 
command, but not with the 
Bend Relief command. This is 
one of those situations where it 
is possible in real-life manufac-
turing, but CAD cannot work with  
zero-thickness situations.

Corner relief
A corner relief comes into play when you have two or more bends 
that intersect at a corner. The effect becomes exaggerated with 
thicker material. Again, real-life manufacturing can have a section 
of two bends that overlap, and it naturally makes a rather complex 
area that cannot be easily accomplished in CAD. 

A typical corner where two bends come together looks as shown to 
the right. This corner has no bend relief or corner relief. Sometimes 
your design calls for a tighter corner than this. The intent of this 
book is not to tell you how to design sheet metal parts – just how to 
use the available tools. 

One way to tighten up this corner is to use the 2-Bend 
Corner command. This enables you to bring the inside 
edge of the two flanges together until they almost touch. 

The drop-down list at the bottom of the command bar is 
the Corner Treatment setting. This controls how the small area 
where the two bends would overlap is shown. Again, this may look 
different in a real-world bend, and may not match the flat pattern, 
but it is shown simplified in 3D just because it would be more com-
plex to show what actually happens when the bends collide.



Solid Edge with synchronous technology  |  Steering a new course in 3D design 

98 Chapter 8  |  Synchronous sheet metal

The Closed Corner option looks like this:

The Gap value shown is 0.000”, but the gap, as mentioned earlier, cannot be a true zero gap 
between the two edges. The value shown is only three places of the actual value, which is 
0.00011”. If you zoom in very close, you can measure the gap to verify this. This is a little  
workaround that makes it work for CAD and also makes it work for your drawing dimensions  
and tolerances. 

The Overlapping Corner option makes one 
flange overlap the other. The treatment condi-
tions are all for the bend corner area, and are 
the same between the Closed and Overlapping 
flanges. The Overlap ratio can vary from 0 to 1, 
where 0 is like the Closed Corner option, and  
1 is complete overlap, shown on the right. 

The part used to create these screen captures  
is available in the folder of materials for this 
chapter.

Closed Corner with Open treatment.

Closed Corner with Circular Cutout treatment.

Closed Corner with Closed treatment.

Closed Corner with Miter treatment.

Overlapping Corner with Closed treatment.
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Creating a cut feature
You would expect a cut feature to work largely the same in 
sheet metal as in normal modeling. And it does. With two 
exceptions: 

• The cut does not create a feature in the PathFinder. It is just 
geometry, with no special properties after it is created, so it can 
be edited synchronously. The only thing you need to do with this 
information is to be aware of it so that when you create a cut 
feature, and it doesn’t show up in the tree, you’ll know that it’s 
not a mistake.

• The shear is always perpendicular to the sheet face, even when 
the cut feature hits the face at an angle. In the following image,  
notice that the cut faces on 
the angled face on the left 
are cut through normal to 
the sheet face, rather than 
cut at an angle.

This behavior is controlled by 
the first option in the com-
mand bar, Face Normal Cut 
Types. 

Wrapped Cut
Another cut type worth noting on the Cut command bar is the  
Wrapped Cut. You can use this command to make a cut that goes  
across bend lines. 

To make a wrapped cut:

1. Start with a sketch on your 3D part that represents where 
you want the cut made. 

2. Select one face as the sketch plane.

3. Sketch as if you are sketching on the flat pattern, even 
though you’re sketching on the 3D part.

4. Click the Wrapped Cut button on the Cut command bar, 
and Solid Edge automatically recognizes that the cut goes 
across the bend, and flattens the bend temporarily to com-
plete the rest of the cut.

5. When you right-click again to accept, the temporarily flat-
tened bend re-forms, and your cut is complete. 

This is one of the situations in which designing sheet metal in 
3D becomes a little confusing. The hole is punched in the flat, 
and then bent. Solid Edge makes dealing with the situation 
automatic and easy as long as you know what to expect. 

The part file used to make this example is saved in the folder for 
the Chapter 8 materials with the name CH8 wrapped cut, 
angled cut, psm.

Note: Other features can take advantage of this type of technique of going across 
bends, but require the Unfold feature to do it. Unfold, as of this writing, is only 
available in ordered mode.
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Holes, slots and library features
To place a hole on a sheet metal part:

1. Click the Hole button on the Sheet 
Metal group. 

2. Place the hole to accept the 
default hole type, or:

a. Using the drop-down list next to the 
Hole Options button on the command 
bar, select a saved hole.

b. Using the Hole Options button on the 
command bar, specify a new type of 
hole and optionally save it for quick 
access from the drop-down later.

If you place multiple holes in a single com-
mand, those holes will be listed together in the 
PathFinder.  If you make the same hole later 
during a different session of the Hole com-
mand, it will be put into a separate Hole collec-
tor folder. This enables you to edit all the holes 
created together at the same time, for example to change diameter. In the 
image on the right, notice that for Hole 1, there is a collector, and then 
indented is the feature. Note that the collectors and the features can have 
the same names.

If you want to separate one instance of a hole from a group of holes, just 
right-click that instance in the PathFinder or graphics window and select 
Separate. Solid Edge will move the instance to its own new Hole collector 
folder. After you separate a hole from a group of holes, you cannot reconnect 
it. Likewise, if a hole has all of the same properties as other holes, but is in a 
different collector, it cannot be grouped with the other similar holes. This is 
motivation to get holes grouped correctly from the beginning. 

Note: If you are having trouble placing a hole, press F3 to unlock a previously 
locked plane. This is a common source of error that more experienced users deal 
with instinctively.

The slot feature requires an associa-
tive centerline sketch chain with 
tangency. 

To create a slot:

1. Create an open sketch with no sharp cor-
ners. This sketch represents the centerline 
of the slot.

2. Click the Slot button in the Sheet Metal 
group, under the Hole drop-down list.

3. Select any element of the centerline sketch, 
understanding that the entire tangent 
chain will be selected.
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4. Make sure that the Steering Wheel arrow is pointing in the direction of material removal.

Note: The Counterbore settings are not accessible for sheet metal parts, only for 
general parts. To sketch a line, then tangent arc, you can use the A key to switch to 
tangent arc. Be sure to look for the IntelliSketch icon for the location where the 
second line is tangent to the arc. This will be a big help in sketching open loop 
tangent chains.

The Feature Library in Solid Edge can contain ordered and 
synchronous, but each individual folder can only contain 
one type of features. 

The library, as installed with the default Solid Edge instal-
lation defaults, is probably not the configuration you will want to work with in your production 
environment.

To start a new area as a library, use the New 
button to create a new folder where you want 
to put the new library, and start by copying and 
pasting features directly into the Feature 
Library panel. 

You can also just start using an existing folder 
as a library just by using the Library Feature 
tools to browse to it. To get some practice with 
this, follow this workflow:

1. In Windows Explorer, copy the Feature 
Library folder out of the material for this 
chapter, and paste it in an easily accessible 
area on your computer.

2. Show the Feature Library in the Solid Edge 
interface:

 On the View tab -> Show group -> Panes 
drop-down list, click the Feature Library 
button. 

3. Use the tools on the Feature Library to browse to 
the folder you just copied to your computer.

4. Make sure you have a synchronous sheet metal 
part open, and double-click the synchronous 
Features folder in the copied Feature Library.

Note: You can use the folder drop-down  
list to assist in browsing.

5. Right-click in the white space in the synchronous 
Features folder, and select Preview. This displays a 
small window at the bottom of the pane that 
shows a small preview of the selected feature.

6. Click on the Louver1.psm feature, and drag it into 
the graphics window. Make sure to release the mouse button inside the graphics window.

a. When you release the mouse button from the drag, the feature will be attached to  
your cursor. 
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b. Place the cursor over a flat face of the sheet metal model, and press the F3 key. Move the 
cursor to another flat face, and press the F3 key again. When you have a place where you 
want to put the Louver feature, click the left mouse button.

c. Press the Esc key to exit the function.

Notice that the Louver 
feature is pasted to the 
model as a different 
color. This is actually a 
surface model copy of 
the library feature. It is 
not a solid yet. 

d. Right-click the Louver feature either in the graphics window or the PathFinder, and select 
Attach. This will permanently attach the surface model onto your solid model, and the 
faces of the louver will 
turn the same color as 
the rest of your solid 
model. When the faces 
of the feature are 
merged (attached) into 
the solid, there will no 
longer be a checkmark in front of the Louver1 entry in the PathFinder. The checkmark 
gives you the ability to hide the Louver when it is still just an unattached body.

Note: This is the same technique that you use when you copy and paste features 
within a model. You can think of the Feature Library like an extended clipboard. 
You use copy and paste to get items into the library, and the drag-and-drop opera-
tion is essentially another paste operation. The Attach function merges a set of 
copied faces into the rest of your solid model.

Deformation features
Some features in Solid Edge sheet metal are not just straight brake press 
operations. These are generally any of the features under the Dimple  
drop-down list in the Sheet Metal group (Home tab in the Sheet Metal 
environment). 

Further, all of these deformation features (except for Louver, Gusset, and 
Emboss) are different from other Synchronous features in another way –  
they are all driven by associative sketches. We have spent a lot of effort in 
this book trying to get history-based users to forget about associative 
sketches, so we have saved this topic for near the end of the book when 
you probably are comfortable with the idea of leaving sketches behind, to reintroduce the  
concept for these few specialty sheet metal features. 

Deformation features do not handle the stretching or thinning of material due to deformation. 
The volume of the CAD part will be greater after the deformation operation than before. In the 
real world, the material thins slightly, and the volume remains the same.

Before attaching the Louver.

After attaching the Louver.
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Creating a dimple
In Solid Edge sheet metal, a 
dimple is simply a sketched 
shape that is stamped into the 
part a certain distance, leaving 
the back side of the part with material 
removed. For example, this barbell 
shape with two connected circles was 
sketched onto the part, and raised a 
certain distance from the surface, with 
the material remaining constant thick-
ness on the other side. 

Editing a dimple
To change the shape of the feature, 
you can edit the underlying sketch, or 
sketch it again. Let’s walk through edit-
ing the dimple feature. At the end of 
the process we will alter the sketch to 
change the shape.

Selecting the dimple either from the 
PathFinder or the graphics window 
highlights all the faces of the feature, 
and displays the Steering Wheel. You 
can use the Steering Wheel to move or 
rotate the entire feature on the face. Remember that the arrows move in one direction only, but 
the disk (tool plane) allows planar motion.

Selecting the Dimple feature and then clicking on the Dimple 1 annotation that appears allows 
you access to the Edit Profile link and the modify box for the depth of the dimple feature.

Creating a bead
A sheet metal bead feature is similar to the 
dimple. You start with a sketch. The bead 
sketch is required to have all tangent entities 
(no sharp corners).

To create a bead:

1. Create a sketch on a sheet metal part with no 
sharp corners. It can be an open or closed loop.

2. Click the Bead command.

3. Select the sketch elements, loop or chain.

4. Use the Steering Wheel to determine the side of the part to which the bead will add material. 

Select the feature and use the Steering Wheel to move it  
within the face.

The bead feature requires that you start 
with an open or closed loop with no sharp 
corners.
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5. Use the Bead Options from the  
command bar to specify the 
cross-sectional shape and the end 
shape of the bead.

6. Right-click to accept result. 

Editing the bead is the same as editing 
the other deformation features. Select 
the feature, click Bead name, click Edit 
Profile, make changes to profile sketch, 
and then use the Exit Sketch button  
and right mouse button click to accept 
changes. To edit the Bead Options, 
select the feature and click the Bead 
name, then use the command bar to 
access Bead Options.

Creating a drawn cutout
A regular cutout feature just 
cuts through the part, but a 
drawn cutout pushes some 
material through with the cut. 
This feature does not regulate how 
much material you add as part of the 
draw part of the operation, and like the 
other deformation features, it does not 
thin any deformed material. For these 
reasons, it is entirely possible for this cut 
feature to actually add mass to your  
part – which is to say that it may make 
geometry that is entirely impossible to 
manufacture without welding on extra 
material. 

Editing the drawn cutout is the same as 
editing the other deformation features. 
 

Creating a gusset
To create a gusset feature, you 
must first have a sheet metal 
model with at least one bend 
in it. 

To create a gusset:

1. Click the Gusset button on the  
Sheet Metal group.

2. Click the Gusset Options  
button on the command bar.

The Drawn Cutout 
command bar is 
mislabeled as Dimple.

The sketch can represent 
the die (female) or the 

punch (male).
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3. Set the options for your gusset, and save the settings or recall the settings from the drop-
down list if this will be a set of gusset settings you use frequently.

4. Use the Patterning drop-down list to select whether you want a Single gusset, or to pattern 
with Fit, Fill or Fixed method.

5. Click on a location for the gusset along the inside of a bend.

6. Use the dimension that appears, to locate the gusset along the bend, or the box that accepts 
the number of gusset instances.

Editing a gusset is similar to editing other deformation features:

1. Select the feature from the graphics window or PathFinder.

2. Click the name of the Gusset feature that appears in the  
graphics window.

3. Change the pattern number, dimension or the Gusset Options in the command bar.

Creating an etch feature
Etch enables you to show an etched shape or text on  
the surface of the sheet metal part. This does not violate 
the constant thickness requirement for sheet metal. You 
can use standard sketched shapes or insert a text profile. 
The Text Profile command is on the Sketching tab,  
Insert group. 

Most of the functions in this tool are self-explanatory, 
except how to rotate the Text Profile. To rotate text:

1. If the Etch feature has already been created:

a. Select the Etch feature in the PathFinder.

b. Use the Steering Wheel torus to rotate the feature.

2. If the Text Profile has been created, but the Etch has not:

a. Click on the name of the Etch feature that appears as an 
annotation in the graphics area.

b. Select the text profile in the graphics window. Solid Edge 
displays the Edit Definition command bar.

c. Click the arrow to the left of the word Modify, and select 
Move. Solid Edge displays the Steering Wheel in the middle 
of the Text Profile.

d. Shift+click on the tool plane of the Steering Wheel until 
the torus is on the same plane as the Text Profile (you may 
have to Shift+click on the tool plane twice). 

e. Use the torus to rotate. 
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Creating a louver feature
The louver feature can be 
placed freely on a flat face of 
a sheet metal part without a 
sketch. You may need to set the Louver 
Options first to make the louver fit on 
the piece with which you are working. 

As with other deformation features, you 
can use the Steering Wheel to reposition 
or rotate the feature. You can dimen-
sion, copy and pattern it as you do  
other features. 

Working with Flatten  
and Flat Pattern 
The Flatten mode is on the Tools tab, in the 
Model group. This is used to generate a flat 
pattern for the model. This is useful when 
working on a sheet metal part to check and 
make sure your flat pattern does not have any 
undesirable traits, such as overlapping areas in 
the flat. It is also how you generate flattened 
geometry for use in drawings and computer 
controlled sheet metal manufacturing methods.

To avoid confusion, it should be mentioned that 
the Flatten tool creates the Flat Pattern collec-
tor in the PathFinder, and the Flat Pattern but-
ton creates the Flatten entry.

The work flow for creating a Flatten entry for a 
sheet metal part that has no Flat Pattern collec-
tor is as follows:

1. Create a sheet metal part in either synchronous or ordered with at least one bend.

2. Click on Flatten in the Tools -> Model group (this creates the Flat Pattern collector). 

3. Use the Flat Pattern CommandBar to control the following:

a. The Flat Pattern Treatment is the settings used for a single 
Flatten feature. 

b. Select a face that will face “up” in the flat pattern (“up” is  
considered the positive Z direction). The Prompt Bar prompts 
you for this selection.
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c. Select an edge that will specify the X direction and  
the origin.

i.  Hovering the mouse over an eligible edge (eligible 
means that it does not create a conflict with the Z 
direction) causes the edge to highlight orange and 
display a dot on one end, as shown in the figure. 

ii.  The edge will be reoriented to the X axis, and the 
dot will be located at the origin end.

To shift back into synchronous mode where you can continue 
working on building your model, simply click after the Flat Pattern 
has been created. 

Transforming general models to sheet metal
Solid Edge uses a different file type for sheet metal parts because there are several requirements 
and operations which are specific to sheet metal parts: flat patterns, constant thickness require-
ments, special set of tools, and so on. 

Sometimes you may change your mind part way through a design cycle, and decide to make 
some parts using sheet metal techniques, where you had previously used general modeling tech-
niques to make a machined, cast or even fabricated part.

If you decide to change a 
model over to a specialized 
sheet metal part, it still has to 
follow the sheet metal rules. 
The result must have a con-
stant thickness, with the ability 
to be flattened without 
deforming any material. 

You can do this type of opera-
tion with either native Solid 
Edge parts or imported data, 
as long as all the requirements 
are met.

Look at the part called CH8 transformation.par in the folder that contains the working data for 
this chapter. This is a solid block of material, made just the way we have made previous general 
synchronous parts in this book.

To make the transformation to sheet metal, here are 
the general steps required. (Your specific part may 
require more steps depending on the complexity of 
the part).

1. Start with a general synchronous part, native or 
imported.

2. Use the Thin Wall command to make sure it has 
constant wall thicknesses.

a. The Thin Wall command enables you to remove 
a face, which is generally for making plastic parts, but in 
making a sheet metal part you may have to remove multiple faces  
in order to make the part flattenable.

Edge selected for X orientation has 
an orange dot on one end which 
specifies which end of the edge will 
be placed at the origin.
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b. There will probably be multiple ways to flatten  
the part, some may be more awkward than 
others or more efficient from a manufacturing 
point of view.

c. Use a thin wall thickness value that matches 
the sheet metal thickness you require.

3. Once you have the solid part hollowed out with 
the Thin Wall command, it still cannot be flattened 
because the corners are all attached.

a. Click Tools -> Transform -> Thin Part to 
Synchronous Sheet Metal tool.

b. Select an exterior face to use as a reference for 
flattening the part. The software may return 
an error message concerning Rip Edges. Notice 
the model cannot be flattened yet because the edges 
are all welded together.

c. Select the Select Rip Edges Step, and select the model 
edges as shown next. You can select interior or exterior 
edges, but whatever you do, you should be consistent 
about it.

The green face is highlighted.

d.  When done, click Accept.

e.   Flatten the model by going to Tools -> Model ->  
Flatten, and following the Prompt Bar instructions:

     i.   Click on a face to be 
oriented upward in 
the flat.

     ii.   Click on an edge to 
define the X-axis and origin. 

The completed model is saved under the name of CH8 transform3.



Solid Edge with synchronous technology  |  Steering a new course in 3D design 

109 Chapter 8  |  Synchronous sheet metal

When to shift to ordered mode
Synchronous sheet metal functions were developed later than most of the other tools in synchro-
nous technology. For that reason, some sheet metal functions that have existed for years in the 
ordered environment have not yet been developed on the synchronous side. Two of those func-
tions are deformation features across bends and Lofted Flange. Both of these tools work in Solid 
Edge, but do not yet work in synchronous mode. Therefore, if you need either of these features, 
you should model those parts in ordered.
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Summary
Solid Edge synchronous sheet metal is powerful and incredibly easy to use. From click-and-pull 
flanges to gussets that you just click-and-place, building manufacturable sheet metal parts from 
the ground up is easy. When combined with synchronous assembly techniques, the ease of use 
combined with the power is astonishing. The interface is meant to get out of your way until you 
need it, and the available options are well thought out and show a deep understanding of sheet 
metal manufacturing processes.
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Synchronous assemblies may be a strange title for this chapter, because in truth, there is no such 
thing as a synchronous assembly. All Solid Edge assemblies use the same file extension, *.asm. 
You only need one assembly template. There are no settings or options in the assembly docu-
ment that make it either synchronous or ordered. Solid Edge® software assemblies can contain 
synchronous parts, or ordered parts or both. The phrase synchronous assemblies is sometimes 
used when synchronous techniques are used to edit synchronous parts within a Solid Edge 
assembly. 

Note: There is a video that accompanies the material for this chapter. 

Synchronous technology used in assemblies takes the power that we have already demonstrated 
in synchronous parts, and multiplies it by allowing you to edit multiple parts at once. For exam-
ple, you can select faces of three parts, move them up to a face of another part. Grab a hole that 
goes through multiple parts, and move it – without setting anything up beforehand or making 
any relationships between external files. You can directly use faces or edge outlines from other 
parts in the assembly to make new features in the current part – without costly in-context or 
interpart links. 

Even more power comes from the ability to reuse data. In individual parts you can reuse any set 
of faces you can select, without regard for which faces belong to which features or what depen-
dencies those features are involved in. In assemblies, you can replace a part with a copy of itself 
or another part, and change it on the fly in the context of the assembly. Some of this capability 
has nothing to do with synchronous technology, but it is part of Solid Edge assemblies, and pow-
erful nonetheless. Solid Edge assemblies have a lot of power whether you use ordered parts, 
synchronous parts, or mix and match methods and part types.

Editing in the assembly
Editing multiple parts at once in the assembly  
without any prior setup is one of those things that 
history-based users really need to see in action. We 
are going to use the assembly shown to the right to 
demonstrate. You might recognize it as the imported 
motor from the chapter on imported data. We’ve 
hidden a few parts because the parts you really 
want to see here are the light blue piston rod,  
the gray clamp and the orange crank shaft. We 
will also use the green cam shaft and gear part.

These parts are not created specifically for the  
edit that we are going to make – they came to us 
from an import. Ideal parts would have the  
rounds created as separate ordered features. The 

Chapter 9
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http://media.plm.automation.siemens.com/solidedge/solid-edge-st-ebook-ch9-tutorial.mp4
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reason for that is to avoid consuming topology, as was discussed in a previous chapter. The worst 
that can happen when the rounds are ordered features are that an individual round feature 
might fail, as opposed to the entire synchronous edit failing. 

The edit that we are going to perform will 
involve three separate parts, and at the 
end maybe we’ll show off a little bit and 
include a fourth part.

Before we step through the edit, there 
are a couple of assembly related settings 
you need to know. 

Part and Face Priority
On the Home tab, under the Select com-
mand are two options, called Face Priority 
and Part Priority. In the assembly, when 
you click on a part in the graphics win-
dow, your meaning is ambiguous to the 
software. You might mean to click on the 
part itself to do part-level operations such 
as Open or Replace, or you might mean 
to click on the face to do face or fea-
ture-level operations such as edit. 

When working in the assembly with 
parts, you can specify your intention 
using these two options. Your cursor will 
highlight things differently, depending 
on the option you choose. With Part 
Priority, when you hover over a part, the 
entire part is highlighted when your cur-
sor hovers over it. With Face Priority, 
when you hover over a part, only the face 
is highlighted, as shown on the right. 

Activation
The second setting you should know 
about when working in assemblies, is the 
Activate option. When you activate a 
part, Solid Edge loads all of the data (as 
opposed to only loading the visual data) 
and makes it available for editing. You 
cannot edit an inactive part in the assem-
bly, so before you continue, you will have 
to activate all the parts you want to work 
with. The Activate tool is in the Home  
tab -> Select group, and the icon looks as 
shown next.

You can also activate a part or multiple 
parts by selecting them (in the graphics 
window or in the PathFinder), and select-
ing Activate from the ribbon, or from the 
shortcut menu. 

Face Priority helps you select 
faces and make edits when 
working in an assembly.

Part Priority helps you select 
parts for part-level operations 
within an assembly.
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Tutorial: Editing parts in the assembly
The rest of this chapter is going to demonstrate some com-
mon synchronous techniques that you can use in assem-
blies. The assembly called motor subassembly ch9.asm is 
available in the materials for this chapter. It already has the 
parts colored or hidden in the state that you need for this 
tutorial/demo. 

1. Open the assembly called motor subassembly ch9.asm 
from the folder containing material for this chapter. 

 Use the document type filter in the lower right of the 
Open dialog to find Top Level Assembly Documents.

2. Switch to the Right view (Ctrl-R). You may need to use 
Shift+right arrow to orient it as shown. 

3. Start by activating the crank (orange), piston rod  
(light blue) and the piston clamp (light gray). To do  
this, Ctrl+select all three parts in the 
PathFinder, right-click, and select 
Activate.

Make sure the selection is set  
to Face Priority. This setting is 
found on the Home tab -> Select 
group, under the drop-down list 
for Select. The Face Priority  
setting enables you to make  
face selections in the assembly in  
order to make part edits. The 
opposite of Face Priority is Part 
Priority, which you would use if 
you wanted to make part-level 
changes such as replacing a part. 

4. Zoom in, and drag a selection window (fence) as shown in the 
image to the right. This selects every face that is completely 
within the window. 

When you make the selection, the gray Design Intent  
panel is displayed next to the selected faces. You can  
move the panel out of the way, but make sure that  
everything is checked. The best way to do this is to click  
on the Advanced option in the Design Intent window,  
then in the Advanced interface, click the icon on the  
top left, to Restore all previous Design Intent settings. 
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5. Make sure that the pushpin icon in the upper right corner of the Design Intent dialog is verti-
cal when you move it, so that it stays where you put it. 

 The Steering Wheel should also appear, as shown next. Click on the horizontal arrow. As you 
move the cursor, notice that multiple parts are resizing symmetrically. If you move the faces 
too far in either direction, the edit will fail momentarily, and then start working again when 
you move the cursor back into range. 

 Some of the faces that are moving are being changed because you selected them, and are 
moving the steering wheel. Any face that is moving (or that is highlighted in light blue) that 
you did not select is being changed because of a Design Intent setting. In this case, we see 
that the predominant Live Rule being used is Symmetric, but there are others, such as 
Tangent, especially for controlling the rounds.

6. Move the cursor to the right of its original position, and enter .25. This changes all three parts 
without previous planning, or extensive in-context relationship building. This is how synchro-
nous technology deals with a dumb imported assembly. 

7. Next, reposition the model on your screen so you can see the outside of the white casting 
(Gear Box Cover.par), and both sides of the orange shaft. 

8. Click on the left end of the orange shaft. The diameter Ø0.866 dimension appears. 

Note: Synchronous uses dimensions for diameters of cylindrical and conical faces, 
only using the Steering Wheel to position or angle cylindrical faces.
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9. Select the inside diameter surface  
of the white casting part. You can’t 
see that surface, so to select it, 
place your cursor where the surface 
would be if you could see it, wait 
for a second or two for the 
QuickPick cursor to appear, then 
right-click. 

 Solid Edge displays the QuickPick 
list. Hover over items down the list 
and watch the entities highlight in 
the graphics area. Select the entry 
that highlights the inside diameter 
of the hole in the casting. This 
should display a diameter Ø0.874 
dimension. 

10. Change Ø0.874 to Ø0.870.

 
 
 
When you change the size of the orange shaft on one side, it also changes on the 
other side. If this was not intentional, you could turn off the Concentric Design 
Intent, but remember that this also controls your ability to move the cylinders 
within the plane. Ideally, the size and location aspects of cylinders would be 
unlinked by separating the Concentric Design Intent into two separate controls.

When changing diameters in an assembly, you must change each diameter indi-
vidually, you cannot change multiple diameters at once unless they are the same 
size. You can move the position of multiple holes or cylinders at once, but you 
must change sizes individually.
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Cylinder location is another issue.

11. Zoom up on the 
Rod Clamp part, so 
you can see the 
holes in both the 
gray clamp and the 
blue rod. 

12. Click the inside of 
the clamp hole and 
move it along the 
highlighted arrow 
shown in the 
image to the right. 
Notice that the 
hole, the ear that 
surrounds it, and 
the counterbore face, all move, along with their symmetrical  
counterparts, on the other end of the part. This is due to the Design  
Intent settings. You can get the same sort of edit in a part file. 

13. Press ESC to clear the selection. 

14. Now select the same face again, and continue by Ctrl-selecting the inside face of the hole in 
the rod (blue part). Features on both parts move and the symmetrical elements on both parts 
are also moving. 

 You can move the holes far enough that certain features begin to fail. When that hap-
pens, Solid Edge displays a red exclamation point in a yellow triangle which warns you that 
something that is supposed to be changing is not actually doing so, probably because of 
some geometrical condition. 

Note: To move both holes on the Rod part using the Symmetrical Design Intent, 
along with the rest of the holes, there was some simple editing done to the part. 
Originally, the holes were on a 
plane that was 45° from the 
base planes. This doesn’t allow 
for symmetry to be recognized. 
If you rotate the entire part 45° 
about the origin, however, the 
holes are now symmetrical on 
either side of a base plane, and 
the Design Intent of Symmetry 
can apply.

As an alternative, you could 
create an angled plane and 
establish a persistent Symmetry face relation between the holes in the part. This 
demonstrates the parametric capabilities within synchronous technology. These 
relations in the part would allow the assembly-driven edits to work. Another alter-
native would just be to edit the second hole in the Piston Rod separately. This isn’t 
as elegant or automatic, but practically speaking, it would take less time than 
setting up the relationships.
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Tutorial: Creating a part in-context
One of the most important tasks users run 
into in assembly modeling is the ability to 
create new parts in the context of the assem-
bly. Let’s take a look at how this works with 
synchronous technology.

1. First, orient the assembly on the screen so 
you can see the inside of the Gear Box 
Cover casting, as shown on the right. 

2. Next, choose Home tab -> 
Assemble group -> Create 
Part In-Place command to 
create a new part in the 
assembly. 

 When you click the Create New Part In-Place command, the command bar appears. Make sure 
to use the Ground and Edit In-Place options. The options for Ground and Origin are repeated 
in the Options dialog, which you also need to take a look at before getting more involved in 
this operation. The Options dialog is shown next. 

3. Specify a template to use for the new part as well as a material for the new part.  
(Material is listed in the drop-down list labeled (None), in the image above.)

4. Click Accept.

5. Name and save the new part in the directory that corresponds to the Save To setting in the 
options. Name the part GasketX.PAR. 

 After you name and save the new part, depending 
on your settings, the rest of the assembly display 
will change. 

 The display may turn gray and wireframe. You can 
proceed with the rest of the steps. If all the other 
assembly parts simply disappear, it means that you 
must adjust a setting. 
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 Solid Edge assumes that you want to 
start sketching a new feature, which may 
or may not be the case. You already 
know how to sketch features, so we will 
skip over that. 

6. To create a gasket on the face of the 
Gear Box Cover, first click the Extrude 
command, then hover over the flat face 
highlighted in yellow, as shown above. 

7. Click the face, right-click to accept, and 
adjust your settings to create a gasket 
0.080” thick in the appropriate direction 
from the face. This part was created 
without any relationships to the Gear 
Box Cover. You can edit the new gasket with-
out first breaking any relationships. Test this 
by moving faces of the new gasket. If you 
want to move holes on the Gear Box Cover 
and holes on the gasket at the same time, you 
will need to use the Close and Return tool to go back to 
assembly editing mode, and then swtich back to Face 
Selection mode. 
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Rundown of non-synchronous functionality in assemblies
After reading some of the other chapters, you might have concluded that assemblies don’t seem 
to have a lot of synchronous-specific functionality. And it’s true, they don’t. Assemblies, by 
design, must be agnostic-able to work with both sides. But there is a lot more than it might seem 
on first examination. Assemblies are where everything else comes together: sheet metal and 
general parts; synchronous and ordered; associative and non-associative; mates and motion; 
interferences and gaps; file management and visualization.

While there is a lot of functionality in assemblies, I will discuss three critical areas, just to famil-
iarize the reader who does not have a background in Solid Edge. Those areas are Visualization, 
Mates, and certain File Management functionality.

Visualization in Solid Edge
Visualization is one of the most underappreciated areas of any CAD package. Users spend more 
time rotating, sectioning, changing transparency, wireframe states, and generally just looking at 
the model than any other single function.

Using the PathFinder
You should practice with 
some of these options to get 
used to using them. 

As you hover over items in 
the PathFinder, Solid Edge 
will highlight them in 
orange in the graphics win-
dow. When you select items 
in the PathFinder, they are 
highlighted in green in the 
graphics window.

You can turn items on and 
off using the checkmarks to 
the left of each item in the 
PathFinder. It’s easy and 
fast. 

Right-clicking the items 
displays shortcut menus 
relevant to the different 
items.

The Show and Hide options perform the same function as the  
checkmarks to the left of each item in the PathFinder – showing 
 and hiding individual items.

The Show Only option hides everything except the item you clicked on. 

The Show/Hide Component option displays a dialog box where you can turn various types of 
options on or off for the specific item from which you launched it. 

The Scroll To option allows you to scroll to a part in the PathFinder, and the Zoom To option 
allows you to zoom to a part in the graphics window. 

You can multiple select parts in the PathFinder using Shift and Ctrl select.
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Using the mouse and the Quick View cube
I highly recommend using a 3D controller tool like 3DConnexion’s products. They are easy to use, 
powerful, programmable and they free up your mouse hand for other things. 

If you prefer, or are constrained to using the mouse, here are the tools, also found at the bottom 
right of the Solid Edge window: 

Rotate view: middle mouse button drag

Zoom: scroll wheel, or Ctrl+middle mouse button drag, or slider in the lower right corner

Zoom to area: Alt+middle mouse button drag

Fit screen: middle mouse button double-click

Pan: keyboard arrows or Shift+middle mouse button drag

Tools on the View tab

Clipping planes
You can set clipping or section planes to get an interior view of your model. 

To set planes:

1. Click the Set Planes button.

2. Select a reference plane (both cuts will be parallel to this plane).

3. Place first clipping plane.

4. Place second clipping plane (if you only want one cut, you can push this one off the model).

5. Turn clipping on or off using the On button.
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View styles
The following view styles are available:

View style settings
The view style settings are:

Floor Reflection: assembly sits on a shiny floor

Floor Shadow: assembly casts shadow on the floor

High Quality Rendering: enables bump maps, gives slightly better specular reflections 

Edge color selection: you can use either a single color for all model edges or use  
each model’s edge color

Sharpen: a higher setting may be slower to display

Perspective: use View Overrides to change amount of perspective

PMI Section
PMI Section is on the PMI tab -> Model Views group. You can establish multiple PMI 
sections which are tracked in the PathFinder, and can be turned on or off individually as 
you work. 

To create a PMI section:

1. Click the Section button.

2. Select an assembly plane or activate a 
part to select or create a new plane.

3. Draw a section profile, and exit sketch. 
Often this is just a rectangle larger than 
the model to cut everything.

4. Select the side of the profile that you 
want to cut away.

5. Identify how far you want to cut.

Visible and Hidden Edges.

Shaded. Shaded with Visible Edges.

Visible Edges.Wireframe.
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6. Assign which parts to cut:

a. Cut all parts

b. Selected parts

c. Unselected parts

Exploded assemblies
Sometimes the best visualization is an 
exploded assembly. In Solid Edge, you 
can create exploded assemblies with the 
ERA (Explode, Render, Animate) environ-

ment. Renderings these days are usually done with 
the Keyshot plugin, and we don’t cover Animations in this 
book, but we can cover exploded assemblies.

To get to ERA, go to the Tools tab -> Environs group.

You have two options: Auto Explode and Explode.  
I used Auto Explode to create the 
image to the right, so let’s give  
that a try.

As you work through this and any other 
unfamiliar functionality in Solid Edge, be sure 
to keep an eye on the PromptBar, which  
will give you the next step, or what the 
software is expecting you to select next. 

To explode an assembly: 

1. Click the ERA button.

2. Click the Auto Explode button.

3. On the Select Step of the Auto Explode command 
bar, set it to explode either Top Level or 
Subassembly (the Subassembly setting will keep 
the subassemblies together as a single unit).

4. To move to the Settings Step, click Accept.

5. The Automatic Explode Options help you deal 
with subassemblies, but our sample assembly 
does not have any subassemblies.

6. Automatic Spread Distance enables you to  
control how far apart the individual parts are 
spread, or allow the software to control that.  
In the above image, I allowed the software to 
control the spread automatically.

7. Click the Explode button, then click Finish.
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The explode animation is recorded and controlled from the Explode 
PathFinder, which is only available in ERA mode. 

You can click on the exploded parts in the graphics window and edit 
the explode distance if you want to override the automatic results.

Creating and managing mates in Solid Edge
If you are familiar with other 3D CAD programs, you are probably familiar with mates. Mates are 
relations between parts that position the parts and allow them to move in constrained ways. 
There are many mate tools in Solid Edge, but in the following quick tutorial, we are just going to 
review a few basic mates. If you want details on assemblies, mates and motion, you can access 
the training and Help tutorials supplied with the software.

1. From the material associated with this chapter, open the  
assembly called CH9 mates assembly.asm.

2. On the Home tab, click the Insert Component button.

3. The Parts Library pane appears  
(if it does not, go to View -> Show -> Panes -> Part Library).

4. Use the Up One Level button and/or the folder drop-down list to 
browse to the folder where the materials associated with this 
chapter are kept (ch9 Editing in Assemblies). 

5. From the Parts Library, click and drag the part 
called crank ch9.par into the graphics window 
and drop it in white space. The part should 
remain transparent.

6. Click on the cylindrical face, as shown. 

7. Click on the inside face of the hole in the large 
gray block casting part, as shown. 

 The crank shaft should fly into place in the casting. The 
threaded end of the shaft should be pointing away from 
the casting. If the crank shaft went in backwards, press 
the F key to flip its orientation 180°. Even if the part went 
in the correct way, practice using the F key just to see 
what it does.
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8. Next you push the crank shaft into the casting until it 
rests against the bearing face. The two faces you must 
select are indicated in the image on the right. The face 
on the casting will be easy to select, but the one on 
the crank shaft is hidden.

 To select the hidden crank shaft face:

a. Hold your mouse over the hidden face until the 
cursor changes to a mouse with three dots. This 

option is called QuickPick, and we use  
frequently in Solid Edge to select hidden or 
alternate items.

b. Right-click to display a list of items available at 
that location. Move your mouse over the items in 
the list until the correct face highlights. In the list, 
click the item corresponding to the highlighted 
face.

9. Click on the bearing face in the casting if you haven’t 
already. The crank should fly into place inside the 
casting cavity.

10. Right-click or press the Esc key to complete mating 
the crank in place. You may notice that we only created two  
mates, so the part should be able to move. 

11. Click the Drag Component button, and click and drag the  
crank part. It should rotate about the shaft, but not 
move side to side. 

12. From the Parts Library, click and drag the piston ch9.
par into the graphics window and drop it in blank 
white space. It should turn transparent green.

13. Select the outside cylindrical face of the piston,  
as shown. 

14. Click on the corresponding face of the casting.

15. If the part goes in backwards, press the F key to flip it. 
The part also may get stuck or interfere with the crank 
part already mated. We only need one mate with  
this part because the next part we put in will help to 
constrain this one. 

16. When you are done, right-click or press the Esc key. 

17. Using the Drag Component tool, drag the 
piston up so you can still get to the holes 
to locate the piston rod part. 

18. You may want to pre-position the view so 
you can see both the hole in the red part 
and the short cylinder in the orange part. 
Drag the Piston Rod ch9.par into the 
graphics window like the other two parts. 
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19. Click the small hole in the piston rod and the hole in the red piston part.

20. Click inside the half cylindrical face of the rod and the short cylindrical face of the  
orange part. 

21. Push the rod into the crank. Don’t worry that the parts have to interfere to get where they  
are going, once they are together it will be correct. 

 To push the rod in, select the small flat on the rod, in the lower left of the image, and use 
QuickPick to select the hidden flat face as shown on the crank shaft. When this part flies  
into place, your task is finished.

22. Right-click or press the Esc key.

23. Use Drag Component again to rotate the crank shaft, and watch the rod drive the piston  
up and down in the cylinder.
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Simple file management tools in Solid Edge
Solid Edge has a lot of power to manage the files associated with assemblies, but I just want to 
point out a few. 

On the Modify group, right next to the Drag 
Component button is the Replace Part drop-down 
list. The other commands on this list are:

• Replace Part  
Choose the command, then select a part to 
replace, and browse for a new part to use in its 
place. 

• Replace Part with Standard Part  
When you choose this command, Solid Edge dis-
plays the Standard Parts interface in the place of 
the browse window. Standard Parts is a library 
of nuts, bolts and other hardware.

• Replace Part with New Part  
Use this command if you want to start a brand 
new part in the place of an existing one so you 
can work in-context and reference other parts if necessary.

• Replace Part with Copy 
Choose this command if you want to copy the part by doing a Save As and be able to rename 
the part.

These four commands are fairly simple, but as often as you might need to perform these opera-
tions, they are sure to save you a lot of time and clicks. 

The final command here is a combination of View and Markup 
and Revision Manager. These are powerful tools to help you 
work with your Solid Edge assemblies. From the Open command, 
you choose which you want to use:

• If you want to rename or reassign parts in an assembly, use the 
Revision Manager. 

• If you, or someone without full-blown Solid Edge, want to 
view an assembly, use View and Markup.
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Summary
Solid Edge assemblies don’t take sides when it comes to ordered vs. synchronous. You can have 
and edit both types of parts in any Solid Edge assembly. So there is nothing inherently synchro-
nous about any assembly aside from how you edit the parts. You can edit synchronous parts 
synchronously in any Solid Edge assembly.

This book is really just focused on synchronous technology, but if you are not familiar with Solid 
Edge, the functionality in the assembly environment independent of synchronous technology is 
worth noticing. 
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Somehow, even the few CAD users who know there is some alternative to history-based CAD 
tend to believe that the only alternatives are non-parametric. By now, this book should have 
proved that the Synchronous method is indeed parametric. This chapter will offer more details 
and examples of techniques that use parametric design within synchronous technology.

A topic we haven’t discussed as much, however, is associativity. For the purposes of this book, 
we define associativity as links between documents that drive geometrical changes. In general, 
with synchronous technology we consider it a goal to avoid most associativity. Associativity leads 
to things like order-driven rebuilds, parts with links to assemblies and other parts driven by 
in-context associations, and complex relationships that have to be understood to avoid problems 
with file management. Examples of functions that use associativity are Part Copy, Inter-Part 
Copy, and external linked tables. In addition, you saw the sheet metal functions with associative 
sketches, in chapter 7.

Still, associativity is sometimes necessary to automate certain changes, especially changes that 
involve multiple parts. Master model techniques, where you drive all of the main parts in an 
assembly from a single part, are possible with synchronous, and in this chapter we will demon-
strate some of those techniques.

Note: A brief video goes along with the content of this chapter. 

Parametrics
Parametric control over models is crucial to many design professionals. Synchronous gives us 
several tools to control geometry with parameters:

• PMI dimensions
• Variables and formulas
• Face relations

Variables and formulas
If you are coming to Solid Edge from another CAD pack-
age, it could be that the definitions of items may be differ-
ent between the two systems. One of the things to be 
aware of is that in Solid Edge, dimension names are a sub-
set of variables. Each dimension has a name, whether the 
default name (usually in the form of V208 or similar) or 
one assigned by the user. That name is a variable. Other 
variables stand alone, such as Density. So some variables 
are connected to dimensions and some are not, as shown 
in the following Variable Table.

The Variable Table lists all of the dimension variables, and 
all of the formulas, links, or other controls associated with those variables. We will revisit the 
Variable Table shortly.

Chapter 10

Synchronous, parametrics  
and associativity

http://media.plm.automation.siemens.com/solidedge/solid-edge-st-ebook-ch10-tutorial.mp4
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You should already be familiar with how dimensions on the 3D model work with synchronous, so 
in this chapter we can focus on the use of variables, writing expressions and equations, and the 
use of tables. The first stop on this adventure is variables.

 
 
To see and change a dimension 
name, double-click the dimen-
sion arrow or select it, right-click 
the arrow, and then select Edit 
Formula. 
 
 

Note: Dimensions must be 
locked to be driven by a formula. 
The Formula box will be grayed 
out if the dimension is not 
locked.

 
 
 
If you are commonly writing formulas or 
using variables, you should name the 
dimensions you use with names that will 
help you remember what they are for.

To write formulas, use dimension names, 
variables, numbers, and standard mathe-
matical operators. Do not start formulas 
with an equal sign (=). Save that for Excel. 
If you are unsure about the abbreviations 
for some of the allowed functions, check 
out the Function Wizard, which is avail-
able from the drop-down list on the OK 
(green check) button in the Edit Formula 
dialog box.
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The Function Wizard does not have the operator symbols, such as +, -, *, /, so when you need 
these operators, you must key them in.

Also, when writing a formula, Solid Edge 
will not allow you to use unlocked dimen-
sions or sketch dimensions. A dimension 
that is driven by a formula will be dis-
played in purple, to remind you not to try 
to edit the value directly. Also, a dimen-
sion or variable that is driven by a formula 
cannot be used to in turn drive another 
dimension or variable. Nesting formulas 
can cause logical loops or nested 
dependencies.

To create a formula, make sure the cursor is in the Formula field of 
the Edit Formula command bar, and click on an eligible dimension in 
the graphics area or on the PathFinder. Enter number values and 
operator symbols or select function names from the Function Wizard. 
You can also enter anything, but to make sure you get the syntax and 
spelling correct, letting Solid Edge fill in the boxes may be the best 
option. 

Note: By right-clicking on a dimension, you can select Show 
All Values, Show All Names, or Show All Formulas. The last 
two will show all names or formulas instead of values (not in 
addition to values). 

Variable Table
If you use more than a few named variables, they can become difficult to track, especially if you 
have multiple people accessing the same models. For this reason, Solid Edge provides a table 
where you can control all your named dimensions and variables. This table encompasses more 
than just tracking variables and formulas. It also has a button for the Function Wizard and a very 
powerful Variable Rule Editor. 

The Variable Rule Editor enables you to control 
variables and named dimensions as follows: 

• Formula
• Visual Basic routine (external *.bas file)
• Link to assembly and part variables  

(via Peer Variables)
• Links to Excel
• Discrete list of values
• Max and Min limits 
• Sorting by type

There is a great deal of power packed in the vari-
able and formula functionality in Solid Edge.
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Associativity
Synchronous technology spends a fair bit of effort trying 
to give the user all the functionality of associative func-
tions, without the negative entanglements of associativity. 
Links between files complicate file management and slow 
down CAD work in general. But still, the Solid Edge devel-
opers recognized that there is no good alternative for 
some of the things CAD users need to do with their mod-
els, and to have a fully robust CAD modeler, they needed 
to add associativity to synchronous technology. These 
synchronous functions are also associative:

• Part Copy
• Inter-Part Copy
• Shared External Tables
• Copied Variable Links 

Part Copy
The Part Copy command enables you to take one 
part and use it as the starting point of another 
part. In synchronous mode, Part Copy creates a 
dead link; that is, changes to the copied part will 
not propagate to the parent part or vice versa. You can, 
however, make synchronous changes to the copied part. If 
you need a live associative link, you must insert the part in 
ordered mode. It doesn’t matter how you made the origi-
nal part – it only matters if the Part Copy feature was cre-
ated in ordered or synchronous mode.

The Part Copy command is on the Home tab -> Clipboard 
group, in the Part Copy drop-down list. 

You can use Part Copy when you want to mirror or scale a part, and is especially useful if you 
have multiple solid or construction (surface) bodies that you want to manage. For an overview 
of some of the functionality available, see the Part Copy Parameters dialog shown above.

Because of the ability to parse out design and construction bodies, Part Copy is a particularly 
useful tool when working with master model files, where the parts of an assembly are driven by 
splitting a single part file into multiple bodies.

Inter-Part Copy
Inter-Part Copy gives you the ability to copy faces between parts in the context of  
an assembly. You can find Inter-Part Copy on the Part Copy drop-down list on 
Home tab -> Clipboard group. It is only available when you are editing a part in 
the context of the assembly. 

You can use Inter-Part Copy to copy a face (as a surface) from one part to another to extrude  
up to the surface, use the surface to cut, thicken the surface, attach the surface to a solid, and  
so on. 

To use this command, you must first open an assembly with at least two parts. Activate the parts 
you want to have involved in the associative inter-part link. Then right-click the part you want to 
contain the link, and select Edit.
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Note: In Solid Edge, if you already have a window  
open with the part you want to edit in the context of  
the assembly, Solid Edge will open that window, rather 
than allowing you to edit the part with all the other 
assembly parts visible. So if you go to edit a part  
in-context, and the software keeps displaying a part  
window, close down the part window, and then  
right-click and Edit.

When you use Inter-Part Copy, Solid Edge first asks you to iden-
tify the part from which you want to copy geometry, then asks 
you to select the type of geometry, and finally asks for you to 
select the geometry itself. The Inter-Part Copy command bar is 
shown on the right. 

For example, here is a part where one face was copied from an 
adjacent part, thickened to a solid, and then additional features 
were added.

Note the chain link symbol in the PathFinder entry, signifying that there is an associative link 
between this part and another part. Also, note the Links collector, at the top, which shows you 
exactly where the link points. 

Note: It is possible to get too 
much of a good thing. Inter-
part associations are very 
powerful, but they also slow 
down your models and 
introduce file management 
complications. This is true 
with all CAD software. It is 
also possible to get the links 
so intertwined that you 
wind up with looping 
relations.

For some people, one of the attractions to synchronous is that it is designed to 
avoid associative links where possible.

Inter-Part Manager
To invoke an overused cliché, “with great power comes great responsibility”. Inter-part 
links are very powerful, but can also get you into trouble. The Inter-Part Manager gives 
you the ability to see and manage all of the inter-part links in an assembly. By right-click-
ing the links, you can access functions that enable you to update or break existing links. 

Inter-Part Manager is on the Tools tab -> Assistants group. It is available in assemblies and also 
in parts with inter-part links. 
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Shared external tables and copied 
variable links
These topics were discussed briefly 
in the previous section of this chap-
ter on parametrics, but also apply to 
associativity. These are methods, 
along with Part Copy are ways to use 
associativity without employing an 
assembly. The links are direct, part to 
part, without requiring an assembly 
to create some sort of spatial rela-
tionship between the parts.  
 
 
 
 
 

Tutorial: Synchronous parametrics and associativity
In a previous chapter, you created a gasket in place for the assem-
bly shown on the right. In this tutorial you will make adjustments 
to some parts: 

Change the location and size of the main bearing surface of the 
gear box cover to accommodate the crank shaft. Because we can’t 
move the crank shaft, the hole and bearing face have to move.

Move some bolt holes, but move the shaft hole first.

Move the shaft hole in two ways so you can compare the 
advantages of the two methods. 

1. From the folder with materials for this chapter,  
open the assembly called motor subassembly 
ch10.asm. 

2. Flip the assembly over so you are looking at 
the outside of the gear box cover. 

3. Make sure your selection is set to Face Priority 
(under the Select drop-down list).

 

4.   Click on the inside face of the hole in the 
cover, highlighted as shown. Make sure all of 
your Design Intent options are turned on.

      Note: Design Intent does not create 
relationships – it only assists you in 
selecting faces. In this case, it is select-
ing all of the concentric and tangent 
faces, and adding them to the inside 
face of the hole in the cover that you 
selected.
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5. Hover over the tool disk, and click. 

 The tool disk is the flat washer-shaped 
surface on the Steering Wheel. This 
enables you to move the selection set 
anywhere in the plane of the tool.

6. Hover over an edge of the shaft (orange 
part), wait for the cursor feedback tell-
ing you it has snapped to the center of 
the shaft, and then click. 

 This was the easy way. You just made an in-context move of a feature in one part to a feature 
in another part without creating any associative links between the parts. Congratulations!

7. Press Ctrl+Z to undo the move. we’re going to make the move associatively now.

8. To make sure you don’t have any open windows of the gear 
box cover part, press Ctrl+Tab, holding down the Ctrl, and 
releasing the Tab. If a window is open, switch to that win-
dow and close it. If you’re still holding the Ctrl button, you 
can switch to another window by pressing the Tab key. After 
you closed any cover part windows, return to the assembly.

9. Right-click the cover part and select Edit. If the 
software displays the individual part window, 
repeat step 6 (close the cover part window) and try 
it again.

 If the rest of the parts in the assembly 
disappear, but you are still in the 
assembly document, go to the View 
tab -> Show group (far left by default), 

and click the Hide Previous Level button. This 
makes it easier to work on assemblies with multiple 
levels of subassemblies, but in this case, it is just 
getting in the way. When you turn this off, the 
other parts in the assembly should be gray and 
transparent. 
 

 
 
10.   Use the Inter-Part Copy com-

mand to copy the following 
faces into the cover part:
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11. Copy faces for the part of the shaft that is 
near the gear box cover, as shown on the 
right. You can box-select faces. Use the 
Quick View Cube to orient the view, and 
then drag a box to select the faces.

12. Copy the end face of the crank gear part.

 Inter-Part Copy works while you’re editing a 
part in the context of an assembly. 

 To copy:

a. Click the Inter-Part Copy command.

b. Select the part from which you want to 
copy faces.

c. Select the faces you want to copy.

13. Click Accept.

14. Exit part edit mode by clicking the X in the upper right corner of the graphics window.

15. To keep the changes, save the assembly.

16. Right-click the cover part and click Open. 

 Solid Edge opens the cover part in its own window.

17. Verify that the cover part now has the surfaces from both the shaft and the gear, as shown. 
The blue surfaces are the copied ones. 

 If you open the cover part without saving the assembly, the 
software informs you that you have unsaved changes, and 
you may lose the changes if you don’t save them. 

 You may notice some new items in the PathFinder: the Links 
collector contains the associative links in the Features area 
and two new Inter-Part Copies. 

 In the assembly PathFinder, the Gear Box Cover part has a 
new chain link symbol that denotes the associative link.

 Now that you have the links, you can continue with the edits.
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18. Move the hole with the bearing surface the same 
way you did earlier in step 5, using the tool plane.

 Next you put a little clearance between the end of 
the bearing surface and the gear on the inside.

19. Rotate the part so you can see the inside, then 
click on the end face of the bearing surface as 
shown:

20. Shift+Click on the vertical Steering Wheel 
arrow, and move the cursor up slightly. 
Release the Shift key, if you haven’t already, 
enter .05, press the Enter key, then click in 
white space.

 This series of steps has put the steering 
wheel 0.05” above the bearing face, and 
when you move the Steering Wheel to the 
face of the gear, it will leave a gap of 0.05” 
between the bearing face and the gear. 
This is a technique that is commonly used 
in synchronous edits to create gaps or overlaps.

21. Click the vertical arrow once more, and then click any end point on the face of the gear. 
Using clipping planes, you can see that the move was successful.

 Next, you shape the inside of the hole on the cover to match the shaft.

22. Hide both of the Inter-Part Copy features in the PathFinder. 

23. Click the Replace Face button 
on the Surfacing tab -> 
Modify Surfaces -> Replace 
Face. 

24. Follow the instructions in the Prompt Bar. 
The first face you select should be the 
inside of the hole on the cover part, then 
right-click to accept. 

25. From the PathFinder, show the Inter-Part 
Copy feature copied from the shaft, and 
select it in the graphics window. 

 As soon as you click the Inter-Part surface, 
the operation is complete. 

26. Click Cancel or press the Esc key. 
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27. To create a bit of clearance to allow the shaft to rotate, click on  
the inside larger diameter face, then click on the dimension 
that appears and change it from 1.063 to 1.066.

Note: Synchronous does not have a steering wheel 
method for changing radius or diameter values,  
so those values are changed using dimensions.

 Next you must move the oil drain because it doesn’t touch the  
bottom face.

28. Select the outer cylindrical face and the chamfer face. 

29. Move the Steering Wheel to a model edge or face so 
that it points straight down, not down at an angle. 

Tip: Move it by dragging the origin – blue ball  
in the center.

30. Click the arrow pointing down, move the cursor down, 
and enter 0.215.

31. To display the assembly window again, press Ctrl+Tab.

32. Use the PathFinder to show the Gasket and Block 
Casting parts again. Turn off the crank and the crank 
gear.  
 
 

33. Use the Quick View Cube to display the Top 
view, and zoom in on the area shown next.

34. Switch to Select Face Priority, right-click the 
top-level assembly name in the PathFinder, 
and then click Activate. Solid Edge activates 
all parts in the assembly. 

35. Drag a selection box as shown, to select all the faces of the bolt lug nearest the center of the 
shaft. When selected it looks as shown next.
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36. Move the Steering Wheel to a circular edge, such as 
the one near the cursor in the image to the right, will 
cause the Steering Wheel to snap to the center of the 
arc. In this position, use the torus to rotate the selec-
tion 45° clockwise. 

 This has moved features of three imported parts 
together, with no previously established design intent 
or associativity.
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Summary
Synchronous technology makes extensive use of both parametrics and associativity. Parametrics, 
as in history-based software, is driven by relationships and dimensions. In synchronous, the 
parametrics are attached to the actual 3D model rather than the 2D sketches. Associativity is 
something that synchronous technology was designed to minimize, but links between parts in 
the assembly can still be achieved with Inter-Part Copy functions and even tables driving dimen-
sions from multiple parts.
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